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 Welcome to Teachucomp, Inc.‟s Advanced Crystal 

Reports class. Crystal Reports is a database reporting 

application. It has powerful capabilities to access and 

analyze various sources of data for its reports. 

 As business evolves towards a more information-

based workplace, the talent to access and create accurate 

and relevant reports from multiple data sources is quickly 

becoming a necessity for businesses of all sizes. However, 

as a business entity grows, it may often find that the data 

needed in order to make informed business decisions is 

contained within various database applications. 

 Crystal Reports provides a solution to this issue, due in 

large part to its flexibility in accessing various types of data. 

You can use Crystal Reports to access data from database 

files commonly used in many types of businesses and 

industries, from desktop database solutions like Microsoft 

Access or Microsoft Visual FoxPro to mainframe or server-

based data files like Microsoft SQL Server or Oracle. 

 Crystal Reports can also be used by many different 

types of individuals within an organization. One does not 

have to be an IT guru in order to generate basic reports, as 

Crystal Reports provides many intuitive wizards to assist in 

report generation. It also has more advanced features for 

the IT professional‟s use, too. Whatever your data reporting 

needs, one will find that knowing Crystal Reports is a 

useful tool in making more informed business decisions. 

Introduction and Overview 
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Using Formulas 

9.1- Crystal Reports Formula Syntax: 

 

 Much of the power in Crystal Reports lies in its ability to use powerful analytical functions and 

mathematical expressions to create complex formulas which can manipulate and further calculate the data 

displayed in the report. For example, you could create a formula in a field that multiplies the values in one 

field by the values displayed in another field. This is just one example of the ways in which formulas can be 

used in Crystal Reports. In this lesson, we will examine the ways in which you can write formulas in Crystal 

Reports. There are two different way of writing formulas: you can either use the Crystal syntax or the Basic 

syntax. A syntax is simply an accepted way of writing an expression. 

 Crystal syntax is the way of writing formulas which has always been included in all releases of 

Crystal Reports. The Basic syntax is similar to the way of expressing statements in Visual Basic, but has 

specific reporting variations implemented. You can use both types of formulas in your reports. You simply 

have the flexibility of choosing whichever syntax you prefer to use and are more skilled or comfortable in 

using. 

 All formulas, regardless of how they are expressed, make use of some common elements. These 

various elements are combined together using the rules of expression that govern our selected syntax 

(Crystal or Basic) to create the formulas used in our reports. 

Element: Purpose: 

 

Fields You will frequently make references to field values that are contained in the underlying tables 

of your report. These will always be in the format of “tablename.fieldname,” enclosed in 

braces { }. Example: {employees.EmployeeID}. 

 

Functions Functions are preset mathematical and analytical operations that can be performed upon the 

values contained within your report. There are many different categories of functions 

available that can perform operations on different types of numeric, date/time and string 

(text) values. Functions are always entered in as the name of the function (for example 

sum), followed by one or more additional arguments required by the function to work with 

each argument separated by a comma. Example: AVERAGE({orders.Order Amount}). 

 

Operators Crystal Reports allows for the use of several standard mathematical and comparison 

operators in report formulas. For example, the + sign can be used for addition, the > symbol 

means “greater than,” and so on and so forth. 

 

Text/Numbers You can make a reference to a string (text) value by enclosing the desired text within either 

single or double quotation marks. Number can also be entered into formulas as plain values 

with no commas or other unnecessary punctuation. 

 

Other Formulas Other formulas can be referenced by preceding them with the @ symbol, followed by the 

formula name, all surrounded by braces. Example: {@FormulaName}. 

 Formulas are not case-sensitive. They are also not sensitive to carriage returns or spaces. You can 

certainly use spaces and carriage returns to make the formulas that you compose more comprehensible 

and easier to read, but they are not “necessary,” per se. However, you must not place a carriage return 

within quotes (text values) as this will generate an error in your formula. Also, any lines within a formula that 

begin with two forward slash symbols (//) will be ignored by Crystal Reports. That symbol is used to denote 

comments in a formula. Very complex formulas can benefit from comments that clarify their purpose. Sa
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Using Formulas 

9.2- The Formula Workshop- Formula Editor Window: 

 

 In Crystal Reports, you use the Formula Workshop window to create the various types of formulas 

that are used to select records, create custom group names, calculate values, and other formula-related 

activities. The Formula Workshop consists of two separate components: the Formula Editor and the 

Formula Expert. The Formula Editor is where we create almost all of the formulas that we use in Crystal 

Reports. The Formula Expert is a less frequently used aspect of the Formula Workshop which allows you to 

create your own custom functions that can then be used by other formulas and stored into the Crystal 

Repository (if using Crystal Enterprise). 

 You can access the Formula Workshop in various places within Crystal Reports. You can click the 

“Formula Workshop” button in the Experts toolbar to launch this screen in a separate window. You can also 

launch this window by choosing “Report| Formula Workshop….” from the Menu Bar. You can also access 

this window by clicking the small “X+2” buttons that appear in the “Format Editor” dialog box. 

 When the Formula Editor is being displayed in the Formula Workshop, you can see the different 

sections of the window which are displayed below. At the top of the window you can see the various buttons 

in the four small toolbars that are available for selection. To the left side of the window, you can also view 

the Workshop Tree pane, which shows the various types of formulas and expressions which you can 

manipulate through this window. 

The Workshop Tree 

The Workshop Toolbars 

Report Fields Functions Operators 

Formula text window 
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Using Formulas 

9.2- The Formula Workshop- Formula Editor Window (cont.): 

 

 To the right of the Workshop Tree pane are the four main panes used to create your formulas in the 

Formula Editor. In the “Report Fields” pane, you can see all of the database fields which are available for 

reference in your formula. You will also see any other fields or groups created for the report in this pane, as 

well. The middle pane of the three is the “Functions” pane and this is where you will find all of the possible 

functions which you can insert into your formulas. The rightmost pane is the listing of the “Operators” which 

are available for use in your formulas as well. 

 Within each pane you can click the small plus (+) and minus (-) signs next to each category to 

expand and collapse the objects displayed within each section. You can double-click on an entry within 

these panes to insert it into the “Formula text window” at the bottom of the panes. In this manner you can 

edit and create the complex expression that consists of the fields, functions, operators, and other text and 

numbers that you enter by hand into the “Formula text window.” Notice that in each of the three panes, you 

have a small “X” button, which you can click to close the pane. They can then be turned back on using the 

buttons in the Expressions Editor toolbar. You can also click the small left and right arrows next to the small 

“X” to hide and show each pane temporarily while using the Formula Editor. 

 Let‟s examine what toolbars and buttons are available for use within the Formula Editor when in the 

Formula Workshop window. 

The General Formula Workshop Toolbar 

Save and close 

Save New Toggle Properties 

Display 

Hide/Show Workshop Tree Use Expert/Editor 

The Workshop Tree Toolbar 

Rename Delete Show 

formatting 

formula 

nodes 

only 

Expand Node Add to Repository 

Add to Report 

The Expressions Editor Toolbar 

Check 

Undo Browse 

Data 

Sort 

Trees 

Syntax 

Comment/Uncomment 

Redo 

Find or 

Replace 

Toggle 

Bookmark 

Next 

Bookmark 

Previous 

Bookmark 

Clear All 

Bookmarks 

Field 

Tree 

Function 

Tree 

Operator 

Tree 
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Using Formulas 

9.3- Creating Formula Fields: 

 

 You can also add a formula field into your report, and this is probably the most common reason (at 

first) to use the Formula Workshop window. Formula fields are simply fields that are placed into your report 

that calculate a value determined by the formula which you set. You can either create them through the 

Formula Workshop window, or through the Field Explorer pane. 

 If you have already launched the Formula Workshop window, you can create a new formula field by 

clicking the small drop-down arrow next to the “New” button and then clicking the “Formula…” command. 

You can also right-click on the “Formula Fields” folder in the pane at the left side of the dialog box and 

choose “New…” from the pop-up menu which appears. 

 If you have the Field Explorer pane open and wish to use that to create the new formula field, you 

can do so by simply clicking on the “Formula Fields” entry within the pane and then clicking the “New” 

button in the toolbar at the top of the pane. You can also right-click on the “Formula Fields” entry and then 

choose “New…” from the pop-up menu that appears. 

 Whichever way that you begin, you will next see the “Formula Name” dialog box appear. Type the 

name which you wish to give to the formula field into the “Name:” text box. If using Crystal Reports 10 or 11,  

click either the “Use Expert” button to launch the “Formula Expert” window in the Formula Workshop, which 

is less common, or click the “Use Editor” button to launch the “Formula Editor” window in the Formula 

Workshop, which is much more common. If you accidentally entered this window, then you can click the 

“Cancel” button to cancel the “Formula Name” dialog box and exit without creating a formula field. 

 Next, you will view the Formula Editor panes in the Formula Workshop. The formula that you create 

will be displayed in the “Formula text window” area of the Formula Editor. Now you create the desired 

formula using the available fields, functions, and operators listed in the three panes above the “Formula text 

window.” 

 Note that you can change which syntax you would prefer to use from the “Syntax” drop-down at the 

right side of the Expressions Editor toolbar. By default, it displays the more commonly used “Crystal Syntax” 

choice, but you can choose the “Basic Syntax,” if you prefer. Selecting the “Basic Syntax” option places the 

required “formula =” variable into the “Formula text window.” 

 You can then finish editing the formula as needed in the “Formula text window.” You can click the 

“Check” button in the Expressions Editor toolbar to check the syntax of the formula that you have created in 

the “Formula text window.” If there is an error with the formula, it will be indicated by a message box that 

appears. You can then correct the formula before saving it. Once the syntax is correctly entered for the 

desired formula, you can then click the “Save” button to save your changes. If you wish to save the 

formula‟s changes and also close the “Formula Workshop” window, you can click the “Save and Close” 

button instead. 

 Once the report formula field has been created, it will appear as any other field in the “Field 

Explorer” pane at the right side of the window. You can then add it to the report in the design view just as 

you would add any other database field or special field. Once again, be aware of the placement of the 

formula field within the sections of the report, as its placement can drastically impact its displayed value. 
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Using Formulas 

9.4- Crystal Syntax: 

 

 The Crystal Syntax is commonly used to create formulas in Crystal Reports, as it has been accepted 

in every version of Crystal Reports. You can only use the alternative Basic syntax starting in version 8.0. 

However, almost any formula can be written using either syntax. 

 When writing a formula using the Crystal syntax, the formula must return some type of value: 

whether it be a number value, text value (string), currency value, boolean (logical) value, date value, time 

value, or a combined date/time value. For example, a simple Crystal syntax formula that returns ten percent 

of an “Order Amount” field could be expressed as follows: 

 

//This formula returns ten percent of whatever value is shown in the 

//Order Amount field. 

{Orders.Order Amount}*.10 

 

 This is what you could type into the Formula Editor, assuming that you had a field in your report 

named “Order Amount,” in order to view what ten percent of the value of that field would be. This could be 

useful as a calculation of commission, for example. 

 Note that the first two lines in the formula begin with two forward slashes “//” followed by a line of 

descriptive text. These are “comments.” Comments help clarify the purpose of the formula for other users 

who may view them, and are indicated by a line that begins with two forward slashes. These lines are 

ignored by Crystal Reports when evaluating the formula. Next, let‟s examine a formula that makes use of 

one of the over 250 functions in Crystal Reports. 

 

"The employee is named: "+ Trim ({Employee.First Name}) + " " + Trim ({Employee.Last Name}) 

 

 In this example, we make use of the “Trim” function. This is a function performed on string (text) 

values. It removes both leading and trailing spaces from the text values. Note the syntax convention used: 

the function is referenced and then the field upon which the function is to be performed is then referenced 

and enclosed in parentheses. The field references, using the general syntax of „tablename.fieldname,‟ are 

always enclosed within braces. 

 Also note that this function makes use of one of our most common operators: the plus sign (+). 

When used with number values, the plus sign indicates addition. When used with string (text) values, it 

indicates concatenation. Concatenation is the combining of multiple text values into a single string value. In 

the previous example that calculated ten percent of the “Order Amount” field, we also used another 

operator, the asterisk (*) symbol. This indicates multiplication. 

 Also note that when we needed to create a reference in a formula to a string value, it needed to be 

enclosed within quotes to work. You may use either single or double quotes, as desired. It is also worth 

mentioning that formulas which use Crystal Syntax aren‟t case-sensitive. For example, we could have 

expressed the reference to the “Trim” function as “tRIM” or “trim,” if we felt like it. The only exception is 

when making a string (text) reference. String values are always displayed exactly as they are entered. 

Using our previous example, if we had typed “the employee is named: ” that is exactly (including the casing) 

what would be displayed. 

 The formulas which we have examined thus far have all been one line expressions which return a 

single value. More complex formulas may involve the use of multiple expressions. When using Crystal 

Syntax, you must place a semicolon after each expression (element which returns a value) within the 

formula. Sa
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Using Formulas 

9.4- Crystal Syntax (cont.): 

 

 For example, if you would like to declare a “variable” within an expression and then use that variable 

later on in another expression which will then return a value to the report, the two expressions must be 

separated with a semicolon. They do not necessarily need to be placed onto separate lines within the 

formula, however, they often are for clarity‟s sake. 

 

//This is the expression line which declares a variable value. Note the semicolon. 

NumberVar varX; 

//Next, the variable is assigned a value, which is then returned to the report. 

varX := 100 

 

 Note the new operator displayed in the last example, which is the “assignment” operator. It actually 

consists of two symbols placed in sequence: the colon symbol followed by the equal sign. After declaring a 

variable (which is accomplished in our example through the “NumberVar” function), we can then assign the 

variable a value using the assignment operator. 

9.5- Basic Syntax: 

 

 If you are familiar with Visual Basic programming, you can create formulas in Crystal Reports using 

the Basic syntax which may seem more familiar to you. Generally speaking, using the Basic syntax in 

Crystal Reports is just like using Visual Basic, except that it has specific extensions to handle reporting. 

 When using Basic syntax, you will need to become familiar with the ways in which formulas refer to 

other fields in the report. You must also learn how to return the value from the formula to the report using a 

special variable called “formula.” It is also important to be aware of some of the special report processing 

functions that you will probably need to use, such as “ReportTitle” or “OnFirstRecord.” Also, you will need to 

understand the data type system used in the Basic syntax. Unlike the data types in Visual Basic, the Basic 

syntax is strongly typed. While you do not specifically have to declare a variable data type when declaring 

variables, there is no “variant” type. You have the choice of either a “Date,” “Time,” or “DateTime” data type 

versus the simple “Date” type used in Visual Basic. 

 In Basic syntax, the value returned by the formula to the report is signified by the use of a special 

variable named “formula.” For example, here is a Basic syntax formula that returns ten percent of the value 

of an “Order Amount” field from an “Orders” table in a report. 

 

formula = {Orders.Order Amount} * .10 

 

 Ensure that you switch the “Syntax” drop-down to “Basic syntax” before creating the formula in the 

“Formula Editor” version of the “Formula Workshop.” If you do not, you will receive error messages when 

you try to save and close the formula, as its syntax will be evaluated using the “Crystal syntax” conventions, 

to which it does not adhere. 

 Basic syntax will always return a formula result which must be one of the seven simple data types 

supported: “Number,” “Currency,” “String,” “Boolean,” “Date,” “Time,” or “DateTime.” While Crystal Reports 

does support the use of range types and array types, these cannot be the returned results of a formula. 

 Also, you may use the “formula” variable many times within a formula. This may be the case when 

using the “IF…THEN…ELSE” conditional, which returns one of two possible results. Sa
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Using Formulas 

9.5- Basic Syntax (cont.): 

 

 Also, even if you do not intend to use the result of the formula in the report, you must always assign 

a value to the “formula” variable. However, if you have the situation where you have multiple “formula” 

variables within a formula, as would be the case when using the “IF…THEN…ELSE” conditional, all of the 

values assigned to the “formula” variable must be of the same data type. For example, if “formula” is set to a 

string value in one line of the formula, it must always be assigned a string value in the other lines of the 

same formula when it occurs. Another unique feature of the “formula” variable is that you do not need to 

“declare” the variable as you would most other variables. 

 Just as when using the Crystal syntax, you can write comments into the formulas that can help 

clarify a function. To signify a comment in Basic syntax, begin the line with either the word “Rem,” or with 

the apostrophe character. The text that then follows on the same line will be ignored by the Basic compiler 

when the formula is calculated. Another commonality between the Basic syntax and the Crystal syntax is 

the fact that neither syntax is case-sensitive, with the exception of text strings. Remember that the string 

value of “Crystal Reports” is not the same as “crystal reports” or “CRYSTAL REPORTS.” 

 Many of the functions and operators used in Crystal syntax are also used in the Basic syntax. For 

example, subtraction is references by the minus sign (-) and many functions, such as Sum() are used the 

same way. However, there are still considerable differences between the two syntaxes. Basic syntax 

consists of several lines of statements which comprise the formula. Each statement can be separated by 

using either a line break or the colon symbol (if on the same line). You can continue a statement onto the 

next line by following it with the spacebar character and the underscore symbol “ _” if needed. This allows 

you to write a single statement that consists of several lines, if desired. 

 You can also declare variables and assign a value to them which can then be used later on in the 

formula by another statement, much as you can in the Crystal syntax. 

 

Rem This will declare the type of data to store to the variable. 

Dim varX as Number 

‘Next we will assign the variable a value. 

varX = 20*10 

formula = varX 

 

 In the Basic syntax, we use the “Dim” function to declare the variable which is then named “as” a 

specified data type. Note that the first and third lines of this formula are simply commentary explaining what 

is occurring. The value of the declared variable is then assigned in the fourth line using the equal sign (=). 

Note that you can also use the word “Let” to assign a value to a variable. For example, here is an alternate 

way of expressing the fourth line of the previous example. 

 

Let varX = 20*10 

 

 Much of the referencing to specific types of data values is the same in both syntaxes. Field values 

are always enclosed within braces, string values are always enclosed within double quotes (no single 

quotes allowed for Basic syntax), and date and time values are always enclosed within pound signs. 
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Using Formulas 

9.6- Finding Function and Operator Assistance: 

 

 When you are composing your formulas in the “Formula Workshop” window, you may want to find 

more information about a particular function or formula that you think you would like to use. If you use the 

“Function Tree” and the “Operator Tree” panes to expand the functions and operators, it is helpful to note 

that you can click on the name of a function or an operator within these two panes and then click the “Help” 

button in the Formula Workshop toolbar. This will then launch the “Crystal Reports Online Help” window and 

automatically find the help file associated with the selected function or operator. This can help you find 

information such as why you would use the function, what arguments the function requires, and how it is 

used through examples. When you have finished reading through the information in the help window that 

appears, click the “X” in the upper right corner of the window to close it and return to the “Formula 

Workshop” window. 
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ACTIONS- 

Using Formulas 
OPENING THE FORMULA WORKSHOP WINDOW: 

 

1. You can click the “Formula Workshop” button in the Experts toolbar to launch this screen in a separate 

window. 

 

OR 

 

1. You can also launch this window by choosing “Report| Formula Workshop….” from the Menu Bar. 

 

OR 

 

1. You can also access this window by clicking the small “X+2” buttons that appear in the “Format Editor” 

dialog box. 

USING THE FORMULA WORKSHOP WINDOW: 

 

1. In the “Report Fields” pane, you can see all of the database fields which are available for reference in 

your formula. 

2. The middle pane of the three is the “Functions” pane and this is where you will find all of the possible 

functions which you can insert into your formulas. 

3. The rightmost pane is the listing of the “Operators” which are available for use in your formulas as well. 

4. Within each pane you can click the small plus (+) and minus (-) signs next to each category to expand 

and collapse the objects displayed within each section. 

5. You can double-click on an entry within these panes to insert it into the “Formula text window” at the 

bottom of the panes. 

6. You can edit and create the complex expression that consists of the fields, functions, operators, and 

other text and numbers that you enter by hand into the “Formula text window.” 

7. Notice that in each of the three panes, you have a small “X” button, which you can click to close the pane. 

They can then be turned back on using the buttons in the Expressions Editor toolbar. 

8. You can also click the small left and right arrows next to the small “X” to hide and show each pane 

temporarily while using the Formula Editor. 

CREATING A FORMULA FIELD: 

 

1. If you have already launched the Formula Workshop window, you can create a new formula field by 

clicking the small drop-down arrow next to the “New” button and then clicking the “Formula…” command. 

 

OR 

 

1. You can also right-click on the “Formula Fields” folder in the pane at the left side of the dialog box and 

choose “New…” from the pop-up menu which appears. 

 

OR 

 

(cont.) Sa
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ACTIONS- 

Using Formulas 
CREATING A FORMULA FIELD (CONT.): 

 

1. If you have the Field Explorer pane open and wish to use that to create the new formula field, you can do 

so by simply clicking on the “Formula Fields” entry within the pane and then clicking the “New” button in 

the toolbar at the top of the pane. 

 

OR 

 

1. You can also right-click on the “Formula Fields” entry and then choose “New…” from the pop-up menu 

that appears. 

2. In the “Formula Name” dialog box, type the name which you wish to give to the formula field into the 

“Name:” text box. 

3. If using Crystal Reports 10 or 11,  click either the “Use Expert” button to launch the “Formula Expert” 

window in the Formula Workshop, which is less common, or click the “Use Editor” button to launch the 

“Formula Editor” window in the Formula Workshop, which is much more common. If you accidentally 

entered this window, then you can click the “Cancel” button to cancel the “Formula Name” dialog box and 

exit without creating a formula field. 

4. Next, you will view the Formula Editor panes in the Formula Workshop. The formula that you create will 

be displayed in the “Formula text window” area of the Formula Editor. Now you create the desired 

formula using the available fields, functions, and operators listed in the three panes above the “Formula 

text window.” 

5. Note that you can change which syntax you would prefer to use from the “Syntax” drop-down at the right 

side of the Expressions Editor toolbar. By default, it displays the more commonly used “Crystal Syntax” 

choice, but you can choose the “Basic Syntax,” if you prefer. Selecting the “Basic Syntax” option places 

the required “formula =” variable into the “Formula text window.” 

6. You can then finish editing the formula as needed in the “Formula text window.” 

7. You can click the “Check” button in the Expressions Editor toolbar to check the syntax of the formula that 

you have created in the “Formula text window.” If there is an error with the formula, it will be indicated by 

a message box that appears. You can then correct the formula before saving it. 

8. Once the syntax is correctly entered for the desired formula, you can then click the “Save” button to save 

your changes. 

9. If you wish to save the formula‟s changes and also close the “Formula Workshop” window, you can click 

the “Save and Close” button instead. 

FINDING OPERATOR AND FUNCTION ASSISTANCE: 

 

1. In the “Formula Workshop” window, you can click on the name of a function or an operator within either 

the “Functions” or “Operators” panes and then click the “Help” button in the Formula Workshop toolbar. 

2. This will then launch the “Crystal Reports Online Help” window and automatically find the help file 

associated with the selected function or operator. 

3. Click the “X” in the upper right corner of the window when you are finished to return to the Formula 

Workshop. 
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EXERCISES- 

Using Formulas 
Purpose: 

 

1. To be able to create and insert basic formula fields into our reports. 

Exercises: 

 

1. Open Crystal Reports. 

2. Select “File| Open…” from the Menu Bar to launch the “Open” dialog box. 

3. Click the “My Documents” folder at the left side of the dialog box, or use the “Look in:” drop-down at 

the top of the dialog box to navigate to the “My Documents” folder. 

4. Select the “Employee Sales Report,” which you created in the “Chapter 4- Exercise” from the 

“Crystal Reports- Introductory” manual. 

5. Click the “Open” button. 

6. Click the “Design” tab. 

7. Click on the “First Name” field in the “Details” section to select it. 

8. Select “Edit| Delete” from the Menu Bar. 

9. Click on the “Last Name” field in the “Details” section to select it. 

10. Select “Edit| Delete” from the Menu Bar. 

11. Click on the “Group #2 Name” field in the “Group Header #2:” section to select it. 

12. Select “Edit| Delete” from the Menu Bar. 

13. Click on the “Formula Fields” entry in the “Field Explorer,” and then click the “New” button in the 

small toolbar at the top of the Field Explorer pane. 

14. In the “Formula Name” dialog box, type “Custom Group Header” into the “Name:” text box, and then 

click the “OK” button. 

15. Click the “Use Editor” button in the “Formula Name” dialog box, if prompted. 

16. Ensure that the “Syntax” drop-down is set to “Crystal Syntax” in the toolbar at the top of the Formula 

Workshop window. 

17. Enter the following formula exactly as shown into the “Formula Text” window: 

 

 "Employee Name: " + {Employee.First Name} + " " + {Employee.Last Name} 

 

18. Click “Save and Close” to return to the report design view. 

19. Click and drag the new “Custom Group Header” field from the Field Explorer and drop it into the 

“Group Header #2:” section at the far left end 

20. Select the “Custom Group Header” field and resize it so that its right end extends to 3” in the 

horizontal ruler. 

21. Click the “Print Preview” button in the Standard toolbar. 

22. Select “File| Save” from the Menu Bar to save your changes to the report. 

23. Select “File| Close” from the Menu Bar to close the report. 
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CHAPTER 10- 

Advanced Formatting 

10.1- The Highlighting Expert 

 

10.2- The Section Expert 

 

10.3- Conditionally Formatting a Section 

 

10.4- Conditionally Formatting a Field 

 

10.5- Manipulating Multiple Sections 
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Advanced Formatting 

10.1- The Highlighting Expert: 

 

 The Highlighting Expert is a tool which allows you to apply a specified formatting to a field when it 

meets a criteria which you set. For example, you could change the color of the font used to display numbers 

in a field to red only if they display a negative value. 

 To use the Highlighting Expert within a report, first select the field to which you wish to apply the 

conditional formatting. Next, click the “Highlighting Expert” button in the Experts toolbar or choose “Format| 

Highlighting Expert…” from the Menu Bar to launch the “Highlighting Expert” dialog box. 

 In this dialog box, you can click the “New” button to create a new item in the item list, which is 

displayed at the left side of the “Highlighting Expert” dialog box. To the right side of this dialog box, in the 

“Item editor” section, is where you can create and edit the formula used to apply the desired formatting. 

 Use the “Value of:” drop-down to select the name of the field whose value you wish to use as the 

basis of the condition you are about to specify. Note that you can select a field to format, but base the 

formatting upon the value of another field, which you can specify here. Use the drop-down below the first 

drop-down to specify the comparison operator used for the condition. The third drop-down allows you to 

specify a value from the selected field. This drop-down shows the first few hundred possible choices from 

the selected field. You can also type a value directly into the field itself, if needed. Notice that as you make 

or enter your choices from the drop-down menus available that the condition displays itself in the “Item list” 

at the left side of this dialog box. 

 Next you need to choose the formatting to apply to the selected field when the criteria which you 

specified is met. You can use the “Font style:” drop-down to choose a selected font style for the displayed 

used. The “Font color:” drop-down allows you to select from a basic set of color choices. Note that you can 

select the “Custom” color choice to launch the “Color” dialog box, where you can set your own custom color 

choice. You can use the “Background:” drop-down to accomplish the same thing by choosing the desired 

background color used for the display of the value. You can use the “Border:” drop-down to select the type 

of border to apply to the selected values when they meet the condition that you specify from this drop-down. 

After you have made all of the choices that you would like, you will be able to see the way that the text 

values will display in the “Sample:” text box. 

 At this point, you can then create additional 

conditions to which you would like to apply 

formatting to the same selected field by simply 

clicking the “New” button again and then repeating 

the same process of selecting the values and the 

formatting to display. If you have a condition 

specified for a field which you no longer wish to 

apply, you can select the condition to remove from 

the “Item list” and then click the “Remove” button at 

the bottom of the “Item list.” If you have multiple 

conditional formatting formulas listed in the “Item 

list,” you can click the “up” and “down” arrows to the 

right of the “Item list” to reorganize the order in 

which the conditional formatting will be enforced. 

When you have finished specifying any conditional 

formatting choices that you wish, you can click the 

“OK” button at the bottom of the “Highlighting 

Expert” dialog box to apply the selected conditions 

to the chosen field. Sa
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Advanced Formatting 

10.2- The Section Expert: 

 

 The Section Expert allows you to control the appearance of information within the various sections 

displayed in the Design view of the report. You can also set the appearance of the sections themselves 

using the Section Expert dialog box. This allows us to apply some very powerful formatting features to our 

reports. Using the Section Expert, we can choose to show or hide entire sections, keep sections together 

and set the background color for the selected section, amongst other things. 

 To view the Section Expert, either click the “Section Expert” button in the Experts toolbar, or choose 

“Report| Section Expert…” from the Menu Bar. You can also right-click on one of the names of the sections 

listed at the left side of the Design view and then choose the “Section Expert…” command from the pop-up 

menu which appears in order to select that, as well. 

 At the left side of the “Section Expert” dialog box are the names of the various sections of the current 

report. You can click on a name of a section in this list to select it and then view its properties on the tabs to 

the right. In Crystal Reports 10 and 11, these are the “Common” tab and the “Color” tab. In Crystal Reports 

2011 and 2008, there is a tab called “Paging” that contains some of the page-related options that were 

previously found on the “Common” tab, such as “New Page Before” and “New Page After.” 

 On the “Common” tab, you can view various section settings from which you can set your desired 

options. We will examine what options we can set on this tab in a moment. 

 On the “Color” tab, you can set the desired background color for the section. You can even specify a 

conditional color setting for the background color, if so desired. 

 If using Crystal Reports 2011 or 2008, you have page-related options shown on the “Paging” tab. 

You also have a bit more flexibility regarding page breaking behavior in Crystal Reports 2011 and 2008. Sa
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Advanced Formatting 

10.2- The Section Expert (cont.): 

 

 Now we can examine the options that we can set on the “Common” tab of the “Section Expert” 

dialog box in Crystal Reports 10 & 11. Some options have moved to the “Paging” tab in Crystal Reports 

2011 and 2008, and are noted below. The options are illustrated in the table shown below. 

Option:  

 

Free-Form Placement 

(Crystal Reports 10 & 11 Only) 

 

Hide (Drill-Down OK) 

 

 

 

Suppress (No Drill-Down) 

 

 

Print at Bottom of Page 

 

 

New Page Before 

(on “Paging” tab in 11/08) 

New Page After 

(on “Paging” tab in 11/08) 

Reset Page Number After 

(on “Paging” tab in 11/08) 

Keep Together 

 

 

 

Suppress Blank Section 

 

Underlay Following Sections 

 

 

Format with Multiple Columns 

 

 

 

 

 

Reserve Minimum Page Footer 

 

 

Read-only 

 

 

Relative Positions 

Function: 

 

When checked, this allows for free movement of form fields in the report design 

view. If unchecked, forces fields to only be set at fixed points. 

 

Hides the selected section during printing, but allows viewing in “Print Preview” by 

allowing the user to double-click on a group summary which displays the hidden 

section. 

 

Hides the selected section in both the printed version and the preview. There is no 

“drill-down” allowed. 

 

If checked, will force the section to print as far down in the page as possible. 

Cannot print any lower than the section beneath it, if checked. 

 

If checked, will force a new page break before the section prints. 

 

If checked, will force a new page break after the section prints. 

 

If checked, will reset the page numbering back to “1” after printing the section. 

 

If checked, will try to print the entire section and all section data on a single page. 

If there is not enough room left on a page, then the whole section is moved to 

print starting at the top of the next page. 

 

Will prevent the display of the section if there is no data in the section‟s fields. 

 

When checked, will print the section in the same place on the page where it prints 

the next section‟s data. Useful for printing a group graph next to the group data. 

 

Allows you to have data display in columns instead of as a single column which 

prints straight down the page in the “Details” section. When you check this 

option, you will see a new “Layout” tab appear. When you click the “Layout” tab, 

you can specify (in inches) the width of the columns and the gap between the 

columns. You can also set the printing direction on the “Layout” tab. 

 

Only applicable to the “Page Footer” section. Allows you to gain space by 

removing unused page footer space. 

 

Prevents additional formatting changes from being applied to the section. Also 

prevents the use of formatting buttons that can format a section. 

 

When checked, locks the section next to a grid object, like a cross-tab. As the 

object changes in size, the section expands in relationship to the size of the 

object. Sa
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Advanced Formatting 

10.2- The Section Expert (cont.): 

 

 After checking any options which you wish to set in the “Section Expert” dialog box, you can click the 

“Color” tab. On the “Color” tab, if you wish to set the background color of the selected section, check the 

“Background Color” checkbox. That will then enable the drop-down box below the checkbox. Use the drop-

down to select the color which you want to display as the background color for the selected section. You 

can click the “More…” command to launch the “Color” dialog box where you can select from a wider range 

of colors or create your own custom background color. 

 Once you have made your choices as to the desired settings to apply to the selected sections, you 

can click the “OK” button at the bottom of the “Section Expert” dialog box. 

10.3- Conditionally Formatting a Section: 

 

 If you examine the “Section Expert” dialog box, you can see that many of the options which are 

available to use have formula selection buttons available for use. When you normally check an option in this 

tab, or many others (such as the ones in the “Format Editor” dialog box), you are turning the feature or 

format on or off unconditionally. Notice that the buttons which display the small blue “X+2” symbols can be 

clicked to conditionally apply a format using the Formula Editor in the Formula Workshop. Only when the 

formula you specify is met will the selected formatting be applied. For many of the types of formatting which 

you can apply, you will simply need to enter a logical test that will either evaluate to a true or false value, 

effectively enabling or disabling the formatting of the section. Other types of formatting, such as a 

“Background Color” formatting choice where there could be a number of possibilities, will need to have a 

logical “IF…THEN…ELSE” statement with the possible values specified. 

 Depending on the type of formatting you are trying to apply, type the necessary formula or formulas 

into the “Formula Text Box” and then save and close the conditional formula which you made to return to 

the “Section Expert” dialog box. Notice when you do this that the blue “X+2” button has switched to a 

maroon “X+2” button with a pencil pointing upwards. This indicates that a condition has been specified for 

the selected formatting condition. When you have specified the necessary conditions, you can then click 

“OK” in the “Section Expert” dialog box to view the formatting applied in the report. 

10.4- Conditionally Formatting a Field: 

 

 You can also apply conditional formatting to fields in a report using the “Format Editor” dialog box. 

While much of the conditional formatting which we would want to apply can be applied through the 

Highlighting Expert, we can also specify more involved conditions under which to apply specified formatting 

using the Formula Editor in the Formula Workshop window and the “Format Editor” dialog box. 

 To use this feature, first select the field to which you want to apply the conditional formatting in the 

report. Then either right-click and choose the “Format Field…” command from the pop-up menu which 

appears, or choose “Format| Format Field…” from the Menu Bar, or click the “Format” button in the Experts 

toolbar. 

 In the “Format Editor” dialog box, you can click the blue “X+2” button next to the format which you 

wish to conditionally apply. This will invoke the Formula Editor in the Formula Workshop window, where you 

can specify the formula which, if met, will then apply the selected formatting. When you are finished entering 

the formula, click “Save and Close” to return to the “Format Editor” dialog box. Here you can then click “OK” 

to save and set the desired conditional formatting. Sa
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Advanced Formatting 

10.5- Manipulating Multiple Sections: 

 

 When you create a new, blank report you are given five report sections to use by default: the report 

header, the page header, the details section, the report footer, and the page footer. Using the Section 

Expert allows us to create and delete additional sections within the framework of the five basic sections. For 

example, you can have a “Page Footer A” and a “Page Footer B.” 

 Having multiple sections within a report allows you to accomplish very sophisticated report layouts. 

For example, this can be used to display alternating background colors for each row in a report. You could 

also use this to show or hide lines when the fields are empty, or display text messages based on specified 

conditions. There are several ways in which you can use multiple report sections to create intricate report 

designs. Some of the section attributes which we examined in the Section Expert, such as the “Underlay” 

option, are often used in conjunction with multiple report sections. 

 To manipulate multiple report sections, first invoke the Section Expert dialog box. Note that there are 

buttons shown above the “Sections:” list at the left side of the dialog box. We use these buttons to add, 

position, and remove the various report sections. 

 You can select a report section from the listing at the left side of the dialog box, and then click the 

“Insert” button to insert an additional section of the same “type” beneath the selected listing. This will 

typically then show the two sections, listing the original as section “a” and the one you just created as 

section “b.” You can continue to add additional sections, which will simply consecutively increase the 

lettering for each section that you continue to add (such as “c,” “d,” etc…). 

 You can click on a section which you have added and then click the “Delete” button in the Section 

Expert dialog box to remove the selected section from the report. You can also merge the contents of two 

adjacent sections within the same section type. To do this, highlight the upper section of the two sections 

which you wish to merge into a single section and then click the “Merge” button to merge the selected 

section with the section below it. 

 You can use the “Up” and “Down” arrows to move the selected report section up or down through 

the list of sections available to reposition the section in the desired order. When you are finished, click “OK” 

in the Section Expert dialog box to return to the report. 
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ACTIONS- 

Advanced Formatting 
APPLYING CONDITIONAL FORMATTING USING THE HIGHLIGHTING EXPERT: 

 

1. Select the field to which you wish to apply the conditional formatting using the Highlighting Expert. 

2. Click the “Highlighting Expert” button in the Experts toolbar. 

 

OR 

 

2. Choose “Format| Highlighting Expert…” from the Menu Bar to open the “Highlighting Expert” dialog box. 

 

3. In the “Highlighting Expert” dialog box, you can click the “New” button to create a new item in the “Item 

list,” which is displayed at the left side of the “Highlighting Expert” dialog box. 

4. Use the “Value of:” drop-down to select the name of the field whose value you wish to use as the basis 

of the condition you are about to specify. 

5. Use the drop-down below the first drop-down to specify the comparison operator used for the condition. 

6. The third drop-down allows you to specify a value from the selected field. You can also type a value 

directly into the field itself, if needed. 

7. Next, use the “Font style:” drop-down to choose a selected font style for the displayed used. 

8. Use the “Font color:” drop-down to select from a basic set of color choices. Note that you can select the 

“Custom” color choice to launch the “Color” dialog box, where you can set your own custom color 

choice. 

9. You can use the “Background:” drop-down to choose a desired background color used for the display of 

the value. 

10. You can use the “Border:” drop-down to select the type of border to apply to the selected values when 

they meet the condition that you specify. 

11. You can create additional conditions by simply clicking the “New” button again and then repeating steps 

4 through 10 above. 

12. When you have finished specifying any conditional formatting choices that you wish, you can click the 

“OK” button at the bottom of the “Highlighting Expert” dialog box to apply the selected conditions. 

REMOVING CONDITIONAL FORMATTING USING THE HIGHLIGHTING EXPERT: 

 

1. Select the field from which you wish to remove the conditional formatting. 

2. Open the “Highlighting Expert” dialog box. 

3. Select the condition to remove from the “Item list.” 

4. Click the “Remove” button at the bottom of the “Item list.” 

REORGANIZING CONDITIONAL FORMATTING USING THE HIGHLIGHTING EXPERT: 

 

1. Select the field from which you wish to remove the conditional formatting. 

2. Open the “Highlighting Expert” dialog box. 

3. In the “Item list,” select which condition to reorganize. 

4. You can click the “up” and “down” arrows to the right of the “Item list” to reorganize the order in which 

the conditional formatting will be enforced. 

5. When you have finished specifying any conditional formatting choices that you wish, you can click the 

“OK” button at the bottom of the “Highlighting Expert” dialog box. Sa
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ACTIONS- 

Advanced Formatting 
SETTING SECTION PROPERTIES USING THE SECTION EXPERT: 

 

1. Click the “Section Expert” button in the Experts toolbar. 

 

OR 

 

1. Choose “Report| Section Expert…” from the Menu Bar. 

 

OR 

 

1. Right-click on one of the names of the sections listed at the left side of the report Design view and then 

choose the “Section Expert…” command from the pop-up menu which appears. 

2. Click on the name of a section displayed in the list at the left side of the “Section Expert” dialog box to 

select it and view its properties on the tabs to the right. 

3. On the “Common” tab, you can check any options which you wish to set. 

4. If using Crystal Reports 2008, set any paging options that you desire on the “Paging” tab. 

5. Click the “Color” tab if you wish to set the background color of the selected section by checking the 

“Background Color” checkbox. That will enable the drop-down box below the checkbox. Use the drop-

down to select the color which you want to display as the background color for the selected section. You 

can click the “More…” command to launch the “Color” dialog box where you can select from a wider 

range of colors or create your own custom background color. 

6. Once you have made your choices as to the desired settings to apply to the selected sections, you can 

click the “OK” button at the bottom of the “Section Expert” dialog box. 

CONDITIONALLY FORMATTING A SECTION USING THE SECTION EXPERT: 

 

1. Invoke the “Section Expert” dialog box. 

2. In the “Section Expert” dialog box, you can see many of the options have formula selection buttons 

(X+2). 

3. Click the “X+2” button next to the formatting option which you wish to conditionally apply. 

4. In the Formula Editor, create the formula which, when met, will apply the selected formatting feature. 

5. Click “Save and Close” in the Formula Workshop window. 

6. Notice that the blue “X+2” button has switched to a maroon “X+2” button with a pencil pointing upwards 

to indicate that a condition has been specified for the selected formatting condition. 

7. When you have set any additional conditions you would like, you can then click “OK” in the “Section 

Expert” dialog box to view the formatting applied in the report. 
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ACTIONS- 

Advanced Formatting 
CONDITIONALLY FORMATTING A REPORT FIELD: 

 

1. To use this feature, first select the field to which you want to apply the conditional formatting. 

2. Then either right-click and choose the “Format Field…” command from the pop-up menu which appears. 

 

OR 

 

2. Choose “Format| Format Field…” from the Menu Bar. 

 

OR 

 

2. Click the “Format” button in the Experts toolbar. 

3. In the “Format Editor” dialog box, you can click the blue “X+2” button next to the format which you wish 

to conditionally apply. 

4. This will invoke the Formula Editor in the Formula Workshop window, where you can specify the formula 

which, if met, will then apply the selected formatting. 

5. When you are finished entering the formula, click “Save and Close” to return to the “Format Editor” 

dialog box. 

6. Here you can then click “OK” to save and set the desired conditional formatting. 

MANIPULATING MULTIPLE REPORT SECTIONS USING THE SECTION EXPERT: 

 

1. Invoke the “Section Expert” dialog box. 

2. You can select a report section from the listing at the left side of the dialog box, and then click the 

“Insert” button to insert an additional section of the same “type” beneath the selected listing. 

3. You can click on a section which you have added and click the “Delete” button in the “Section Expert” 

dialog box to remove the selected section from the report. 

4. You can also merge the contents of two adjacent sections within the same section type. To do this, 

highlight the upper section of the two sections which you wish to merge into a single section and then 

click the “Merge” button to merge the selected section with the section below it. 

5. You can use the “Up” and “Down” arrows to move the selected report section up or down through the list 

of sections available to reposition the section in the desired order. 

6. When you have finished making your changes to the sections, click “OK” to return to the report. 
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EXERCISES- 

Advanced Formatting 
Purpose: 

 

1. To be able to apply advanced conditional formatting to our reports. 

Exercises: 

 

1. Open Crystal Reports. 

2. Select “File| Open…” from the Menu Bar to launch the “Open” dialog box. 

3. Click the “My Documents” folder at the left side of the dialog box, or use the “Look in:” drop-down at 

the top of the dialog box to navigate to the “My Documents” folder. 

4. Select the “Employee Sales Report,” which was created during the earlier exercises. 

5. Click the “Open” button. 

6. Click the “Design” tab. 

7. Choose “Report| Section Expert…” from the Menu Bar. 

8. In the “Section Expert” dialog box, click on the “Group Header #2: Employee.Employee ID – A” in 

the “Sections:” listed at the left side of the dialog box. 

9. Click the “Insert” button above the “Sections:” list to insert a new section called “Group Header #2b: 

Employee.Employee ID – A” in the “Section Expert.” 

10. Ensure that the “Group Header #2b: Employee.Employee ID – A” section is highlighted in the 

“Sections:” list, and click the “Common” tab at the right side of the dialog box to bring it forward, if 

necessary. 

11. Click the “Underlay Following Sections” checkbox to place a checkmark into the checkbox. 

12. Click “OK.” 

13. Using the “Field Explorer” pane, add the “Photo” field from the “Employee” table at the far left edge 

of the “Group Header #2b:” section. 

14. Click on the “Sum of Orders.Order Amount” summary field in the “Group Footer #2” section. 

15. Choose “Format| Highlighting Expert…” from the Menu Bar. 

16. Click the “New” button in the lower left corner of the “Highlighting Expert” dialog box. 

17. Use the first drop-down in the upper right corner to select “this field.” 

18. Use the second drop-down to select “is greater than or equal to.” 

19. Type “$50,000.00” into the third text box. 

20. Use the “Font style:” drop-down to select “Bold.” 

21. Use the “Font color:” drop-down to select “Red.” 

22. Click “OK.” 

23. Select “File| Save” from the Menu Bar. 

24. Click the “Print Preview” button in the Standard toolbar to inspect the changes to the report‟s 

appearance. 

25. Select “File| Close” from the Menu Bar to close the report when you are finished previewing the 

data. 
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CHAPTER 11- 

Summary Reports 

11.1- Summarizing Report Data 

 

11.2- Using the DrillDownGroupLevel Feature 
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Summary Reports 

11.1- Summarizing Report Data: 

 

 You can create summary reports that show the summarized totals of detail data, but hide the details 

upon which the summary values are calculated. Once you have created a full report with groupings and 

data values which you have summarized, Crystal Reports makes it very easy to display a summary report 

from the detailed report data. In the “Section Expert” dialog box, it was shown that each section could have 

its “Suppress” or “Hide” option set for the data it contains on the “Common” tab. Checking either of these 

options will suppress the detail data from displaying. The difference is that you may double-click on a 

section that has been set to “Hide” in order to view the detail data on a separate “Preview” tab. When you 

check the “Suppress” option, you will not be able to double-click to “drill-down” to the detail data upon which 

the summary value is calculated. 

 Once you have selected which detail sections to hide, all you will see in the report is the information 

shown in the report, page, and group headers and footers. This is the summary format of the report. Once 

again, you may be able to double-click on the summary values to display their associated detail data on a 

new “Preview” tab if you selected to “Hide” the detail data versus “Suppress” the detail data in the “Section 

Expert” dialog box. 

11.2- Using the DrillDownGroupLevel Feature: 

 

 As long as you choose to “Hide” the detail data in summary reports versus suppressing the detail 

data, you can double-click on the summary values which are displayed within the report to show the hidden 

detail data on a new preview tab. However, sometimes the field headings will still appear in section 

headings where you wish that they wouldn‟t. You can use conditional formatting and the 

“DrillDownGroupLevel” function to show or hide information depending on which drill-down grouping level is 

being displayed. 

 When you are viewing the information in a drill-down level, you will need to know the number value 

assigned to the detail information which you are viewing. The topmost level is always zero (0). The first 

grouping is level 1, the second grouping is level 2, and so on and so forth. 

 You can then choose to suppress the display of information while viewing a specified drill-down 

group level, by selecting the field or section to suppress and then clicking the “X+2” button next to the 

“Suppress (No Drill-Down)” option. In the “Formula Text” window, you can then type the following general 

formula: DrillDownGroupLevel = Number, where “Number” is the number of the drill-down level for which 

you wish to suppress the display of the selected information. 
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ACTIONS- 

Summary Reports 
CREATING SUMMARY REPORTS: 

 

1. First, create a report with field groupings and summarized data values. 

2. Select “Report| Section Expert…” from the Menu Bar. 

3. In the “Section Expert” dialog box select the section of the report (usually the “Details” section) which 

contains the detail records which you wish to hide in order to simply show summary fields. 

4. If you do not want the users to preview the report and double-click on the summary values to see the 

detail of the records which contributed to the summarized value on a separate “Preview” tab, then check 

the “Suppress (No Drill-Down)” option on the “Common” tab. 

5. If you do want the users to preview the report and double-click on the summary values to see the detail 

of the records which contributed to the summarized value on a separate “Preview” tab, then check the 

“Hide (Drill-Down OK)” option on the “Common” tab. 

6. Click “OK” to apply the selected settings to the chosen sections. 

USING THE DRILLDOWNGROUPLEVEL FEATURE: 

 

1. Knowing the group number allows us to apply conditional suppression to the desired information. The 

topmost level is always zero (0). The first grouping is level 1, the second grouping is level 2, and so on 

and so forth. 

2. You can choose to suppress the display of information while viewing a specified drill-down group level, 

by selecting the field or section to suppress and then clicking the “X+2” button next to the “Suppress (No 

Drill-Down)” option in the associated “Format” dialog box or the “Section Expert” dialog box. 

3. In the “Formula Text” window, you can then type the following general formula: DrillDownGroupLevel = 

Number, where “Number” is the number of the drill-down level for which you wish to suppress the 

display of the selected information. 
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EXERCISES- 

Summary Reports 
Purpose: 

 

1. To be able to create a summary report with drill-down capabilities in Crystal Reports 10. 

Exercises: 

 

1. Open Crystal Reports 10 and click “Cancel” in the “Welcome to Crystal Reports” dialog box. 

2. Select “File| New…” from the Menu Bar to launch the “Crystal Reports Gallery” dialog box. 

3. Select the “As a Blank Report” option button and click “OK.” 

4. In the “Database Expert” dialog box, expand the “Favorites” data source connection to reveal the 

“Xtreme Sample Database 10” connection, which we created in the “Chapter 3- Exercise” from the 

“Introductory Crystal Reports” manual. 

5. Expand the “Xtreme Sample Database 10” and then expand the “Tables” within the database. 

6. Double-click the “Customer” table to move it into the “Selected Tables:” list. 

7. Double-click the “Orders” table to move it into the “Selected Tables:” list. 

8. Double-click the “Orders_Detail” table to move it into the “Selected Tables:” list. 

9. Click “OK” in the “Database Expert” window. 

10. Select “Insert| Text Object” from the Menu Bar. 

11. Click into the upper left corner of the report in the “Report Header” to place the text object. 

12. Type the report title of “Customer Order Report” into the text object. 

13. Click outside of the text object to stop editing the text. 

14. Ensure that the text object is selected, and then select “Format| Format Text…” from the Menu Bar. 

15. On the “Common” tab, type “ReportTitle” into the “Object Name:” text box. 

16. On the “Font” tab, select “Bold” from the “Style:” drop-down. 

17. On the “Font” tab, select “16” from the “Size:” drop-down. 

18. Click “OK” in the “Format Editor” dialog box. 

19. Resize the text object to fully display the text enclosed within the object. 

20. In the “Field Explorer” pane, select the “Formula Fields” list and then click the “New” button in the 

toolbar at the top of the “Field Explorer” pane. 

21. In the “Formula Name” dialog box, type “Sale Amount” into the “Name:” text box. 

22. Click the “Use Editor” button in the “Formula Name” dialog box. 

23. Ensure that the “Syntax:” drop-down is set to “Crystal Syntax.” 

24. Enter the following formula into the formula text window: {Orders_Detail.Unit 

Price}*{Orders_Detail.Quantity}. 

25. Click “Save and Close” to return to the report‟s Design view. 

26. Click and drag the “Sale Amount” field from the “Field Explorer” and deposit it at 3” on the horizontal 

ruler in the “Details” section of the report. 

27. Select “Report| Group Expert…” from the Menu Bar. 

28. In the “Group Expert” dialog box, select “Customer ID” from the “Available Fields:” list and click the 

“>” arrow to move it to the “Group By:” list at the right side of the dialog box. 

29. Click the “Options…” button to launch the “Change Group Options” dialog box. 

30. Click the “Options” tab, and click the “Customize Group Name Field” checkbox. 

31. Select the “Choose From Existing Field” option button. 

32. Select “Customer Name” from the drop-down menu. 
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EXERCISES- 

Summary Reports 
Exercises (cont.): 

 

33. Click “OK” in the “Change Group Options” dialog box. 

34. Click “OK” in the “Group Expert” dialog box. 

35. Choose “Insert| Summary…” from the Menu Bar. 

36. In the “Insert Summary” dialog box, select “Sale Amount” from the “Choose the field to summarize:” 

drop-down. 

37. Choose “Sum” from the “Calculate this summary:” drop-down. 

38. Select “Group #1: Customer.Customer ID – A” from the “Summary location” drop-down. 

39. Click “OK” to insert the summary field. 

40. Copy the “Sale Amount” label from the “Page Header” section and paste the copy into the “Group 

Header #1:” section. Do not change its horizontal position. 

41. Select “Report| Section Expert…” from the Menu Bar. 

42. In the “Section Expert” dialog box, select the “Details” section from the “Sections:” listed at the left. 

43. Check the “Hide (Drill-Down OK)” checkbox on the “Common” tab. 

44. Click “OK.” 

45. Select “File| Save As…” from the Menu Bar. 

46. In the “Save As” dialog box, save the reports to your “My Documents” folder and type the name of 

“Customer Order Report” into the “File name:” text box. 

47. Click “Save” to save the report to the selected directory with the given name. 

48. Select “File| Print Preview” from the Menu Bar. Note the way that the label “Sale Amount” is 

repeated for each record because it appears in both the “Page Header” and also in the “Group 

Header.” 

49. Double-click on any of the summary values displayed to show the detail records which contributed to 

the value upon which you just double-clicked on their own tab. 

50. Click the red “X” on each preview tab to delete them. 

51. We will now suppress the display of the “Sale Amount” label in the “Group Header #1:” but only 

when viewing the topmost level of the report (not when viewing a drill-down group). To do this, right-

click on the “Sale Amount” field that is shown in the “Group Header #1:” field and then select “Format 

Text…” from the Menu Bar. 

52. In the “Format Editor” dialog box on the “Common” tab, click the “X+2” button that is to the right of 

the “Suppress” checkbox to launch the “Formula Editor” window. 

53. Expand the “Functions” pane to reveal the “Print State” function group. 

54. Expand the “Print State” function group and double-click on the “DrillDownGroupLevel” function to 

insert it into the “Formula Text” window. 

55. Type “=0” after the “DrillDownGroupLevel” in the “Formula Text” window. 

56. Click the “Save and close” button in the Formula Workshop window. 

57. Click “OK” in the “Format Editor” dialog box. 

58. Select “File| Print Preview” from the Menu Bar to view the report on the “Preview” tab. Note that the 

secondary display of the “Sale Amount” label has been suppressed. If you double-click on a 

summary field to display it on its own tab, however, note that the field will be displayed. 

59. Click the small red “X” on each “Preview” tab to delete the preview tabs you have created. 

60. Select “File| Save” from the Menu Bar to save the changes to the report that were made. 

61. Select “File| Close” from the Menu Bar to close the report. 
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EXERCISES- 

Summary Reports 
Purpose: 

 

1. To be able to create a summary report with drill-down capabilities in Crystal Reports 2011, 2008 & 

11. 

Exercises: 

 

1. Open Crystal Reports 2011, 2008 or 11. 

2. Click the “Blank Report” hyperlink in the “Start Page.” 

3. In the “Database Expert” dialog box, expand the data source connection to reveal the sample 

database connection, which was created in the “Chapter 3- Exercise” from the “Introductory Crystal 

Reports” manual. 

4. Expand the sample database and then expand the “Tables” within the database. 

5. Double-click the “Customer” table to move it into the “Selected Tables:” list. 

6. Double-click the “Orders” table to move it into the “Selected Tables:” list. 

7. Double-click the “Orders_Detail” table to move it into the “Selected Tables:” list. 

8. Click “OK” in the “Database Expert” window. 

9. Click “OK” in the “Database Expert” window again, once you have viewed the “Links” tab shown. 

10. Select “Insert| Text Object” from the Menu Bar. 

11. Click into the upper left corner of the report in the “Report Header” to place the text object. 

12. Type the report title of “Customer Order Report” into the text object. 

13. Click outside of the text object to stop editing the text. 

14. Ensure that the text object is selected, and then select “Format| Format Text…” from the Menu Bar. 

15. On the “Common” tab, type “ReportTitle” into the “Object Name:” text box. 

16. On the “Font” tab, select “Bold” from the “Style:” drop-down. 

17. On the “Font” tab, select “16” from the “Size:” drop-down. 

18. Click “OK” in the “Format Editor” dialog box. 

19. Resize the text object to fully display the text enclosed within the object. 

20. In the “Field Explorer” pane, select the “Formula Fields” list and then click the “New” button in the 

toolbar at the top of the “Field Explorer” pane. 

21. In the “Formula Name” dialog box, type “Sale Amount” into the “Name:” text box. 

22. Click the “Use Editor” button in the “Formula Name” dialog box, if prompted. 

23. Ensure that the “Syntax:” drop-down is set to “Crystal Syntax.” 

24. Enter the following formula into the formula text window: {Orders_Detail.Unit 

Price}*{Orders_Detail.Quantity}. 

25. Click “Save and Close” to return to the report‟s Design view. 

26. Click and drag the “Sale Amount” field from the “Field Explorer” and deposit it at 3” on the horizontal 

ruler in the “Details” section of the report. 

27. Select “Report| Group Expert…” from the Menu Bar. 

28. In the “Group Expert” dialog box, select “Customer ID” from the “Available Fields:” list and click the 

“>” arrow to move it to the “Group By:” list at the right side of the dialog box. 

29. Click the “Options…” button to launch the “Change Group Options” dialog box. 

30. Click the “Options” tab, and click the “Customize Group Name Field” checkbox. 

31. Select the “Choose From Existing Field” option button. 

32. Select “Customer Name” from the drop-down menu. 
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EXERCISES- 

Summary Reports 
Exercises (cont.): 

 

33. Click “OK” in the “Change Group Options” dialog box. 

34. Click “OK” in the “Group Expert” dialog box. 

35. Choose “Insert| Summary…” from the Menu Bar. 

36. In the “Insert Summary” dialog box, select “Sale Amount” from the “Choose the field to summarize:” 

drop-down. 

37. Choose “Sum” from the “Calculate this summary:” drop-down. 

38. Select “Group #1: Customer.Customer ID – A” from the “Summary location” drop-down. 

39. Click “OK” to insert the summary field. 

40. Copy the “Sale Amount” label from the “Page Header” section and paste the copy into the “Group 

Header #1:” section. Do not change its horizontal position. 

41. Select “Report| Section Expert…” from the Menu Bar. 

42. In the “Section Expert” dialog box, select the “Details” section from the “Sections:” listed at the left. 

43. Check the “Hide (Drill-Down OK)” checkbox on the “Common” tab. 

44. Click “OK.” 

45. Select “File| Save As…” from the Menu Bar. 

46. In the “Save As” dialog box, save the reports to your “My Documents” folder and type the name of 

“Customer Order Report” into the “File name:” text box. 

47. Click “Save” to save the report to the selected directory with the given name. 

48. Select “View| Print Preview” from the Menu Bar. Note the way that the label “Sale Amount” is 

repeated for each record because it appears in both the “Page Header” and also in the “Group 

Header.” 

49. Double-click on any of the summary values displayed to show the detail records which contributed to 

the value upon which you just double-clicked on their own tab. 

50. Click the “X” on each preview tab to delete them. Return to the “Design” tab. 

51. We will now suppress the display of the “Sale Amount” label in the “Group Header #1:” but only 

when viewing the topmost level of the report (not when viewing a drill-down group). To do this, right-

click on the “Sale Amount” field that is shown in the “Group Header #1:” field and then select “Format 

Text…” from the Menu Bar. 

52. In the “Format Editor” dialog box on the “Common” tab, click the “X+2” button that is to the right of 

the “Suppress” checkbox to launch the “Formula Editor” window. 

53. Expand the “Functions” pane to reveal the “Print State” function group. 

54. Expand the “Print State” function group and double-click on the “DrillDownGroupLevel” function to 

insert it into the “Formula Text” window. 

55. Type “=0” after the “DrillDownGroupLevel” in the “Formula Text” window. 

56. Click the “Save and close” button in the Formula Workshop window. 

57. Click “OK” in the “Format Editor” dialog box. 

58. Select “View| Print Preview” from the Menu Bar to view the report on the “Preview” tab. Note that the 

secondary display of the “Sale Amount” label has been suppressed. If you double-click on a 

summary field to display it on its own tab, however, note that the field will be displayed. 

59. Click the small “X” on each “Preview” tab to delete the preview tabs you have created. 

60. Select “File| Save” from the Menu Bar to save the changes to the report that were made. 

61. Select “File| Close” from the Menu Bar to close the report. 

Sa
mple

- f
or

 ev
alu

ati
on

 pu
rp

os
es

 on
ly!



34 Advanced Crystal Reports ©TeachUcomp, Inc. 

CHAPTER 12- 

Charting 

12.1- The Chart Expert 

 

12.2- Editing Charts 

 

12.3- Setting General Chart Options- (2011, 2008 & 11) 

 

12.4- Setting General Chart Options- (10) 

 

12.5- Changing Chart Titles- (10) 

 

12.6- Formatting Selected Chart Items- (2011, 2008 & 11) 

 

12.7- Formatting Selected Chart Items- (10) 

 

12.8- Formatting a Data Series 

 

12.9- Formatting Chart Gridlines- (2011, 2008 & 11) 

 

12.10- Formatting a Chart Grid- (10) 

 

12.11- Setting Chart Axes Options- (2011, 2008 & 11) 

 

12.12- Adding Chart Trendlines 

 

12.13- Modifying a 3D Chart View 

 

12.14- Using Chart Templates 

 

12.15- Auto-Arranging Charts 
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Charting 

12.1- The Chart Expert: 

 

 Crystal Reports provides another useful tool for creating charts from the grouped and summarized 

data in your reports: the “Chart Expert.” You use the Chart Expert to quickly and easily create graphs and 

charts to supplement your report data. To insert a chart into your report, select “Insert| Chart…” from the 

Menu Bar. You can also click the “Insert Chart” button in the Insert toolbar. Next, click into the section of the 

report where you want to place the chart. Often, this will then launch the “Chart Expert” dialog box to assist 

you in creating your chart. If the “Chart Expert” dialog box does not launch, you can right-click on the chart 

that you just inserted and then choose the “Chart Expert…” command from the pop-up menu that appears. 

The “Chart Expert” dialog box is a series of tabs which you click through, setting your desired chart options 

in each as needed. 

 On the “Type” tab, you can select which type of chart to create in your report by clicking on the 

desired type in the “Chart type:” list. To the right of the listing of chart types, you will see the various chart 

sub-types from which you can select. You click on the specific sub-type that you wish to create at the right, 

and you can read the description of the chart type in the small text box below the sub-type. Also, for some 

of the chart types (like the “Bar” type), you can select either a “Vertical” or “Horizontal” display by choosing 

the desired option button at the bottom of the “Chart type:” list. If using Crystal Reports 10, notice that the 

“Automatically set chart options” checkbox is already checked. When checked, Crystal Reports 10 sets the 

chart attributes such as the axis settings, data point settings, and other chart formatting options. If you wish 

to specify these settings on your own, you can uncheck this checkbox. Depending on the chart type you 

selected, this will then enable the display of two other tabs: “Axes” and “Options.” 

 On the “Data” tab, you can set the display of the data used in the chart. If using Crystal Reports 10, 

in the “Placement” section you can select where to place the chart object by using the drop-down and 

option buttons available to place the chart that you will create. For all versions, in the “Layout” section you 

can choose either “Advanced,” “Group,” “Cross-Tab,” or “OLAP.” Not every choice may be available, 

depending on the data source of the report. Whichever button is selected in the “Layout” section impacts the 

display of the “Data” section of the “Data” tab. 

 For most reports with grouping applied, the “Group” choice will appear as the default. This then 

allows you to select for which grouped field‟s values (if you have more than one) you want to show the 

summary data by choosing the field to use from the “On change of:” drop-down. Then use the “Show:” drop-

down to select which field‟s values to display for each change in the value of the field you had just selected 

in the drop-down above. 

 If you select the “Advanced” layout, you can then specify by which field you want to create the 

groupings by using the listing of fields shown in the “Available Fields:” list. Use the drop-down to the right to 

select either “On change of,” “For each record,” or “For all records.” If you select either “On change of” or 

“For each record,” you will then need to specify which field to use from the “Available Fields:” list. Select the 

field to use and then click the “>” button to move it to the list at the right. Then, for each record or group 

selected, you can then choose which field‟s summary values to display. Just click on the field whose values 

you wish to display from the “Available Fields:” list, and then click the “>” arrow to move it into the “Show 

value(s):” list at the right. Crystal Reports will then attempt to display a summary value (like “Sum” or 

“Count”) for the field. If you want to change the summary used, click on the summary field‟s value and then 

click the “Set Summary Operation…” button. In the “Edit Summary” dialog box which appears, you can 

select the summary function to display from the “Calculate this summary:” drop-down. When you are 

finished, click “OK” to set the summary options that you wish. If you have selected to show the change in 

value for a specified field, then you can check the “Don‟t Summarize” option, to not show a summary of a 

field, if you do not wish to see one for the change in the field shown above. 

 If you have a cross-tab table as the basis for your report, you can click the “Cross-Tab” layout button 
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Charting 

12.1- The Chart Expert (cont.): 

 

to display the cross-tab display options at the right. These are similar to the normal “Group” options, 

however, you also have the option to show the data subdivided by a secondary field, if needed. You can 

select which field to use for that purpose from the “Subdivided by:” drop-down. 

 If you have an OLAP data cube as the basis for your data source, then you will see options similar to 

the ones that you have for the cross-tab display. You can use the “On change of” drop-down to select the 

dimension that you want to use for plotting the values in the chart. Then use the “Subdivided by” drop-down 

to choose the secondary row or column by which to base the chart. You can click the “Other Dimensions” 

button to invoke the “Format Other Dimensions” dialog box. In this dialog box, you can click on a dimension 

shown and then click “Select a field value” to specify a new field for the dimension to be fixed to. 

 If using Crystal Reports 10, the “Axes” tab will only be displayed if you elected to remove the check 

from the “Automatically set chart options” checkbox on the “Type” tab. However, this tab appears by default 

in Crystal Reports 2011, 2008 and 11. You can click on the “Axes” tab to set the axes of the chart. 

Depending on the type of chart which you are trying to create, the options on this tab will vary. For some 

chart types, such as a “Pie” chart, this tab will not even appear as it would be completely devoid of any 

meaning or function for that type of chart. In the “Show gridlines” section, you have two columns of 

checkboxes for the “Major” and “Minor” gridlines. Depending upon the type of chart that you are creating, 

you will then have checkboxes for “Group axis (x):,” “Series axis (y):,” “Data axis (z):,” and/or “Data 2 axis.” 

You can check or uncheck any boxes that correspond to the types of gridlines you want to show or hide. 

 In the “Data values” section, you can specify what range of data values to plot in the chart. If you 

check the “Auto scale” checkbox, you will specify that the number of data labels is adjusted so that they will 

clearly display along the data axis. If “Auto range” is checked, the data values for the data axis are assigned 

a default range of values to plot. If unchecked, you can then use the “Min” and “Max” text boxes to set the 

desired minimum and maximum values to plot. Also, you can use the “Number format” drop-down to set the 

number formatting used for the data axis. You may also have a “Data 2” axis for which you can set the 

number display if you are using a cross-tab or OLAP chart. 

 In the “Number of divisions” section, you can set the number of divisions used for the corresponding 

data axis. If you select the “Automatic” option, then Crystal Reports will automatically set the number of 

divisions for the data axis. If you select the “Manual” option, then you can type the desired number of 

divisions to display into the text box at the right. 

 If you unchecked the “Automatically set chart options” on the “Type” tab in Crystal Reports 10, then 

you can set the chart display options on the “Options” tab. This tab appears by default in Crystal Reports 

2011, 2008 and 11. In the “Chart color” section you can specify either a “Color” chart or a “Black and White” 

chart by clicking the desired option button. If using Crystal Reports 10, you can click the “Format” button to 

launch the “Chart Color Format Expert” dialog box, where you can set conditional chart colors based on 

whether or not the data matches a criteria that you specify. This button becomes the “Color Highlight” tab in 

Crystal Reports 2011, 2008 & 11, which you can click to set conditional chart formatting. You can set the 

criteria and colors here, just as you do when using the “Highlighting Expert.” If you use conditional chart 

coloring in Crystal Reports 10, click “OK” in the separate dialog box when you are finished creating your 

conditions. 

 In the “Data points” section of the “Options” tab in the “Chart Expert” dialog box, you set what to 

display for the data points plotted in your chart. You can check the “Show label” checkbox to show the label 

next to each plotted value. You can check the “Show value” checkbox to show the value that is being 

plotted in the chart. This is often very useful for “Pie” chart types. If you elect to show the value plotted, you 

can then use the “Number format:” drop-down to select the formatting of the values displayed. 

 In the “Customize settings” section, you can set the display of data markers and pie slices in your 
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12.1- The Chart Expert (cont.): 

 

charts, if the type of chart that you selected makes use of those features. 

 You can check the “Transparent background” checkbox to remove the appearance of the 

background of the chart, allowing underlying objects to become visible through the chart background. If you 

are creating a “Line” type chart, you can use the “Marker size:” drop-down to select the size of the markers 

used to plot the data points on the line chart. You use the “Marker shape:” drop-down to choose what shape 

to make the data markers. You can use the “Viewing angle:” drop-down to choose the angle from which you 

will appear to be viewing the chart. If you are using a pie chart, you can use the “Pie size:” drop-down to set 

the size which you want the pie to be. If you are creating a bar chart, you can use the “Bar size:” drop-down 

to set the size of the bar chart. If you happen to be creating a pie chart, you can check the “Detach pie slice” 

checkbox to have one of the pieces of the pie appear detached from the rest of the pie. You can then use 

the option buttons to the right to choose to detach either the “Smallest slice” or the “Largest slice.” 

 In the “Legend” section you set the appearance of the legend in the chart. To set the legend to 

display, you can check the “Show Legend” checkbox. Use the “Placement:” drop-down to specify where to 

place the legend within the chart. Then you can use the “Layout:” drop-down to set whether to show 

percentage values, amount values, both, or none in the legend. 

 After setting the options on the other tabs, you can click the “Text” tab to set the options for the 

display of the text within the chart. Here you can set the text to display for the various text elements within 

the chart. If you leave the “Auto-Text” checkbox checked the text elements will be automatically created 

using the default values assigned by Crystal Reports. You can clear the “Auto-Text” checkboxes and then 

specify your own titles in the text boxes to the right, if you like. 

 You can use the “Format” section at the bottom of the “Text” tab to set the display of the text in the 

chart. To do this, just click on the type of text to format within the scrolling list, such as “Title.” Then click the 

“Font…” button to launch the “Font” dialog box where you can set the font used to display that type of data 

within the chart. 

 When you have finished setting your desired chart options in the “Chart Expert” dialog box, click 

“OK” to insert a chart with the specified settings into your report. Note that you can double-click on a data 

series within the chart to “drill-down” to display the underlying data on a separate “Preview” tab. 
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12.2- Editing Charts: 

 

 You can edit a chart object once it has been created, if needed. You can click the chart object once 

to select it and set the focus of the application to the chart object. It will appear with a blue border around its 

perimeter so that you can tell when it is selected. You can click and drag the chart object around by its 

border to move it, if needed. You can also place your mouse pointer over any one of the small blue resizing 

squares on the border of the chart until you see the mouse pointer turn into a double-pointed arrow. You 

can then click and drag at that point to change the size of the chart area. 

 It is important to also notice that a chart is really a larger container for several independently 

selectable smaller objects. While you can make changes to the entire chart area, you can also click on the 

individual elements, such as the data series, the legend, and the labels within the chart after you have 

selected the entire chart area by simply clicking once again on the particular object that you wish to select 

within the chart area. You will find that not only can you edit the properties of the entire chart, but you can 

also set the properties of the individual elements within the chart. 

 To edit the chart object itself using the “Chart Expert” after you have created it, just select the chart 

object and then choose “Format| Chart Expert…” from the Menu Bar. You can also just right-click on the 

chart object and then select the “Chart Expert…” command from the pop-up menu that appears. You can 

then step back through the tabs in the “Chart Expert” dialog box, changing the settings as needed. 

12.3- Setting General Chart Options- (Crystal Reports 2011, 2008 & 11): 

 

 You can set general options for a selected chart by choosing “Chart| Chart Options…” from the 

Menu Bar in Crystal Reports 2011, 2008 & 11. You could also right-click on the chart and choose “Chart 

Options…” from the pop-up menu which appears. Either way, this will launch the “Chart Options” dialog 

box. This dialog box is used to change the layout and appearance of a chart and also hide and show chart 

labels and other chart objects. 

 You can click the “Appearance” tab to set general formatting options for your selected chart type. 

The options displayed here will vary depending on the type of chart selected. Depending on what type of 

chart you created, you will use the sliders and settings on this tab to set the options for your chart type. 

 On the “Titles” tab, you can set options for the chart titles which you have available. 

 On the “Data Labels” tab you can set the general display options of the data labels used for the 

chart. Note that for “Gauge” chart types, the “Data Labels” options are set on the “Quality Bands” tab, 

instead. Once again, the options for how to display the data labels will change, depending on your selected 

chart type. 

 On the “Legend” tab, you can set options for the display and placement of the chart legend. 

 On the “Gridlines” tab, you can set the formatting and display of the gridlines in your selected chart. 

 On the “Axes” tab, you can set the formatting and display of chart axes. If you are setting the 

properties of a dual-axes chart, then you can set the additional axes options on the “Multi-Axes” tab. This 

tab will only appear if you check the “Dual Axes” checkbox on the “Axes” tab, if available. 

 Once you have set the general chart options that you wish to view in this dialog box, click “OK” to 

apply the changes to your selected chart. 
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12.4- Setting General Chart Options- (Crystal Reports 10): 

 

 You can set general options for a selected chart by choosing “Chart| Chart Options| General…” from 

the Menu Bar in Crystal Reports. You could also right-click on the chart and choose “Chart Options| 

General…” from the pop-up menu which appears. Either way, this will launch the “Chart Options” dialog 

box. This dialog box is used to change the layout and appearance of a chart and also hide and show chart 

labels and other chart objects. 

 You can click the “General” tab, to set general formatting options for your selected chart type. The 

options displayed here will vary depending on the type of chart selected. Depending on what type of chart 

you elected to create, you will use the sliders and settings on this tab to set the options for your chart type. 

 On the “Layout” tab, you can set general layout options for the chart type which you have selected. 

Make any changes to the chart type layout that you prefer by choosing the desired options. 

 On the “Data Labels” tab you can set the general display options of the data labels used for the 

chart. Note that for “Gauge” chart types, the “Data Labels” options are set on the “Display Status” tab, 

instead. Once again, the options for how to display the data labels will change, depending on your selected 

chart type. Also, if you selected to display data labels on the “Data Labels” tab, you can then set the display 

of the numbers used in the data labels on the “Numbers” tab. 

 If you have a dual axes chart type selected on the “Layout” tab, then you can set the formatting 

options for the dual axes of the chart on the “Dual Y Options” tab. 

 On the “Look” tab, you can set various options that impact the look of the chart. You can set options 

such as the placement of the legend, the placement of the data markers, and the appearance of the box 

border of the chart area. Make any changes to the settings that you desire for your chart type on this tab. 

 On the “Display Status” tab, you can check or uncheck the various checkboxes to show or hide the 

chart elements listed next to the boxes. Once you have set the general chart options that you wish to view 

in this dialog box, click “OK” to apply the changes to your selected chart. 

12.5- Changing Chart Titles- (Crystal Reports 10): 

 

 You can set the chart titles in your chart by selecting the chart and then choosing “Chart| Chart 

Options| Titles…” from the Menu Bar. You could also just right-click on the chart and then select “Chart 

Options| Titles…” from the pop-up menu which appears. When you perform either of these actions, you will 

invoke the “Titles” dialog box. Here you can type the desired text for whichever of the titles listed in the box 

you want to change. Then click “OK” to set the new text for the selected titles. 
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12.6- Formatting Selected Chart Items- (Crystal Reports 2011, 2008 & 11): 

 

 You can set the formatting of selected chart items by first selecting the individual item within the 

chart area that has the appearance that you wish to change. In Crystal Reports 2011, 2008 or 11, you can 

then choose “Chart| Format (object name)…” from the top of the Menu Bar drop-down menu, or just right-

click on the selected chart element and choose “Format (object name)…” from the pop-up menu which 

appears.  

 In the “Format (object name)” dialog box which appears, there are various tabs which you can use to 

change the appearance of the selected item. The specific tabs available will depend entirely on the type of 

object selected. Common tabs that are available for many objects are: “Font,” “Line,” “Border,” “Layout,” and 

“Fill.” Depending on what object was selected, note that some of these tabs may appear unavailable for 

use. For example, if there was no text associated with the selected chart object, then the “Font” tab would 

appear unavailable. 

 On the “Font” tab, you can set the style of text displayed in the selected object. Use the drop-downs 

on this tab to make your desired changes. You can change the font face used by selecting a choice from 

the “Font:” drop-down. You can add bolding or italics by clicking either the “B” or “I” button, as desired. You 

can then click one of the buttons available to set the horizontal alignment of the text within the selected 

object. You can select either “Align Left,” “Align Center,” or “Align Right.” You can click the “Color:” drop-

down to pick a font color from the colors displayed in the color cubes in the drop-down menu. If you wish to 

create a custom color, you may click the “More…” button toward the bottom of this drop-down to open the 

“Color” dialog box, where you can create and set a custom color. You can then use the “Size:” drop-down to 

select a font size. Use the “Frame:” drop-down to select a style of border for the selected text. The options 

that you choose can be viewed in the “Preview:” window at the bottom of this tab. 

 On the “Line” tab, you can set the color of the selected line of the chart item using the “Color:” drop-

down. Then use the “Style:” and “Thickness:” drop-downs to set the desired line style and thickness for the 

selected line. 

 On the “Border” tab, you can set the color of the border of the selected chart item using the “Color:” 

drop-down. Then use the “Style:” and “Thickness:” drop-downs to set the desired line style and thickness for 

the border. 

 On the “Layout” tab, you can set the appearance of the legend and labels in the chart. Use the 

checkboxes and drop-down on this tab to make your desired selections. The exact options available in this 

tab will depend on the type of chart which you have selected. 

 On the “Fill” tab, you set the fill, or interior, color of the selected chart object. You can apply a simple 

color choice using the color cubes available from the “Foreground Color:” drop-down. However, if you would 

like a more sophisticated appearance, you can make use of the “Pattern,” “Gradient,” “Texture,” and 

“Picture” buttons to apply a more interesting fill effect than just a simple color. 

 To apply a pattern, click the “Pattern…” button to open the “Choose a Pattern” dialog box. In this 

dialog box, select a pattern that you want to use as the fill pattern from the choices listed at the left. You can 

then set the “Foreground:” and “Background:” colors by clicking the “paint can” button next to each label, 

and then selecting the desired choice from the drop-down menu of color cube choices. The pattern that you 

have selected will be displayed in the “Preview:” square. When you have the desired pattern set, click “OK” 

to return to the “Fill” tab in the “Format (object name)” dialog box. 

 You can apply a gradient by clicking the “Gradient…” button to open the “Choose a gradient to apply 

to the selected areas” dialog box. Here, you can simply click on the type of gradient that you want to apply 

in the list shown and then click “OK” to apply the selected gradient. If you wish to create your own 

customized gradient, then you can instead click the “Advanced Options >>” button to expand the dialog box.  Sa
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12.6- Formatting Selected Chart Items- (Crystal Reports 2011, 2008 & 11- cont.): 

 

 To the right, you can create and customize your own gradients. You can begin to create a gradient 

by selecting a preset gradient from the list that is as similar as possible to the gradient that you would like to 

create. You could also use the drop-down below the gradient preview to select the name of a preset 

gradient to use, or you can click the arrow buttons to scan through the list of presets until you find the one 

you want. 

 You can change the colors used in the displayed gradient by clicking the “paint can” buttons shown 

at either end of the gradient strip and then selecting the desired color to use from the color cubes displayed. 

You can change the type of gradient pattern used by selecting either the “Linear,” “Circular,” or 

“Rectangular” option buttons. You can then use the “Angle,” “Horizontal Offset” and “Vertical Offset” spinner 

buttons to change the direction and angle of the gradient. 

 When you have created the desired gradient, you can then click a button to save or dismiss your 

changes. Click the “Save” button to save your changes and overwrite the old preset gradient. You can click 

the “Save As…” button to invoke the “Enter the Gradient Preset Name” dialog box, where you can type a 

new name for the gradient which you have created and then click “OK” to create and save a new preset 

gradient. You can rename a gradient by clicking the “Rename” button and typing the new name into the 

“Enter the Gradient Preset Name” dialog box. You can click the “Delete” button to delete the selected preset 

gradient. You can click the “Duplicate” button to create a duplicate copy of the current gradient, if desired. 

Once you have made any changes to the gradient, you can click “OK” to return to the “Fill” tab of the 

“Format (object name)” dialog box. 

 You can apply a texture to a selected chart object by clicking the “Texture...” button on the “Fill” tab 

of the “Format (object name)” dialog box. This opens the “Choose a texture to apply to the selected areas” 

dialog box. You can click on the name of the tab that contains the type of texture that you would like to use. 

You can then scroll through the lists of available textures on the tab and click on the one that you would like 

to use. If you click the “Advanced Options >>” button, you will view the expanded dialog box, where you can 

choose additional customization options for your texture by choosing the desired option buttons. The 

changes that you select can be seen in the preview box at the right side of the dialog box. When you have 

selected the desired texture and set any additional options which you would like to apply, click “OK” to 

return to the “Format (object name)” dialog box. 

 If you want to use a picture as the fill effect for the selected chart object, then click the “Picture…” 

button in the “Fill” tab to open the “Choose a picture” dialog box. You can select one of the pieces of clip art 

displayed by clicking on it. If you wish to set any additional options, you can click the “Advanced Options 

>>” button to expand the dialog box to the right. You can click the checkbox for “Pictograph (Scale Picture 

to Grid Unit)” to fit one entire picture within each major grid unit of the data series of a bar chart. You can 

then select one of the selected display options for flipping the image from the four options shown. If you 

wish to browse for a piece of clip art to use from your computer or network, you can click the “Browse…” 

button to launch the “Open” dialog box. You can then navigate to the folder that contains the clip art (.wmf) 

file that you wish to use in the report. You can click on the file to select it and then click the “Open” button to 

return to the “Choose a Picture” dialog box. Click “OK” when you are ready to return to the “Fill” tab of the 

“Format (object name)” dialog box. 

 After you have set the desired formatting options for the selected chart element in the “Format 

(object name)” dialog box, click “OK” to apply the selected formatting. 
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12.7- Formatting Selected Chart Items- (Crystal Reports 10): 

 

 You can set the formatting of selected chart items by first selecting the individual item within the 

chart area that has the appearance that you wish to change. In Crystal Reports 10, you can then choose 

“Chart| Chart Options| Selected Item…” from the Menu Bar or just right-click on the chart element and then 

choose “Chart Options| Selected Item…” from the pop-up menu which appears.  

 In the “Formatting” dialog box which appears, there are generally three tabs which you can use to 

change the appearance of the selected item: “Font,” “Line,” and “Fill.” Depending on what object was 

selected, note that some of these tabs may appear unavailable for use. For example, if there was no text 

associated with the selected chart object, then the “Font” tab would appear unavailable. 

 On the “Font” tab, you can pick a color from the colors displayed in the color cubes. If you wish to 

create a custom color, you may right-click on one of the gray color cubes toward the bottom of this tab to 

launch the “Color” dialog box, where you can create and set a custom color. Then use the drop-down boxes 

to the right of the color cubes to set the “Font,” “Size,” “Style,” “Alignment,” “Box,” and “Rotation” of the 

selected text. The options that you set can be viewed in the “Preview:” window. 

 On the “Line” tab, you can set the color of the line or border of the selected chart item using the color 

cubes available on this tab. Then use the “Style” and “Thickness” drop-downs to set the desired line style 

and thickness for the selected object‟s border. 

 On the “Fill” tab, you set the fill, or interior, color of the selected chart object. You can apply a simple 

color choice using the color cubes available. However, if you would like a more sophisticated appearance, 

you can make use of the “Pattern,” “Gradient,” “Texture,” and “Picture” tabs to apply a more interesting fill 

effect than just a simple color choice. 

 To apply a pattern as the fill effect used for the selected chart object, click the “Pattern…” button on 

the “Fill” tab. This will then launch the “Choose a Pattern” dialog box. In this dialog box, select a pattern that 

you want to use as the fill pattern from the choices listed at the left side of the dialog box. You can then set 

the “Foreground:” and “Background:” colors by clicking the “paint can” button next to each label, and then 

selecting the desired choice from the drop-down menu of color cube choices. The pattern that you have 

selected will be displayed in the “Preview:” square. When you have the desired pattern set, click “OK” to 

return to the “Fill” tab in the “Formatting” dialog box. 

 You can apply a gradient as the fill effect of the selected chart item by clicking the “Gradient…” 

button in the “Fill” tab of the “Formatting” dialog box. This will launch the “Choose a gradient to apply to the 

selected areas” dialog box. Here, you can simply click on the type of gradient that you want to apply in the 

list shown and then click “OK” to apply the selected gradient. If you wish to create your own customized 

gradient, then you can instead click the “Advanced Options >>” button to expand the dialog box. To the 

right, you can create and customize your own gradients. You can begin to create a gradient by selecting a 

preset gradient from the list that is as similar as possible to the gradient that you would like to create. You 

could also use the drop-down below the gradient preview to select the name of a preset gradient to use, or 

you can click the arrow buttons to scan through the list of presets until you find the one you want. 

 You can change the colors used in the displayed gradient by clicking the “paint can” buttons shown 

at either end of the gradient strip and then selecting the desired color to use from the color cubes displayed. 

You can change the type of gradient pattern used by selecting either the “Linear,” “Circular,” or 

“Rectangular” option buttons. You can then use the “Angle,” “Horizontal Offset” and “Vertical Offset” spinner 

buttons to change the direction and angle of the gradient. 

 When you have created the desired gradient, you can then click a button to save or dismiss your 

changes. Click the “Save” button to save your changes and overwrite the old preset gradient. You can click 

the “Save As…” button to invoke the “Enter the Gradient Preset Name” dialog box, where you can type a 

new name for the gradient which you have created and then click “OK” to create and save a new preset 
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12.7- Formatting Selected Chart Items- (Crystal Reports 10- cont.): 

 

gradient. You can rename a gradient by clicking the “Rename” button and typing the new name into the 

“Enter the Gradient Preset Name” dialog box. You can click the “Delete” button to delete the selected preset 

gradient. You can click the “Duplicate” button to create a duplicate copy of the current gradient, if desired. 

Once you have made any changes to the gradient, you can click “OK” to return to the “Fill” tab of the 

“Formatting” dialog box. 

 You can apply a texture to a selected chart object by clicking the “Texture...” button on the “Fill” tab 

of the “Formatting” dialog box. This opens the “Choose a texture to apply to the selected areas” dialog box. 

You can click on the name of the tab that contains the type of texture that you would like to use as the fill 

effect. You can then scroll through the lists of available textures and click on the one that you would like to 

use. If you click the “Advanced Options >>” button, you will view the expanded dialog box, where you can 

choose additional customization options for your texture by choosing the desired option buttons. The 

changes that you select can be seen in the preview box at the right side of the dialog box. When you have 

selected the desired texture and set any additional options which you would like to apply, click “OK” to 

return to the “Formatting” dialog box. 

 If you want to use a picture as the fill effect for the selected chart object, then click the “Picture…” 

button in the “Fill” tab to open the “Choose a picture” dialog box. You can select one of the pieces of clip art 

displayed by clicking on it. If you wish to set any additional options, you can click the “Advanced Options 

>>” button to expand the dialog box to the right. You can click the checkbox for “Pictograph (Scale Picture 

to Grid Unit)” to fit one entire picture within each major grid unit of the data series of a bar chart. You can 

then select one of the selected display options for flipping the image from the four options shown. If you 

wish to browse for a piece of clip art to use from your computer or network, you can click the “Browse…” 

button to launch the “Open” dialog box. You can then navigate to the folder that contains the clip art (.wmf) 

file that you wish to use in the report. You can click on the file to select it and then click the “Open” button to 

return to the “Choose a Picture” dialog box. Click “OK” when you are ready to return to the “Fill” tab of the 

“Formatting” dialog box. 

 After you have selected the desired formatting options for the selected chart element in the 

“Formatting” dialog box, click “OK” to apply the selected formatting. 
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12.8- Formatting a Data Series: 

 

 You can apply formatting to an individual data series in your chart by first selecting a data series 

within your chart. If using Crystal Reports 10, then choose “Chart| Chart Options| Series…” from the Menu 

Bar or right-click on the selected data series and select “Chart Options| Series…” from the pop-up menu 

which appears to invoke the “Series Options” dialog box. If using Crystal Reports 2011, 2008 or 11, then 

choose “Chart| Series Options…” from the Menu Bar or right-click on the selected data series and select 

“Series Options…” from the pop-up menu which appears to invoke the “Series Options” dialog box. In this 

dialog box are the tabs which you can use to format the selected series. 

 The tabs which are displayed in this dialog box vary based upon the chart type selected. For most 

charts, you can set general display options using the settings displayed on the “General” or “Appearance” 

tab, depending on which version of Crystal Reports you are using. If you click the “Data Labels” tab, you 

can apply formatting options to the data labels in the currently selected data series. If you selected to show 

the values on the “Data Labels” tab, then you may then have the “Numbers” tab become active. On the 

“Numbers” tab, you can select what format you wish to use for the values displayed in the data labels of the 

chart. 

 If you have a data series that displays trends, such as a bar chart or line chart, then you can set the 

appearance of the trendlines in the selected data series of the chart by choosing the desired options on the 

“Trendlines” tab. When you have set any formatting options that you want to apply to the selected data 

series, just click “OK” to apply the selected options. 

12.9- Formatting Chart Gridlines- (Crystal Reports 2011, 2008 & 11): 

 

 If you have created a chart that makes use of an underlying grid of values upon which the data 

series are charted, you can set the formatting of the chart gridlines and value scaling. To do so, first select a 

chart gridline. Note that you may have to be very careful where you click, as it is sometimes tricky to select 

a gridline. Once it is selected, choose “Chart| Format Grid Lines…” from the Menu Bar. You could also just 

right-click on the chart and then choose “Format Grid Lines…” from the pop-up menu which appears. 

 In the “Format Gridlines…” dialog box, you can format all of the gridlines in your chart. On the “Line” 

tab, you can set general formatting options such as the color and thickness of the selected gridlines. On the 

“Scales” tab you can set scaling options like the minimum and maximum values to display on the axis, the 

base measurement unit, and the major and minor scaling units. If you want Crystal Reports to handle the 

settings, you can check the checkboxes under the “Auto-Scale” column for the “Minimum Value:,” 

“Maximum Value:,” “Major Interval:,” and “Minor Steps:.” If you want to set your own value settings for any 

one of these values shown, just uncheck the checkbox and then specify the desired value in the text box to 

the right of the attribute label. You also have a separate section of checkbox options that you can check or 

uncheck to alter the appearance of the gridlines, as desired. 

 On the “Layout” tab, you can select whether or not to display the major and minor gridlines within the 

chart grid. You can also use the drop-downs available to specify additional stylistic settings for the 

appearance of the ticks and lines of the gridlines. Once you have set the appearance of the gridlines within 

the grid as you would like, click “OK” to close the dialog box and apply the selected formatting. 
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12.11- Setting Chart Axes Options- (Crystal Reports 2011, 2008 & 11): 

 

 You can set the attributes of chart axes by first selecting the axis within the chart area whose 

attributes you wish to edit. Note that you have to be very careful where you click when selecting an axis, as 

it can be tricky to select. Once you have the desired axis selected, choose “Chart| Axis Options…” from the 

Menu Bar or just right-click on the selected axis and choose “Axis Options…” from the pop-up menu which 

appears. This will make the axis settings dialog box appear. The title of the dialog box will change, 

depending on which axis you selected. 

 In the dialog box, you can set options for the selected axis. The exact options available change 

slightly depending upon which axis is selected. On the “Layout” tab, you can select whether or not to display 

the axis lines and labels and also set axis and label options by checking the desired checkboxes or 

selecting the desired option buttons. On the “Scales” tab, you can set scaling options to display on the axis. 

If you want Crystal Reports to handle the settings, you can check the checkboxes under the “Auto-Scale” 

column for the “Minimum Value:,” “Maximum Value:,” “Major Interval:,” and “Minor Steps:.” If you want to set 

your own value settings for any one of these values shown, just uncheck the checkbox and then specify the 

desired value in the text box. You also have a separate section of checkbox options that you can check or 

uncheck to alter the appearance of the axis, as desired. On the “Numbers” tab, which will appear for 

numbers on value axes only, you can select the type of numeric formatting to use from the “Category:” drop-

down. You can also set the number of decimals to display, whether or not to use a thousands separator, 

and the abbreviation of the numbers to use for large values. On the “Gridlines” tab, you can set the display 

of the major and minor gridlines for values axes. Once you have set the appearance of the axes within the 

chart as you would like, click “OK” to close the dialog box and apply the selected options. 

12.10- Formatting a Chart Grid- (Crystal Reports 10): 

 

 If you have created a chart that makes use of an underlying grid of values upon which the values of 

the data series are charted, you can set the formatting of the chart axes, grid and gridlines, and value 

scaling within the selected chart. To do so, select the chart and then choose “Chart| Chart Options| Grid…” 

from the Menu Bar. You could also just right-click on the chart and then choose “Chart Options| Grid…” from 

the pop-up menu which appears. 

 In the “Numeric Axis Grids & Scales” dialog box, you can format all of the axes in your chart. You 

can click on the names of the available axes in your chart, which are listed on the tabs shown at the left side 

of this dialog box. Depending on what type of chart you have elected to create, not all of the axis types will 

necessarily be available. The possible tabs which could be shown at the left side of the dialog box are: 

“Data Axis,” “Group Axis,” “Data2 Axis,” “X Axis,” and “Series Axis.” You can click on the desired axis tab to 

set the options for the selected axis, which appear as the tabs along the top of this dialog box. The available 

tabs which you can use to set the appearance of the selected axis are: “General,” “Scales,” “Labels,” 

“Numbers,” and “Grids.” 

 On the “General” tab, you can set general formatting options, such as the placement and 

appearance of the selected axis. On the “Scales” tab you can set scaling options like the minimum and 

maximum values to display on the axis, the base measurement unit, and the major and minor scaling units. 

On the “Labels” tab you can select whether or not to display the axis labels and the minimum and maximum 

labels on the axis. On the “Numbers” tab, you can set the display of the numbers used to show the values of 

the selected axis. The “Grids” tab is used to determine which gridlines to display within the chart grid area 

and what additional settings you wish to specify for their appearance. 

 Once you have set the appearance of the gridlines within the grid as you would like, click “OK” to 

close the dialog box and apply the selected axis settings. 
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Charting 

12.12- Adding Chart Trendlines: 

 

 You can add a trendline against which you can display the values in the chart by first selecting a 

data series within the chart and then choosing “Chart| Trendlines…” from the Menu Bar, or by just right-

clicking on a data series and then selecting “Trendlines…” from the pop-up menu which appears. 

 In the “Trendlines” dialog box which appears, you can choose a type of trendline to add to the chart 

by clicking on the desired type of trendline to add in the “Available Types:” list at the left side of the dialog 

box. You can then click the “>” button to add the selected trendline to the “Show Trendlines:” list. 

 You can then set any additional options that you would like for the selected trendline by choosing 

the desired options underneath the “Show Trendlines:” list. Once you have set any display options for the 

selected trendline types that you have selected, click the “OK” button to add them to the selected chart. 

12.13- Modifying a 3D Chart View: 

 

 You can alter the 3D view of your 3D chart types by using the “Choose a Viewing Angle” dialog box. 

To access this dialog box, first select the 3D chart type whose display you wish to change. If using Crystal 

Reports 10, choose “Chart| Chart Options| Viewing Angle…” from the Menu Bar. If using Crystal Reports 

2011, 2008 or 11, choose “Chart| 3D Viewing Angle…” from the Menu Bar. Note that this is not available for 

charts that use the new “depth” feature of charts that appears in Crystal Reports, but only for true 3D chart 

types, as selected in the first step of the Chart Expert. 

 The “Choose a Viewing Angle” dialog box is used to pan, rotate, and move your 3D chart within the 

chart area. To quickly change the 3D view of your chart, you can click one of the preset pictures that 

represent the types of 3D views available for use from the list of views shown. 

 If you want to make your own custom 3D view, click the “Advanced Options >>” button in the upper 

right corner of the dialog box to expand the dialog box to the right. You will see four tabs which can be used 

to make your own custom 3D adjustments: “Rotate,” “Pan,” “Walls,” and “Move.” 

 On the “Rotate” tab, you can click the arrow buttons in the image or to the right of the “X,” “Y,” and 

“Z” letters to change the rotation of the currently selected view. You can click the “Pan” tab and then click 

the arrows displayed in the image or to the right of the “X,” “Y,” and “Zoom” labels to change the perspective 

on the 3D view. On the “Walls” tab you can click the arrow buttons in the image or to the right of the “X,” “Y,” 

and “Z” labels to increase or decrease the thickness or length of the walls in the chart. If you click the “Link” 

checkbox, you will only need to click the “X” coordinate to also increase the “Y” and “Z” coordinates at the 

same time. You can click the “Move” tab to change the position of the 3D chart in the chart area by clicking 

on the arrows in the diagram to move the selected chart view or by clicking the arrows to the right of the “X,” 

“Y,” and “Z” labels. 

 You can then click one of the buttons at the right side of this dialog box to determine what you would 

like to do after making your custom 3D view. You can click the “Save” button to save your changes over the 

currently selected preset view. You can click the “Save As…” button to launch the “Enter 3D Viewing Angle 

Preset Name,” where you can type a new name for your new custom 3D view. Click “OK” to save the new 

view as a custom preset view. 

 You can also click the “Rename” button to launch the “Enter 3D Viewing Angle Preset Name,” where 

you can type a new name for the currently selected 3D view. Click “OK” to save the view with a new name. 

You can click the “Delete” button at the right side of the dialog box to delete the currently selected view from 

the dialog box. You can click the “Duplicate” button to create a duplicate of the currently selected view in the 

dialog box. When you have made whatever changes you want in this dialog box, click “OK” to apply the 

selected 3D view. Sa
mple

- f
or

 ev
alu

ati
on

 pu
rp

os
es

 on
ly!



47 Advanced Crystal Reports ©TeachUcomp, Inc. 

Charting 

12.14- Using Chart Templates: 

 

 You can use the available chart templates to quickly apply a pre-created chart type to your chart 

data, or you can save a chart type that you have customized as your own custom chart template to re-use it 

in the future without having to reset and re-apply all of the custom formatting which you have set. This can 

save a lot of time in formatting future charts that you may need to create. 

 To save a custom chart template, select the chart which you have formatted and now wish to save 

as a new chart template. Then choose “Chart| Save as Template…” from the Menu Bar. You can also 

simply right-click on the chart which you want to serve as the basis for your new template, and then select 

“Save as Template…” from the pop-up menu which appears. 

 In the “Save As” dialog box which appears, type a name for the template into the “File name:” text 

box at the bottom of the dialog box and click the “Save” button to save the template into the pre-designated 

folder with the name which you gave it. Do not change the folder into which it wants to save the template, as 

it will need to look into this folder in order to access the template in the future. 

 To apply a chart template in the future, first select the chart to which you would like to apply the 

template. If using Crystal Reports 10, select “Chart| Chart Options| Template…” from the Menu Bar. If using 

Crystal Reports 2011, 2008 or 11, select “Chart| Load Template…” from the Menu Bar. 

 If you want to apply a custom chart type which you have saved as a template, click the “Custom” tab 

and then click on the “User Defined” choice at the bottom of the “Categories:” list. Then select the saved 

template which you wish to apply to the selected chart from the list at the right side of the tab. Note that 

there are also several sets of “preset” custom chart types from which you can choose on the “Custom” tab. 

Once you have made your desired template choice, just click “OK” to apply the selected chart type. 

12.15- Auto-Arranging Charts: 

 

 Once you have applied all of the modifications that you want to the selected chart, you may want to 

use the “Auto-Arrange” feature to arrange the elements within the chart in a manner that makes the most 

use of the chart area that is available. This can oftentimes be more efficient that manually reorganizing the 

chart elements. To auto-arrange chart elements, select the chart and then choose “Chart| Auto-Arrange 

Chart” from the Menu Bar. 
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ACTIONS- 

Charting 
INSERTING A CHART: 

 

1. To insert a chart into your report, select “Insert| Chart…” from the Menu Bar or click the “Insert Chart” 

button in the Insert toolbar. 

2. In the “Chart Expert” dialog box click on the “Type” tab to select which type of chart to create by clicking 

on the desired type shown in the “Chart type:” list. 

3. To the right of the displayed chart types, you will see the various chart sub-types which you can click on 

to select. 

4. For some of the chart types (like the “Bar” type), you can select either a “Vertical” or “Horizontal” display 

by choosing the desired option button at the bottom of the “Chart type:” list. 

5. In Crystal Reports 10, if the “Automatically set chart options” checkbox is checked, Crystal Reports sets 

the chart attributes automatically. If you wish to set these on your own, you can uncheck this checkbox. 

Depending on the chart type you selected, this will then enable the display of two other tabs: “Axes” and 

“Options.” 

6. On the “Data” tab, you can set the display of the data used in the chart. 

7. If using Crystal Reports 10, in the “Placement” section you can select where to place the chart object by 

using the drop-down and option buttons available to place the chart that you will create. 

8. In the “Layout” section you can choose either “Advanced,” “Group,” “Cross-Tab,” or “OLAP.” Not every 

choice may be available, depending on the data source of the report. Whichever button is selected in the 

“Layout” section does impact the display of the “Data” section of the “Data” tab. 

9. For most reports with grouping applied, the “Group” choice will appear as the default. This then allows 

you to select for which grouped field‟s values (if you have more than one) you want to show the summary 

data by choosing the field to use from the “On change of:” drop-down. Then use the “Show:” drop-down 

to select which field‟s values to display for each change in the value of the field you had just selected in 

the drop-down above. 

10. If you select the “Advanced” layout, you can then specify by which field you want to create the groupings 

by using the listing of fields shown in the “Available Fields:” list. Use the drop-down to the right to select 

either “On change of,” “For each record,” or “For all records.” 

11. If you select either “On change of” or “For each record,” you will need to specify which field to use from 

the “Available Fields:” list. Select the field to use and click the “>” button to move it to the list at the right. 

12. For each record or group selected, you can then choose which field‟s summary values to display. Just 

click on the field whose values you wish to display from the “Available Fields:” list, and then click the “>” 

arrow to move it into the “Show value(s):” list at the right. Crystal Reports will then attempt to display a 

summary value (like “Sum” or “Count”) for the field. 

13. If you want to change the summary used, click on the summary field‟s value and then click the “Set 

Summary Operation…” button. In the “Edit Summary” dialog box which appears, you can select the 

summary function to display from the “Calculate this summary:” drop-down. When you are finished, click 

“OK” to set the summary options that you wish. 

14. If you have selected to show the change in value for a specified field, then you can check the “Don‟t 

Summarize” option, to not show a summary of a field, if you do not wish to see one for the change in the 

field shown above. 

15. If you have a cross-tab table as the basis for your report, you can click the “Cross-Tab” layout button to 

show the cross-tab display options at the right. These are similar to the normal “Group” options, however, 

you also have the option to show the data subdivided by a secondary field, if needed. You can select 

which field to use for that purpose from the “Subdivided by:” drop-down. 
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ACTIONS- 

Charting 
INSERTING A CHART (CONT.): 

 

16. If you have an OLAP data cube as the basis for your data source, then you will see options similar to the 

ones that you have for the cross-tab display. You can use the “On change of” drop-down to select the 

dimension that you want to use for plotting the values in the chart. Then use the “Subdivided by” drop-

down to choose the secondary row or column by which to base the chart. 

17. You can click the “Other Dimensions” button to invoke the “Format Other Dimensions” dialog box. In this 

dialog box, you can click on a dimension shown and then click “Select a field value” to specify a new field 

for the dimension to be fixed to. 

18. If using Crystal Reports 10, the “Axes” tab will only be displayed if you elected to remove the check from 

the “Automatically set chart options” checkbox on the “Type” tab. However, this tab appears by default in 

Crystal Reports 2011, 2008 and 11. You can click on the “Axes” tab to set the axes of the chart. 

Depending on the type of chart which you are trying to create, the options on this tab will vary. For some 

chart types, such as a “Pie” chart, this tab will not even appear as it would be completely devoid of any 

meaning or function for that type of chart. 

19. In the “Show gridlines” section, you have two columns of checkboxes for the “Major” and “Minor” 

gridlines. Depending upon the type of chart that you are creating, you will then have checkboxes for 

“Group axis (x):,” “Series axis (y):,” “Data axis (z):,” and/or “Data 2 axis.” You can check or uncheck any 

checkboxes that correspond to the types of gridlines that you want to show or hide. 

20. In the “Data values” section, you can specify what range of data values to plot in the chart. If you check 

the “Auto scale” checkbox, you will specify that the number of data labels is adjusted so that they will 

clearly display along the data axis. 

21. If “Auto range” is checked, the data values for the data axis are assigned a default range of values to 

plot. If unchecked, you can then use the “Min” and “Max” text boxes to set the desired minimum and 

maximum values to plot. 

22. You can use the “Number format” drop-down to set the number formatting used for axis data. You may 

also have a “Data 2” axis for which you can set number display in cross-tab or OLAP charts. 

23. In the “Number of divisions” section, you can set the number of divisions used for the corresponding 

data axis. If you select the “Automatic” option, then Crystal Reports will automatically set the number of 

divisions for the data axis. If you select the “Manual” option, then you can type the desired number of 

divisions to display into the text box at the right. 

24. If you unchecked the “Automatically set chart options” on the “Type” tab in Crystal Reports 10, you can 

set display options on the “Options” tab. This appears by default in Crystal Reports 2011, 2008 and 11. 

25. In the “Chart color” section you can specify either a “Color” chart or a “Black and White” chart by clicking 

the desired option button. 

26. If using Crystal Reports 10, you can click the “Format” button to launch the “Chart Color Format Expert” 

dialog box, where you can set conditional chart colors based on whether or not the data matches a 

criteria that you specify. This button becomes the “Color Highlight” tab in Crystal Reports 2011, 2008 and 

11, which you can click to set conditional chart formatting. You can set the criteria and colors here, just 

as you do when using the “Highlighting Expert.” If you elect to use conditional chart coloring and are 

using Crystal Reports 10, just click “OK” in the dialog box when you are finished creating your conditions. 

27. In the “Data points” section of the “Options” tab in the “Chart Expert” dialog box, you set what to display 

for the data points plotted in your chart. You can check the “Show label” checkbox to show the label next 

to each plotted value. You can check the “Show value” checkbox to show the value that is being plotted 

in the chart. This is often very useful for “Pie” chart types. If you elect to show the value plotted, you can 

then use the “Number format:” drop-down to select the formatting of the values displayed. 
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ACTIONS- 

Charting 
INSERTING A CHART (CONT.): 

 

28. In the “Customize settings” section, you can set the display of data markers and pie slices in your 

charts, if the type of chart that you selected makes use of those features. 

29. You can check the “Transparent background” checkbox to remove the appearance of the background of 

the chart, allowing underlying objects to become visible through the chart background. 

30. If you are creating a “Line” type chart, you can use the “Marker size:” drop-down to select the size of the 

markers used to plot the data points on the line chart. You use the “Marker shape:” drop-down to choose 

what shape to make the data markers. 

31. You can use the “Viewing angle:” drop-down to choose the angle from which you will appear to be 

viewing the chart. 

32. If you are using a pie chart, you can use the “Pie size:” drop-down to set the size which you want the pie 

to be. 

33. If you are creating a bar chart, you can use the “Bar size:” drop-down to set the size of the bar chart. 

34. If you happen to be creating a pie chart, you can check the “Detach pie slice” checkbox to have one of 

the pieces of the pie appear detached from the rest of the pie. You can then use the option buttons to the 

right to choose to detach either the “Smallest slice” or the “Largest slice.” 

35. In the “Legend” section you set the appearance of the legend in the chart. To set the legend to display, 

you can check the “Show Legend” checkbox. 

36. Use the “Placement:” drop-down to specify where to place the legend within the chart. Then you can 

use the “Layout:” drop-down to set whether to show percentage values, amount values, both, or none in 

the legend. 

37. After setting the options on the other tabs, you can click the “Text” tab to set the options for the display 

of the text within the chart. Here you can set the text to display for the various text elements within the 

chart. If you leave the “Auto-Text” checkbox checked the text elements will be automatically created 

using the default values assigned by Crystal Reports. You can clear the “Auto-Text” checkboxes and 

then specify your own titles in the text boxes to the right, if you like. 

38. You can use the “Format” section at the bottom of the “Text” tab to set the display of the text in the chart. 

To do this, just click on the type of text to format within the scrolling list, such as “Title.” Then click the 

“Font…” button to launch the “Font” dialog box where you can set the font used to display that type of 

data within the chart. 

39. When you have finished setting your desired chart options in the “Chart Expert” dialog box, click “OK” to 

insert a chart with the specified settings into your report. Note that you can double-click on a data series 

within the chart to “drill-down” to display the underlying data on a separate “Preview” tab. 

DRILLING-DOWN TO VIEW DATA IN A CHART: 

 

1. You can double-click on a data series within the chart to “drill-down” to display the underlying data on a 

separate “Preview” tab. 
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ACTIONS- 

Charting 
SELECTING A CHART: 

 

1. You can click the chart object once to select it and set the focus of the application to the chart object. It 

will appear with a blue border around its perimeter so that you can tell when it is selected. 

MOVING AND RESIZING A CHART: 

 

1. You can click and drag the chart object around by its blue border to move it. 

2. You can also place your mouse pointer over any one of the small blue resizing squares on the border of 

the chart until you see the mouse pointer turn into a double-pointed arrow. You can then click and drag at 

that point to change the size of the chart area. 

SELECTING A PART OF A CHART: 

 

1. You can click the chart object once to select it and set the focus of the application to the chart object. It 

will appear with a blue border around its perimeter so that you can tell when it is selected. 

2. Click once again on the particular object that you wish to select within the chart area. 

EDITING A CHART: 

 

1. To edit the chart object using the “Chart Expert,” select the chart object first. 

2. Choose “Format| Chart Expert…” from the Menu Bar or just right-click on the chart object and then select 

the “Chart Expert…” command from the pop-up menu that appears. 

3. You can then step back through the “Chart Expert” dialog box, changing the settings as needed. 

4. Click “OK” to apply the changed settings when you are finished. 

SETTING GENERAL CHART OPTIONS (CRYSTAL REPORTS 2011, 2008 AND 11): 

 

1.  You can set general options for a selected chart by choosing “Chart| Chart Options…” from the Menu 

Bar. You could also right-click on the chart and choose “Chart Options…” from the pop-up menu. 

2. In the “Chart Options” dialog box, you can click the “Appearance” tab to set general formatting options for 

your selected chart type. The options displayed here will vary depending on the type of chart selected. 

Depending on what type of chart you created, you will use the sliders and settings on this tab to set the 

options for your chart type. 

3. On the “Titles” tab, you can set options for the chart titles which you have available. 

4. On the “Data Labels” tab you can set the display options of the data labels used for the chart. Note that 

for “Gauge” chart types, the “Data Labels” options are set on the “Quality Bands” tab, instead. Once 

again, the options for how to display the data labels will change, depending on your selected chart type. 

5. On the “Legend” tab, you can set options for the display and placement of the chart legend. 

6. On the “Gridlines” tab, you can set the formatting and display of the gridlines in your selected chart. 

7. On the “Axes” tab, you can set the formatting and display of chart axes. If you are setting the properties of 

a dual-axes chart, then you can set the additional axes options on the “Multi-Axes” tab. This tab will only 

appear if you check the “Dual Axes” checkbox on the “Axes” tab, if available. 

8. Once you have set the general chart options that you wish to view in this dialog box, click “OK” to apply 

the changes to your selected chart. Sa
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ACTIONS- 

Charting 
SETTING GENERAL CHART OPTIONS (CRYSTAL REPORTS 10): 

 

1. Select either “Chart| Chart Options| General…” from the Menu Bar or right-click on the chart and select 

“Chart Options| General…” from the pop-up menu which appears. 

2. In the “Chart Options” dialog box, click the “General” tab. The options displayed will vary depending on 

the type of chart selected. Use the sliders and settings on this tab to set the options for your chart type. 

3. On the “Layout” tab, set general layout options for the chart type you have selected. Make any changes 

to the chart type layout that you prefer by choosing the desired options. 

4. On the “Data Labels” tab, set the general display options of the data labels used. Note that for “Gauge” 

chart types, the “Data Labels” options are set on the “Display Status” tab, instead. Also, if you selected to 

display data labels on the “Data Labels” tab, you can then set the display of the numbers used in the 

data labels on the “Numbers” tab. 

5. If you have a dual axes chart type selected on the “Layout” tab, then you can set the formatting options 

for the dual axes of the chart on the “Dual Y Options” tab. 

6. On the “Look” tab, you can set various options that impact the look of the chart. You can set options such 

as the placement of the legend, the placement of the data markers, and the appearance of the box 

border of the chart area. Make any changes to the settings that you desire for your chart type on this tab. 

7. On the “Display Status” tab, you can check or uncheck the various checkboxes to show or hide the chart 

elements listed next to the boxes. 

8. Once you have set the general chart options that you wish to view in this dialog box, click “OK” to apply 

the changes to your selected chart. 

CHANGING CHART TITLES (CRYSTAL REPORTS 10): 

 

1. Choose “Chart| Chart Options| Titles…” from the Menu Bar or just right-click on the chart and select 

“Chart Options| Titles…” from the pop-up menu which appears. 

2. In the “Titles” dialog box you can type the desired text for whichever of the titles listed in the box you want 

to change. 

3. Click “OK” to set the new text for the selected titles. 

FORMATTING CHART ITEMS (CRYSTAL REPORTS 2011, 2008 AND 11): 

 

1.  You can set the formatting of selected chart items by first selecting the individual item within the chart 

area that has the appearance that you wish to change. 

2. In Crystal Reports 2011, 2008 and 11, you can then choose “Chart| Format (object name)…” from the top 

of the Menu Bar drop-down menu, or just right-click on the selected chart element and choose “Format 

(object name)…” from the pop-up menu which appears. 

3. In the “Format (object name)” dialog box which appears, there are various tabs which you can use to 

change the appearance of the selected item. The specific tabs available will depend entirely on the type 

of object selected. Common tabs that are available for many objects are: “Font,” “Line,” “Border,” 

“Layout,” and “Fill.” Depending on what object was selected, note that some of these tabs may appear 

unavailable for use. For example, if there was no text associated with the selected chart object, then the 

“Font” tab would appear unavailable. 

4. On the “Font” tab, you can set the style of text displayed in the selected object. Use the drop-downs on 

this tab to make your desired changes. 
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ACTIONS- 

Charting 
FORMATTING CHART ITEMS (CRYSTAL REPORTS 2011, 2008 AND 11- CONT.): 

 

5. You can change the font face used by selecting a choice from the “Font:” drop-down. 

6. You can add bolding or italics by clicking either the “B” or “I” button, as desired. 

7. You can then click one of the buttons available to set the horizontal alignment of the text within the 

selected object. You can select either “”Align Left,” “Align Center,” or “Align Right.” 

8. You can click the “Color:” drop-down to pick a font color from the colors displayed in the color cubes in 

the drop-down menu. If you wish to create a custom color, you may click the “More…” button toward the 

bottom of this drop-down to open the “Color” dialog box, where you can create and set a custom color. 

9. You can then use the “Size:” drop-down to select a font size. 

10. Use the “Frame:” drop-down to select a style of border for the selected text. 

11. On the “Line” tab, you can set the color of the selected line of the chart item using the “Color:” drop-

down. 

12. Then use the “Style:” and “Thickness:” drop-downs to set the desired line style and thickness for the 

selected line. 

13. On the “Border” tab, you can set the color of the border of the selected chart item using the “Color:” 

drop-down. 

14. Then use the “Style:” and “Thickness:” drop-downs to set the desired line style and thickness for the 

border. 

15. On the “Layout” tab, you can set the appearance of the legend and labels in the chart. Use the 

checkboxes and drop-down on this tab to make your desired selections. The exact options available in 

this tab will depend on the type of chart which you have selected. 

16. On the “Fill” tab, you set the fill, or interior, color of the selected chart object. You can apply a simple 

color choice using the color cubes available from the “Foreground Color:” drop-down. However, if you 

would like a more sophisticated appearance, you can make use of the “Pattern,” “Gradient,” “Texture,” 

and “Picture” buttons to apply a more interesting fill effect than just a simple color. 

17. To apply a pattern, click the “Pattern…” button to open the “Choose a Pattern” dialog box. In this dialog 

box, select a pattern that you want to use as the fill pattern from the choices listed at the left. 

18. You can then set the “Foreground:” and “Background:” colors by clicking the “paint can” button next to 

each label, and then selecting the desired choice from the drop-down menu of color cube choices. 

19. The pattern that you have selected will be displayed in the “Preview:” square. When you have the 

desired pattern set, click “OK” to return to the “Fill” tab in the “Format (object name)” dialog box. 

20. You can apply a gradient by clicking the “Gradient…” button to open the “Choose a gradient to apply to 

the selected areas” dialog box. Here, you can simply click on the type of gradient that you want to apply 

in the list shown and then click “OK” to apply the selected gradient. 

21. If you wish to create your own customized gradient, then you can instead click the “Advanced Options 

>>” button to expand the dialog box. 

22. To the right, you can create and customize your own gradients. You can begin to create a gradient by 

selecting a preset gradient from the list that is as similar as possible to the gradient that you would like to 

create. You could also use the drop-down below the gradient preview to select the name of a preset 

gradient to use, or you can click the arrow buttons to scan through the list of presets until you find the 

one you want. 

23. You can change the colors used in the displayed gradient by clicking the “paint can” buttons shown at 

either end of the gradient strip and then selecting the desired color to use from the color cubes displayed. 

24. You can change the type of gradient pattern used by selecting either the “Linear,” “Circular,” or 

“Rectangular” option buttons. 
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ACTIONS- 

Charting 
FORMATTING CHART ITEMS (CRYSTAL REPORTS 2011, 2008 AND 11- CONT.): 

 

25. You can then use the “Angle,” “Horizontal Offset” and “Vertical Offset” spinner buttons to change the 

direction and angle of the gradient. 

26. When you have created the desired gradient, you can then click a button to save or dismiss your 

changes. Click the “Save” button to save your changes and overwrite the old preset gradient. 

27. You can click the “Save As…” button to invoke the “Enter the Gradient Preset Name” dialog box, where 

you can type a new name for the gradient which you have created and then click “OK” to create and save 

a new preset gradient. 

28. You can rename a gradient by clicking the “Rename” button and typing the new name into the “Enter the 

Gradient Preset Name” dialog box. 

29. You can click the “Delete” button to delete the selected preset gradient. 

30. You can click the “Duplicate” button to create a duplicate copy of the current gradient, if desired. 

31. Once you have made any changes to the gradient, you can click “OK” to return to the “Fill” tab of the 

“Format (object name)” dialog box. 

32. You can apply a texture to a selected chart object by clicking the “Texture...” button on the “Fill” tab of 

the “Format (object name)” dialog box. This opens the “Choose a texture to apply to the selected areas” 

dialog box. 

33. You can click on the name of the tab that contains the type of texture that you would like to use. You 

can then scroll through the lists of available textures on the tab and click on the one that you would like to 

use. 

34. If you click the “Advanced Options >>” button, you will view the expanded dialog box, where you can 

choose additional customization options for your texture by choosing the desired option buttons. The 

changes that you select can be seen in the preview box at the right side of the dialog box. 

35. When you have selected the desired texture and set any additional options which you would like to 

apply, click “OK” to return to the “Format (object name)” dialog box. 

36. If you want to use a picture as the fill effect for the selected chart object, then click the “Picture…” button 

in the “Fill” tab to open the “Choose a picture” dialog box. 

37. You can select one of the pieces of clip art displayed by clicking on it. If you wish to set any additional 

options, you can click the “Advanced Options >>” button to expand the dialog box to the right. 

38. You can click the checkbox for “Pictograph (Scale Picture to Grid Unit)” to fit one entire picture within 

each major grid unit of the data series of a bar chart. 

39. You can then select one of the selected display options for flipping the image from the four options 

shown. 

40. If you wish to browse for a piece of clip art to use from your computer or network, you can click the 

“Browse…” button to launch the “Open” dialog box. 

41. You can then navigate to the folder that contains the clip art (.wmf) file that you wish to use in the report. 

You can click on the file to select it and then click the “Open” button to return to the “Choose a Picture” 

dialog box. 

42. Click “OK” when you are ready to return to the “Fill” tab of the “Format (object name)” dialog box. 

43. After you have set the desired formatting options for the selected chart element in the “Format (object 

name)” dialog box, click “OK” to apply the selected formatting. 
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ACTIONS- 

Charting 
FORMATTING CHART ITEMS (CRYSTAL REPORTS 10): 

 

1. Select the individual item within the chart area that has the appearance that you wish to change. 

2. Choose “Chart| Chart Options| Selected Item…” from the Menu Bar or right-click on the chart element 

and choose “Chart Options| Selected Item…” from the pop-up menu which appears. 

3. In the “Formatting” dialog box which appears, there are three tabs which you can use to change the 

appearance of the selected item: “Font,” “Line,” and “Fill.” Note that some of these tabs may appear 

unavailable for use depending on what type of object was selected. 

4. On the “Font” tab, you can pick a color from the colors displayed in the color cubes. If you wish to create 

a custom color, you may right-click on one of the gray color cubes toward the bottom of this tab to launch 

the “Color” dialog box, where you can create and set a custom color. 

5. Then use the drop-down boxes to the right of the color cubes to set the “Font,” “Size, “ “Style,” 

“Alignment,” “Box,” and “Rotation” of the selected text. The options that you set can be viewed in the 

“Preview:” window. 

6. On the “Line” tab, you can set the color of the line or border of the selected chart item using the color 

cubes available on this tab. Then use the “Style” and “Thickness” drop-downs to set the desired line style 

and thickness for the selected object‟s border. 

7. On the “Fill” tab, you set the fill, or interior, color of the selected chart object. You can apply a simple color 

choice using the color cubes available. However, if you would like a more sophisticated appearance, you 

can make use of the “Pattern,” “Gradient,” “Texture,” and “Picture” tabs to apply a more interesting fill 

effect than just a simple color choice. 

8. To apply a pattern as the fill effect used for the selected chart object, click the “Pattern…” button on the 

“Fill” tab. 

9. This will then launch the “Choose a Pattern” dialog box. In this dialog box, select a pattern that you want 

to use as the fill pattern from the choices listed at the left side of the dialog box.  

10. You can set the “Foreground:” and “Background:” colors by clicking the “paint can” button next to each 

label, and then selecting the desired choice from the drop-down menu of color cube choices. The pattern 

that you have selected will be displayed in the “Preview:” square. When you have the desired pattern set, 

click “OK” to return to the “Fill” tab in the “Formatting” dialog box. 

11. You can apply a gradient as the fill effect of the selected chart item by clicking the “Gradient…” button in 

the “Fill” tab of the “Formatting” dialog box. 

12. In the “Choose a gradient to apply to the selected areas” dialog box, you can simply click on the type of 

gradient that you want to apply in the list shown and then click “OK” to apply the selected gradient. 

13. If you wish to create your own customized gradient, then you can instead click the “Advanced Options 

>>” button to expand the dialog box. To the right, you can create and customize your own gradients. You 

can begin to create a gradient by selecting a preset gradient from the list that is as similar as possible to 

the gradient that you would like to create. You could also use the drop-down below the gradient preview 

to select the name of a preset gradient to use, or you can click the arrow buttons to scan through the list 

of presets until you find the one you want. 

14. You can change the colors used in the displayed gradient by clicking the “paint can” buttons shown at 

either end of the gradient strip and then selecting the desired color to use from the color cubes displayed. 

You can change the type of gradient pattern used by selecting either the “Linear,” “Circular,” or 

“Rectangular” option buttons. You can then use the “Angle,” “Horizontal Offset” and “Vertical Offset” 

spinner buttons to change the direction and angle of the gradient. 
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ACTIONS- 

Charting 
FORMATTING CHART ITEMS (CRYSTAL REPORTS 10- CONT.): 

 

15. When you have created the desired gradient, you can then click a button to save or dismiss your 

changes. Click the “Save” button to save your changes and overwrite the old preset gradient. You can 

click the “Save As…” button to invoke the “Enter the Gradient Preset Name” dialog box, where you can 

type a new name for the gradient which you have created and then click “OK” to create and save a new 

preset gradient. You can rename a gradient by clicking the “Rename” button and typing the new name 

into the “Enter the Gradient Preset Name” dialog box. You can click the “Delete” button to delete the 

selected preset gradient. You can click the “Duplicate” button to create a duplicate copy of the current 

gradient, if desired. Once you have made any changes to the gradient, you can click “OK” to return to the 

“Fill” tab of the “Formatting” dialog box. 

16. You can apply a texture to a selected chart object by clicking the “Texture...” button on the “Fill” tab of 

the “Formatting” dialog box. This opens the “Choose a texture to apply to the selected areas” dialog box. 

You can click on the name of the tab that contains the type of texture that you would like to use as the fill 

effect. 

17. You can then scroll through the lists of available textures and click on the one that you would like to use. 

If you click the “Advanced Options >>” button, you will view the expanded dialog box, where you can 

choose additional customization options for your texture by choosing the desired option buttons. The 

changes that you select can be seen in the preview box at the right side of the dialog box. When you 

have selected the desired texture and set any additional options which you would like to apply, click “OK” 

to return to the “Formatting” dialog box. 

18. If you want to use a picture as the fill effect for the selected chart object, then click the “Picture…” button 

in the “Fill” tab to open the “Choose a picture” dialog box. 

19. You can select one of the pieces of clip art displayed by clicking on it. If you wish to set any additional 

options, you can click the “Advanced Options >>” button to expand the dialog box to the right. 

20. You can click the checkbox for “Pictograph (Scale Picture to Grid Unit)” to fit one entire picture within 

each major grid unit of the data series of a bar chart. 

21. You can then select one of the selected display options for flipping the image from the four options 

shown. 

22. If you wish to browse for a piece of clip art to use from your computer or network, you can click the 

“Browse…” button to launch the “Open” dialog box. You can then navigate to the folder that contains the 

clip art (.wmf) file that you wish to use in the report. You can click on the file to select it and then click the 

“Open” button to return to the “Choose a Picture” dialog box. 

23. Click “OK” when you are ready to return to the “Fill” tab of the “Formatting” dialog box. 

24. After you have selected the desired formatting options for the selected chart element in the “Formatting” 

dialog box, click “OK” to apply the selected formatting. 
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ACTIONS- 

Charting 
FORMATTING A DATA SERIES: 

 

1. Select a data series within your chart. 

2. If using Crystal Reports 10, then choose “Chart| Chart Options| Series…” from the Menu Bar or right-click 

on the selected data series and select “Chart Options| Series…” from the pop-up menu which appears to 

invoke the “Series Options” dialog box. 

 

OR 

 

2. If using Crystal Reports 2011, 2008 or 11, then choose “Chart| Series Options…” from the Menu Bar or 

right-click on the selected data series and select “Series Options…” from the pop-up menu which 

appears to invoke the “Series Options” dialog box. In this dialog box are the tabs which you can use to 

format the selected series. 

3. The tabs displayed in this dialog box vary based upon the chart type selected. For most charts, you can 

set general display options using the settings displayed on the “General” tab. 

4. If you click the “Data Labels” tab, you can apply formatting options to the data labels in the currently 

selected data series. 

5. If you selected to “Show Values” on the “Data Labels” tab, you may then have the “Numbers” tab become 

active. On the “Numbers” tab, you can select what format you wish to use for the values displayed in the 

data labels of the chart. 

6. If you have a data series that displays trends in a data series, such as a bar chart or line chart, then you 

can set the appearance of the trendlines in the selected data series of the chart by choosing the desired 

options on the “Trendlines” tab. 

7. When you have set any formatting options that you want to apply to the selected data series, just click 

“OK” to apply the selected options. 

FORMATTING CHART GRIDLINES (CRYSTAL REPORTS 2011, 2008 AND 11): 

 

1. Select a chart gridline. Note that you may have to be very careful where you click, as it is sometimes 

tricky to select a gridline. 

2. Once it is selected, choose “Chart| Format Grid Lines…” from the Menu Bar or just right-click on the chart 

and then choose “Format Grid Lines…” from the pop-up menu which appears. 

3. In the “Format Gridlines…” dialog box, you can format all of the gridlines in your chart. 

4. On the “Line” tab, you can set general formatting options such as the color and thickness of the selected 

gridlines. 

5. On the “Scales” tab you can set scaling options like the minimum and maximum values to display on the 

axis, the base measurement unit, and the major and minor scaling units. If you want Crystal Reports to 

handle the settings, you can check the checkboxes under the “Auto-Scale” column for the “Minimum 

Value:,” “Maximum Value:,” “Major Interval:,” and “Minor Steps:.” If you want to set your own value 

settings for any one of these values shown, just uncheck the checkbox and then specify the desired 

value in the text box to the right of the attribute label. You also have a separate section of checkbox 

options that you can check or uncheck to alter the appearance of the gridlines, as desired. 

6. On the “Layout” tab, you can select whether or not to display the major and minor gridlines within the 

chart grid. You can also use the drop-downs available to specify additional stylistic settings for the 

appearance of the ticks and lines of the gridlines. 

7. Click “OK” to close the dialog box and apply the selected formatting. Sa
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ACTIONS- 

Charting 
FORMATTING A CHART GRID (CRYSTAL REPORTS 10): 

 

1. Select the chart and then choose “Chart| Chart Options| Grid…” from the Menu Bar or just right-click on 

the chart and then choose “Chart Options| Grid…” from the pop-up menu which appears. 

2. In the “Numeric Axis Grids & Scales” dialog box, you can format all of the axes in your chart. You can 

click on the names of the available axes in your chart, which are listed on the tabs shown at the left side 

of this dialog box. 

3. Depending on what type of chart you have elected to create, not all of the axis types will necessarily be 

available. The possible tabs which could be shown at the left side of the dialog box are: “Data Axis,” 

“Group Axis,” “Data2 Axis,” “X Axis,” and “Series Axis.” 

4. You can click on the desired axis tab to set the options for the selected axis, which appear as the tabs 

along the top of this dialog box. The available tabs which you can use to set the appearance of the 

selected axis are: “General,” “Scales,” “Labels,” “Numbers,” and “Grids.” 

5. On the “General” tab, you can set general formatting options, such as the placement and appearance of 

the selected axis. 

6. On the “Scales” tab you can set scaling options like the minimum and maximum values to display on the 

axis, the base measurement unit, and the major and minor scaling units. 

7. On the “Labels” tab you can select whether or not to display the axis labels and the minimum and 

maximum labels on the axis. 

8. On the “Numbers” tab, you can set the display of the numbers used to show the values of the selected 

axis. 

9. The “Grids” tab is used to determine which gridlines to display within the chart grid area and what 

additional settings you wish to specify for their appearance. 

10. Once you have set the appearance of the gridlines within the grid as you would like, click “OK” to close 

the dialog box and apply the selected axis settings. 
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ACTIONS- 

Charting 

ADDING TRENDLINES TO A CHART: 

 

1. Select a data series within the chart and then choose “Chart| Trendlines…” from the Menu Bar or right-

click on a data series and then select “Trendlines…” from the pop-up menu which appears. 

2. In the “Trendlines” dialog box which appears, you can choose a type of trendline to add to the chart by 

clicking on the desired type of trendline to add in the “Available Types:” list at the left side of the dialog 

box. 

3. You can then click the “>” button to add the selected trendline to the “Show Trendlines:” list. 

4. You can then set any additional options that you would like for the selected trendline by choosing the 

desired options underneath the “Show Trendlines:” list. 

5. Once you have set any display options for the selected trendline types that you have selected, click the 

“OK” button to add them to the selected chart. 

SETTING CHART AXES OPTIONS (CRYSTAL REPORTS 2011, 2008 AND 11): 

 

1. You can set the attributes of chart axes by first selecting the axis within the chart area whose attributes 

you wish to edit. Note that you have to be very careful where you click when selecting an axis, as it can 

be tricky to select. 

2. Once you have the desired axis selected, choose “Chart| Axis Options…” from the Menu Bar or just right-

click on the selected axis and choose “Axis Options…” from the pop-up menu which appears. 

3. This will make the axis settings dialog box appear. The title of the dialog box will change, depending on 

which axis you selected. 

4. In the dialog box, you can set options for the selected axis. The exact options available change slightly 

depending upon which axis is selected. 

5. On the “Layout” tab, you can select whether or not to display the axis lines and labels and also set axis 

and label options by checking the desired checkboxes or selecting the desired option buttons. 

6. On the “Scales” tab, you can set scaling options like the minimum and maximum values to display on the 

axis. If you want Crystal Reports to handle the settings, you can check the checkboxes under the “Auto-

Scale” column for the “Minimum Value:,” “Maximum Value:,” “Major Interval:,” and “Minor Steps:.” If you 

want to set your own value settings for any one of these values shown, just uncheck the checkbox and 

then specify the desired value in the text box to the right of the attribute label. You also have a separate 

section of checkbox options that you can check or uncheck to alter the appearance of the gridlines, as 

desired. 

7. On the “Numbers” tab, which will appear for numbers on value axes only, you can select the type of 

numeric formatting to use from the “Category:” drop-down. You can also set the number of decimals to 

display, whether or not to use a thousands separator, and the abbreviation of the numbers to use for 

large values. 

8. On the “Gridlines” tab, you can set the display of the major and minor gridlines for values axes. 

9. Click “OK” to close the dialog box and apply the selected options. 
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ACTIONS- 

Charting 
MODIFYING A 3D CHART VIEW: 

 

1. Select the 3D chart type whose display you wish to change. 

2. If using Crystal Reports 10, choose “Chart| Chart Options| Viewing Angle…” from the Menu Bar. 

 

OR 

 

2. If using Crystal Reports 2011, 2008 or 11, choose “Chart| 3D Viewing Angle…” from the Menu Bar. Note 

that this is not available for charts that use the new “depth” feature of charts that appears in Crystal 

Reports, but only for true 3D chart types, as selected in the first step of the Chart Expert. 

3. You can easily change the 3D view of your chart by clicking on the picture that represents the type of 3D 

view you wish to use for the 3D chart‟s display in the list of views shown in the dialog box. 

4. If you want to make your own custom 3D view, click the “Advanced Options >>” button in the upper right 

corner of the dialog box to expand the dialog box to the right. You will see four tabs which can be used to 

make your own custom 3D adjustments: “Rotate,” “Pan,” “Walls,” and “Move.” 

5. On the “Rotate” tab, you can click the arrow buttons in the image or to the right of the “X,” “Y,” and “Z” 

letters to change the rotation of the currently selected view. 

6. You can click the “Pan” tab and then click the arrows displayed in the image or to the right of the “X,” “Y,” 

and “Zoom” labels to change the perspective on the 3D view. 

7. On the “Walls” tab you can click the arrow buttons in the image or to the right of the “X,” “Y,” and “Z” 

labels to increase or decrease the thickness or length of the walls in the chart. If you click the “Link” 

checkbox, you will only need to click the “X” coordinate to also increase the “Y” and “Z” coordinates at 

the same time. 

8. You can click the “Move” tab to change the position of the 3D chart in the chart area by clicking on the 

arrows in the diagram to move the selected chart view or by clicking the arrows to the right of the “X,” “Y,” 

and “Z” labels. 

9. You can then click one of the buttons at the right side of this dialog box to determine what you would like 

to do after making your custom 3D view. You can click the “Save” button to save your changes over the 

currently selected preset view. 

10. You can click the “Save As…” button to launch the “Enter 3D Viewing Angle Preset Name,” where you 

can type a new name for your new custom 3D view. Click “OK” to save the new view as a custom preset 

view. 

11. You can also click the “Rename” button to launch the “Enter 3D Viewing Angle Preset Name,” where 

you can type a new name for the currently selected 3D view. Click “OK” to save the view with a new 

name. 

12. You can click the “Delete” button at the right side of the dialog box to delete the currently selected view 

from the dialog box. 

13. You can click the “Duplicate” button to create a duplicate of the currently selected view in the dialog box. 

14. When you have made whatever changes you want, click “OK” to apply the selected 3D view. 
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ACTIONS- 

Charting 
SAVING A CHART TEMPLATE: 

 

1. Select the chart which you wish to save as a chart template. 

2. Choose “Chart| Save as Template…” from the Menu Bar or right-click on the chart and select “Save as 

Template…” from the pop-up menu. 

3. In the “Save As” dialog box, type a name for the template into the “File name:” text box. 

4. Click the “Save” button to save the template into the pre-designated folder. Do not change the folder into 

which it wants to save the template, as it will need to look into this folder in order to access the template 

in the future. 

APPLYING A CHART TEMPLATE: 

 

1. Select the chart to which you would like to apply a template. 

2. If using Crystal Reports 10, select “Chart| Chart Options| Template…” from the Menu Bar. 

 

OR 

 

2. If using Crystal Reports 2011, 2008 or 11, select “Chart| Load Template…” from the Menu Bar. 

3. If you want to apply a custom chart type which you have saved as a template, click the “Custom” tab and 

then click on the “User Defined” choice at the bottom of the “Categories:” list. 

4. Then select the saved template which you wish to apply to the selected chart from the list at the right side 

of the tab. Note that there are also several sets of “preset” custom chart types from which you can 

choose on the “Custom” tab. 

5. Once you have made your desired template choice, just click “OK” to apply the selected chart type. 

AUTO-ARRANGING CHART CONTENTS: 

 

1. Select the chart and then choose “Chart| Auto-Arrange Chart” from the Menu Bar. 
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EXERCISES- 

Charting 
Purpose: 

 

1. To be able to create a summary report and chart in Crystal Reports 10. 

Exercises: 

 

1. Open Crystal Reports 10 and click “Cancel” in the “Welcome to Crystal Reports” dialog box. 

2. Select “File| New…” from the Menu Bar to launch the “Crystal Reports Gallery” dialog box. 

3. Select the “As a Blank Report” option button and click “OK.” 

4. In the “Database Expert” dialog box, expand the “Favorites” data source connection to reveal the 

“Xtreme Sample Database 10” connection, which we created in the “Chapter 3- Exercise” from the 

“Introductory Crystal Reports” manual. 

5. Expand the “Xtreme Sample Database 10” and then expand the “Tables” within the database. 

6. Double-click the “Product_Type” table to move it into the “Selected Tables:” list. 

7. Double-click the “Product” table to move it into the “Selected Tables:” list. 

8. Double-click the “Orders_Detail” table to move it into the “Selected Tables:” list. 

9. Click “OK” in the “Database Expert” window. 

10. Select “Insert| Text Object” from the Menu Bar. 

11. Click into the upper left corner of the report in the “Report Header” to place the text object. 

12. Type the report title of “Product Sales Graph By Product Type” into the text object. 

13. Click outside of the text object to stop editing the text. 

14. Ensure that the text object is selected, and then select “Format| Format Text…” from the Menu Bar. 

15. On the “Common” tab, type “ReportTitle” into the “Object Name:” text box. 

16. On the “Font” tab, select “Bold” from the “Style:” drop-down. 

17. On the “Font” tab, select “16” from the “Size:” drop-down. 

18. Click “OK” in the “Format Editor” dialog box. 

19. Resize the text object to fully display the text enclosed within the object. 

20. In the “Field Explorer” pane, select the “Formula Fields” list and then click the “New” button in the 

toolbar at the top of the “Field Explorer” pane. 

21. In the “Formula Name” dialog box, type “Sale Amount” into the “Name:” text box. 

22. Click the “Use Editor” button in the “Formula Name” dialog box. 

23. Ensure that the “Syntax:” drop-down is set to “Crystal Syntax.” 

24. Enter the following formula into the formula text window: {Orders_Detail.Unit 

Price}*{Orders_Detail.Quantity}. 

25. Click “Save and Close” to return to the report‟s Design view. 

26. Click and drag the “Sale Amount” field from the “Field Explorer” and drop it at 3” on the horizontal 

ruler in the “Details” section of the report. 

27. Select “Report| Group Expert…” from the Menu Bar. 

28. In the “Group Expert” dialog box, click the plus sign (+) next to the “Product_Type” table and then 

select “Product Type Name” from the “Available Fields:” list and click the “>” arrow to move it to the 

“Group By:” list at the right side of the dialog box. 

29. Click the “Options…” button to launch the “Change Group Options” dialog box. 

30. Click the “Options” tab, and click the “Customize Group Name Field” checkbox. 

31. Select the “Choose From Existing Field” option button. 

32. Select “Product Type Name” from the drop-down menu. 
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EXERCISES- 

Charting 
Exercises (cont.): 

 

33. Click “OK” in the “Change Group Options” dialog box. 

34. Click “OK” in the “Group Expert” dialog box. 

35. Choose “Insert| Summary…” from the Menu Bar. 

36. In the “Insert Summary” dialog box, select “Sale Amount” from the “Choose the field to summarize:” 

drop-down. 

37. Choose “Sum” from the “Calculate this summary:” drop-down. 

38. Select “Group #1: Product_Type.Product Type Name – A” from the “Summary location” drop-down. 

39. Click “OK” to insert the summary field. 

40. Select “Report| Section Expert…” from the Menu Bar. 

41. In the “Section Expert” dialog box, select the “Details” section from the “Sections:” listed at the left. 

42. Check the “Hide (Drill-Down OK)” checkbox on the “Common” tab. 

43. Click “OK.” 

44. Select “Insert| Chart…” from the Menu Bar. 

45. On the “Type” tab, select “Pie” from the “Chart type:” list. 

46. On the “Data” tab, select the “Once per report” option from the “Place chart:” drop-down. Then 

choose the “Header” option button. 

47. On the “Text” tab, uncheck the “Auto-Text” checkbox for the “Title:” box, and then type “Sales by 

Product Type” into the title text box. 

48. Click “OK.” 

49. Select “File| Save As…” from the Menu Bar. 

50. In the “Save As” dialog box, save the reports to your “My Documents” folder and type the name of 

“Product Sales Graph By Type” into the “File name:” text box. 

51. Click “Save” to save the report to the selected directory with the given name. 

52. Select “File| Print Preview” from the Menu Bar to view the report on the “Preview” tab. 

53. Click the small red “X” on the “Preview” tab to delete the preview tab you have created. 

54. Select “File| Save” from the Menu Bar to save the changes to the report that were made. 

55. Select “File| Close” from the Menu Bar to close the report. 
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EXERCISES- 

Charting 
Purpose: 

 

1. To be able to create a summary report and chart in Crystal Reports 2011, 2008 and 11. 

Exercises: 

 

1. Open Crystal Reports 2011, 2008 or 11. 

2. Select the “Blank Report” hyperlink in the “Start Page.” 

3. In the “Database Expert” dialog box, expand the “Favorites” data source connection to reveal the 

sample database connection, which was created in the “Chapter 3- Exercise” from the “Introductory 

Crystal Reports” manual. 

4. Expand the sample database, and then expand the “Tables” within the database. 

5. Double-click the “Product_Type” table to move it into the “Selected Tables:” list. 

6. Double-click the “Product” table to move it into the “Selected Tables:” list. 

7. Double-click the “Orders_Detail” table to move it into the “Selected Tables:” list. 

8. Click “OK” in the “Database Expert” window. 

9. Click “OK” after viewing the “Links” tab in the “Database Expert” window. 

10. Select “Insert| Text Object” from the Menu Bar. 

11. Click into the upper left corner of the report in the “Report Header” to place the text object. 

12. Type the report title of “Product Sales Graph By Product Type” into the text object. 

13. Click outside of the text object to stop editing the text. 

14. Ensure that the text object is selected, and then select “Format| Format Text…” from the Menu Bar. 

15. On the “Common” tab, type “ReportTitle” into the “Object Name:” text box. 

16. On the “Font” tab, select “Bold” from the “Style:” drop-down. 

17. On the “Font” tab, select “16” from the “Size:” drop-down. 

18. Click “OK” in the “Format Editor” dialog box. 

19. Resize the text object to fully display the text enclosed within the object. 

20. In the “Field Explorer” pane, select the “Formula Fields” list and then click the “New” button in the 

toolbar at the top of the “Field Explorer” pane. 

21. In the “Formula Name” dialog box, type “Sale Amount” into the “Name:” text box. 

22. Click “OK” button in the “Formula Name” dialog box. 

23. In the “Formula Editor” window, ensure that the “Syntax:” drop-down is set to “Crystal Syntax.” 

24. Enter the following formula into the formula text window: {Orders_Detail.Unit 

Price}*{Orders_Detail.Quantity}. 

25. Click “Save and Close” to return to the report‟s Design view. 

26. Click and drag the “Sale Amount” field from the “Field Explorer” and drop it at 3” on the horizontal 

ruler in the “Details” section of the report. 

27. Select “Report| Group Expert…” from the Menu Bar. 

28. In the “Group Expert” dialog box, click the plus sign (+) next to the “Product_Type” table and then 

select “Product Type Name” from the “Available Fields:” list and click the “>” arrow to move it to the 

“Group By:” list at the right side of the dialog box. 

29. Click the “Options…” button to launch the “Change Group Options” dialog box. 

30. Click the “Options” tab, and click the “Customize Group Name Field” checkbox. 

31. Select the “Choose From Existing Field” option button. 

32. Select “Product Type Name” from the drop-down menu. 
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EXERCISES- 

Charting 
Exercises (cont.): 

 

33. Click “OK” in the “Change Group Options” dialog box. 

34. Click “OK” in the “Group Expert” dialog box. 

35. Choose “Insert| Summary…” from the Menu Bar. 

36. In the “Insert Summary” dialog box, select “Sale Amount” from the “Choose the field to summarize:” 

drop-down. 

37. Choose “Sum” from the “Calculate this summary:” drop-down. 

38. Select “Group #1: Product_Type.Product Type Name – A” from the “Summary location” drop-down. 

39. Click “OK” to insert the summary field. 

40. Select “Report| Section Expert…” from the Menu Bar. 

41. In the “Section Expert” dialog box, select the “Details” section from the “Sections:” listed at the left. 

42. Check the “Hide (Drill-Down OK)” checkbox on the “Common” tab. 

43. Click “OK.” 

44. Select “Insert| Chart…” from the Menu Bar. 

45. Click into the “Report Footer” section to place the chart. 

46. Right-click on the default chart you inserted, and choose “Chart Expert” from the pop-up menu. 

47. On the “Type” tab, select “Pie” from the “Choose your chart type:” list. 

48. On the “Text” tab, uncheck the “Auto-Text” checkbox for the “Title:” box, and then type “Sales by 

Product Type” into the title text box. 

49. Click “OK.” 

50. Select “File| Save As…” from the Menu Bar. 

51. In the “Save As” dialog box, save the reports to your “My Documents” folder and type the name of 

“Product Sales Graph By Type” into the “File name:” text box. 

52. Click “Save” to save the report to the selected directory with the given name. 

53. Select “View| Print Preview” from the Menu Bar to view the report on the “Preview” tab. 

54. Click the small “X” on the “Preview” tab to delete the preview tab you have created. 

55. Select “File| Save” from the Menu Bar to save the changes to the report that were made. 

56. Select “File| Close” from the Menu Bar to close the report. 
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CHAPTER 13- 

Advanced Reporting Tools 

13.1- Using Running Totals 

 

13.2- Creating Parameter Fields- (2011, 2008 & 11) 

 

13.3- Creating Parameter Fields- (10) 

 

13.4- Parameterized Record Selection 

 

13.5- Entering Parameter Values- (2011, 2008 & 11) 

 

13.6- Entering Parameter Values- (10) 

 

13.7- Creating Subreports 

 

13.8- Report Alerts 

 

13.9- Report Alert Functions 
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Advanced Reporting Tools 

13.1- Using Running Totals: 

 

 You can make formula fields which display the results of a running total, versus simply showing the 

results tabulated at the end of a record grouping. You create these fields in the “Field Explorer” pane, just 

as you would any other type of formula field. These fields function in much the same way as a summary 

field functions, however, you have a greater amount of control over how the calculation is performed and 

when the calculated value is reset. 

 To create a running total field, click on the “Running Total Fields” entry in the “Field Explorer” pane. 

Then click the “New” button in the toolbar at the top of the “Field Explorer” pane to launch the “Create 

Running Total Field” dialog box. You use this dialog box to name the field and set its calculation properties. 

 In the “Running Total Name:” text box you can type a name for the running total field. In the 

“Summary” section, you select which field‟s values to calculate. Click on the field to summarize within the 

“Available Tables and Fields:” list at the left side of the dialog box, and then click the “>” arrow button to 

move the selected field into the “Field to summarize” text box at the right. Then use the “Type of summary” 

drop-down to select what type of summary calculation to perform over the chosen field. 

 In the “Evaluate” section you can set the parameters under which the calculation will be performed 

for the selected field‟s values. You can select the “For each record” option to calculate the chosen function 

for every record in the report. You can also choose the “On change of field” option to calculate a value 

based on the change to the value shown in another field. If you do choose that option, then click on the field 

to use for the changing values in the “Available Tables and Fields” list at the left of the dialog box and click 

the “>” arrow button to move it into the “On change of field” text box at the right side. 

 You could also choose the “On change of group” option button in the “Evaluate” section to evaluate 

the selected field on the change of a grouped value. If you choose this option, then select which group‟s 

values you want to use from the drop-down to the right of the “On change of group” label. 

 You can also select the “Use a formula” option button and then click the “X+2” button to invoke the 

“Formula Editor.” In the Formula Editor, you can create a formula that, when evaluated and found to be true, 

will then perform the selected calculation of the chosen field. This is very handy for creating conditional 

running sum fields. For example, if you want to sum the “Amount Sold” field where the “Order Country” field 

was “USA,” you could set that up as the condition under which the field would be added. The result would 

be the sum of all sales from the USA. 

 In the “Reset” section, you can choose under which conditions the running total will be reset back to 

zero. If you select “Never,” the field‟s values will never be set back to zero in the report. You can also select 

the “On change of field” option button in the “Reset” section to have the running total field get reset back to 

zero on the change of value to a specified field. If you select this option, then select by which field you want 

to reset the value from the list displayed in the “Available Tables and Fields:” list at the left side of the dialog 

box, and click the “>” arrow button to move the selected field into the text box displayed. You can also 

select the “On change of group” option, and then select by which group‟s changing values you wish to reset 

the running total back to zero from the drop-down which appears. You can also click the “Use a formula” 

option button, and then click the “X+2” button to invoke the “Formula Editor.” In the “Formula Editor,” you 

can create a condition that, when met, will reset the value of the running total field back to zero. 

 Once you have set the desired attributes of the running total field, just click “OK” in the “Create 

Running Total Field” dialog box. The field that you created will then be displayed in the “Field Explorer” 

pane. You can then insert it into your report just as you would any other type of field. 
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Advanced Reporting Tools 

13.2- Creating Parameter Fields- (2011, 2008 & 11): 

 

 A parameter field allows you to specify a value that will be used by the report when the report data is 

refreshed. Parameters can serve multiple purposes in reports and are one of the most powerful tools that 

you have. You can use parameters to filter report data at run-time, selecting which records to display and 

calculate “on-the-fly.” You could also have a parameter prompt you to enter a value which can then be used 

by a formula in the report, for example. 

 You create the parameter fields in the “Field Explorer” pane, just as you create many other types of 

fields. You do have a few considerations to bear in mind as you create the parameter fields for use in your 

reports. First off, parameter fields that will be used by report group or record selection formulas do not need 

to have the parameter field placed into the actual report. Simply create the parameter field and then 

reference it as needed within the selection formula. Also, you can create parameters that will accept “string,” 

“number,” “currency,” “boolean,” “date,” “time,” or “date/time” values for use in the report. 

 To create a parameter field, select the “Parameter Fields” option in the “Field Explorer” pane and 

then click the “New” button in the toolbar at the top of the pane. This will launch the “Create New 

Parameter” dialog box where you can specify the settings for the parameter field. The “Name:” and “Type:” 

are the only two required arguments in this dialog box. You can specify the other values, as needed. 

 In the “Create New Parameter” dialog box, enter the name of the parameter field that you want to 

create into the “Name:” text box. It can be up to 255 characters in length, but should be short, descriptive, 

and easy to reference. You can then use the “Type:” drop-down to select the data type of the parameter. 

 In the “List of Values:” area, you can create a list of preset values from which the user can select the 

desired value to use for the parameter when refreshing the report data. You can either select the “Static” 

option or the “Dynamic” option. Note that your choice changes what fields are available in the dialog box. 

 If you select “Static,” then you are presenting the user with choices that always contain the same 

values. This is used for possible parameter choices that do not change very frequently. If you choose 

“Dynamic,” then you create a list of possible parameter choices that can be updated, as needed. In addition, 

you can create cascading choices in the dynamic parameter prompts. This allows you to make the user 

select from multiple fields to specify an exact value. For example, you could use both the “City” and “State” 

fields in a dynamic prompt to prevent confusion about which city is being referred to when one is selected. 

For example, using a cascading prompt you could make the user choose “Grand Rapids, MI” versus “Grand 

Rapids, MN.” In a static prompt you would simply see the city of “Grand Rapids” shown twice in the list, 

without any idea which value was associated with which state. 

 If you select the “Static” option, then you can provide a list of values from a database field from 

which the user can choose by selecting the name of the desired database field from the “Value Field” drop-

down. You can use the “Description Field:” drop-down to choose a database field which describes the 

contents of the “Value Field” choice, if needed. For example, if you selected the “Employee ID” field as the 

“Value Field,” then you could select the “Employee Name” field as the “Description Field” so the user could 

see a name versus a number when selecting a parameter value. 

 If you wish to manually type a list of values and, optionally, descriptions; then you can either click 

into the first row of the “Value” column to begin entering the parameter values, or you can click the “Insert” 

button to append a new entry to the list of values. In the value list, you can click into any entry made, and 

then click the “Delete” button, which looks like a black „x,‟ to delete the selected entry. 

 You may also click the “Move Up” and “Move Down” arrow button to move the selected choice up or 

down through the list of values. 

 You can use the “Actions” drop-down button to perform various commands on the value list shown. 

If you selected to use a database field value, then you must select the “Append all database values” 

command to load the values from the selected field(s) into the value list. You can select the “Clear” 
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Advanced Reporting Tools 

13.2- Creating Parameter Fields- (2011, 2008 & 11- cont.): 

 

command to remove all list values shown. You can import a delimited list of values from a text file by 

clicking the “Import…” command choice. This launches a separate dialog box, which you can use to browse 

for and open the desired delimited text file. Also, you can select the “Export…” command to export a manual 

list to a delimited text file using the “Save As” dialog box. 

 If you choose “Dynamic” in the “List of Values:” section, then you have different choices to make in 

this section. If you have a cascading parameter choice, meaning it uses multiple fields, then type whatever 

you would like to have displayed as the prompting text for the cascading parameter into the “Prompt Group 

Text:” text box. You can use this with single-field prompts, as well, but the title shows up at the top of the 

parameter dialog box prompt and not over the individual fields. 

 To create a new list of field values from which the user can select, ensure that the “New” choice is 

selected in the “Choose a Data Source:” section. You can then select from the list of fields in the current 

data source by using the “Insert” button or by clicking into the first empty row of the “Value” column. You 

can select any field entered into the list and click the “Delete” button to delete the field. You can also 

reorganize a selected value by clicking the “Move Up” and “Move Down” arrow buttons. If you would like to 

use a secondary field for the description of the field selected in the “Value” column, then you can choose a 

field for that purpose to the right in the “Description” column. In the “Parameter” column, you can click on a 

value to unbind it from the parameter. You can also click it to bind an unbound parameter value. 

 Once you have set your value list, then you can set the desired options for each value in the 

“Options” area. The choices from which you can select change depending on whether or not you selected 

“Static” or “Dynamic” value fields. For all “Static” values that are not “Boolean” (logical) values, you can set 

the following parameter options by clicking into the “Setting” column and entering or changing the value. In 

the “Prompt Text:” option, you can enter the text that you want to appear as the parameter prompt. You can 

choose “True” or “False” for the “Prompt With Description Only” to only allow the description field choices to 

be viewed in the parameter prompt (True), or to show both the value and description fields (False). You can 

enter a default parameter value to use in the “Default Value” option. If you select “True” in the “Allow custom 

values” option, then the users can type in  their own values in addition to selecting from the value list. If set 

to “False,” then they must only choose from the values shown in the list. If the “Allow multiple values” option 

is set to “True,” then the parameter prompt will allow multiple values to be selected. This also enables you 

to set both the “Allow discrete values” and “Allow range values” options to “True,” as well. Normally, you can 

only select one of the two options. 

 You can set the “Allow discrete values” option to “True” to allow for only singular parameter values 

to be selected. Although there can be multiple, singular values- this means that there are no ranged 

parameter values, such as all values from $100 to $1,000. 

 You can set the “Allow range values” option to “True” to allow ranged parameter value choices. You 

can use the “Min length” option to enter the minimum number of characters that can appear as a value 

entry. You can also use the “Max length” to enter the maximum number of characters that could appear as a 

value entry. You can use the “Edit Mask” option to enter a field mask that restricts the possible range of 

characters that your users could input, if desired. 

 When setting static, boolean parameter options, you can set the “Prompt Text,” “Prompt With 

Description Only,” and “Default Value” options, as normal. You can also enter the “Boolean group #” option 

to set the number of the group to which you wish to add the selected boolean value. Boolean groups are 

created when Crystal Reports requires users to enter a prompt value. Boolean groups can contain many 

Boolean parameter fields. When a user select a group of boolean values, they can set the same values or 

different values to each parameter in the group. You use the “Exclusive Group” option to set this behavior. If 

this option is set to “True,” users can only select a single “True” boolean value from the boolean options 
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Advanced Reporting Tools 

13.2- Creating Parameter Fields- (2011, 2008 & 11- cont.): 

 

presented in the group. If set to “False,” then the users can set multiple options in the group to “True.” 

 If you selected a “Dynamic” set of values, then you can set the “Prompt Text,” “Prompt With 

Description Only,” “Allow multiple values,” “Allow discrete values,” and “Allow range values” options, as 

normal. In addition, you can use the “Sort Order” option to select how to sort the field‟s data values in the 

parameter prompt. The values can be sorted in either ascending (A-Z, 1-9) order or descending (Z-A, 9-1) 

order by either the value field or the description field. 

 Once you have set the desired parameter options, click “OK” in the “Create New Parameter” dialog 

box to create the new parameter field. 

13.3- Creating Parameter Fields- (10): 

 

 Parameters add a level of flexibility to your reports. Many times, you have values that you would like 

to specify at run-time in a report. A parameter field allows you to specify a value that will be used by the 

report when the report data is refreshed. 

 Parameters can serve multiple purposes in reports and are one of the most powerful tools that you 

have to allow for additional flexibility within a report. You can use parameters to filter report data at run-time, 

selecting which records to display and calculate “on-the-fly.” You could also have a parameter prompt you 

to enter a value which can then be used by a formula in the report, for example. 

 You create the parameter fields in the “Field Explorer” pane, just as you create many other types of 

fields. You do have a few considerations to bear in mind as you create the parameter fields for use in your 

reports. First off, parameter fields that will be used by report group or record selection formulas do not need 

to have the parameter field placed into the actual report. Simply create the parameter field and then 

reference it as needed within the selection formula. Also, you can create parameters that will accept “string,” 

“number,” “currency,” “boolean,” “date,” “time,” or “date/time” values for use in the report. 

 To create a parameter field, select the “Parameter Fields” option in the “Field Explorer” pane and 

then click the “New” button in the toolbar at the top of the pane. This will launch the “Create Parameter 

Field” dialog box where you can specify the settings for the parameter field. The “Name” and “Value Type” 

are the only two required arguments in this dialog box. You can optionally specify the other values, as 

needed. 

 In the “Create Parameter Field” dialog box, you can type the name of the parameter field that you 

want to create into the “Name:” text box. It can be up to 255 characters in length, but should be short, 

descriptive, and easy to reference. In the “Prompting text:” text box, you can type the text that you want to 

have appear when the report prompts you to enter the parameter value. This can be up to 255 characters in 

length. You can then use the “Value type:” drop-down to select the data type of the parameter. 

 If you click the “Default Values…” button in this dialog box, you will open the “Set Default Values” 

dialog box. You can use this dialog box to set a default value to be used in case the user doesn‟t specify a 

value. You can also use this dialog box to create a list of preset values from which the user can select the 

value to use for the parameter when refreshing the report data. 

 If you want the possible values from which the user could select to be drawn from a database table, 

you can specify the name of the table from the “Browse table:” drop-down. From there, you can select which 

field in the table to use from the choices in the “Browse field:” drop-down. The values will then appear in the 

“Select or enter value:” list at the left side of the dialog box. If you had the values listed in a text file which 

you wanted to import, you could click the “Import…” button to launch the “Open” dialog box where you could 

select the text file with the values which you wanted to use, and then click “Open” to list the values in the 

“Select or enter value:” list. You can then use the arrow buttons to move the selected list items to and from 
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Advanced Reporting Tools 

13.3- Creating Parameter Fields- (10- cont.): 

 

the “Default Values” list at the right side of the dialog box. You can even click into the text box that is 

immediately below the “Select or enter value:” label and type in the value which you wish to add to the 

default values list. Then click the “>” arrow button to move it to the default values list. 

 In the “Default Values” list you can click on a listed element to select it. You can then click the “Set 

Description…” button to change the description used for the selected value, if desired. Also notice that if the 

elements added to the “Default Values” list aren‟t in the desired order, you can select an entry and then click 

the “Up” and “Down” arrows in the upper right corner of the list to reorganize the entries, if desired.  

 In the “Options” section, you can check the “Length limit” checkbox to restrict the data entry of the 

parameter to a specified size range. You can then type a “Min Length” and a “Max Length” into the text 

boxes provided. If you instead prefer to specify an input mask to use for the parameter, you can type an 

input mask using accepted masking characters into the “Edit mask:” text box. 

 You can also set the “Display:” drop-down to either “Value and Description” or “Description” to 

choose what will be shown in the pick list used by the report user. If you want to sort the entries shown in 

the default values list, you can choose a sorting method from the “Order:” drop-down. You can then use the 

“Order based on:” drop-down to choose to sort either by the “Values” or “Descriptions” used. 

 When you have made any changes to the settings of the default values used by the parameter field 

that you want to apply, click “OK” to return to the “Create Parameter Field” dialog box. 

 In this dialog box, if you want the user to be able to choose more than one value from your list of 

default values, check the “Allow multiple values” checkbox. Otherwise, the user will only be allowed to 

specify a single value from the list of defaults specified. If you select the “Discrete value(s)” option, you can 

choose multiple, individual values to use for the parameter. If you select “Range value(s)” instead, you can 

select a range of values between which all of the other values would also be selected. You could also 

choose “Discrete and Range Values” option. You can also check the “Allow editing of default values when 

there is more than one value” checkbox if you wish to enable that feature. Whenever you have the desired 

settings for the type of parameter field you want to create set in the “Create Parameter Field” dialog box, 

click “OK” to create the parameter field. 

13.4- Parameterized Record Selection: 

 

 One of the primary reasons to create and use parameters within Crystal Reports is for record 

selection. Imagine if you had a report which showed sales by region of your company. If you had a 

parameter which you could use for the “region” variable, you could use the same report and change the 

parameter (in this example, the region) each time to show different regional sales. 

 To use a parameter for record selection after creating the necessary parameter field, click the 

“Select Expert” button in the Experts toolbar. In the “Select Expert” dialog box you select the field against 

which to compare the parameter value and the desired comparison operation as normal. This time, notice 

that when you choose the value against which to compare the field from the drop-down available, that there 

is a parameter prompt at the top of the drop-down of choices in the following format: {?ParameterName}. If 

you have multiple parameters from which you could choose, then select the name of the parameter whose 

value you want to use for the record selection. After you have made the selection criteria, click “OK.” 

 It is important to note that the parameter value and the field against which you are comparing the 

parameter value must share that same data type. For example, if you had a “Number” parameter field, you 

could not compare it to a “String” field‟s value. Sa
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Advanced Reporting Tools 

13.6- Entering Parameter Values- (10): 

 

 After you have entered a parameter field into your report, you can preview the report to force the 

report to refresh its data and enter a parameter value for use. Once you have created the preview and set 

the value, simply switching between the “Design” and “Preview” tabs will not necessarily prompt you to re-

enter a new parameter value. You can always force a “refresh” of the data by selecting “Report| Refresh 

Report Data” from the Menu Bar. 

 When you do this in a report that contains parameterized values used for the “Preview,” Crystal 

Reports invokes a dialog box asking if you wish to “Use current parameter values” or “Prompt for new 

parameter values.” Select the desired option and then click “OK” to continue. 

 When you are initially entering a parameter value, or if you select to re-enter a parameter value 

when refreshing report data, you will do so through the “Enter Parameter Values” dialog box. In this dialog 

box, you will see the names of the report parameters listed in the “Parameter Fields:” list. You can click on a 

parameter listed to display its settings and the parameter‟s prompt below the list. The last selected value for 

the parameter is displayed at the bottom of the dialog box. You can click the “Reset” button to reset all the 

parameter values back to their default values, if needed. Otherwise, all parameters will retain their last 

setting, and you only need to select and change the value of the parameters that you need to in order to 

display the data you want to see in the “Preview.” 

 Depending on the type of parameter that you created, you enter the value or range of values to use 

for each parameter into the text box(es) or drop-down(s) at the bottom of this dialog box. The value or 

values which you then specify are used to by the parameter to select records, display the chosen value, 

format fields, or whatever else you may use parameter values for in a report. Once you have entered the 

values for use, click “OK” to apply the new parameters. 

13.5- Entering Parameter Values- (2011, 2008 & 11): 

 

 After you have entered a parameter field into your report, you can preview the report to force the 

report to refresh its data and enter a parameter value for use. Once you have created the preview and set 

the value, simply switching between the “Design” and “Preview” tabs will not necessarily prompt you to re-

enter a new parameter value. You can always force a “refresh” of the data by selecting “Report| Refresh 

Report Data” from the Menu Bar. 

 When you do this in a report that already contains parameterized values used for the “Preview,” 

Crystal Reports invokes a dialog box asking if you wish to “Use current parameter values” or “Prompt for 

new parameter values.” Select the desired option and then click “OK” to continue. 

 When you are initially entering a parameter value, or if you select to re-enter a parameter value 

when refreshing report data, you will do so through the “Enter Values” dialog box. In this dialog box, you will 

see the names of the report parameters, and you can select or enter the desired values to use for the report 

for each one shown. After initially selecting parameter values, all parameters will retain their last setting, 

and you only need to select and change the value of the parameters that you need to, in order to display the 

data you want to see in the “Preview.” 

 The value or values which you then specify are used to by the parameter to select records, display 

the chosen value, format fields, or whatever else you may use parameter values for in a report. Once you 

have entered the values for use, click “OK” to apply the new parameters. 

Sa
mple

- f
or

 ev
alu

ati
on

 pu
rp

os
es

 on
ly!



73 Advanced Crystal Reports ©TeachUcomp, Inc. 

Advanced Reporting Tools 

13.7- Creating Subreports: 

 

 Another sophisticated report tool which you can use is the subreport. A subreport is created in the 

same manner as a normal report, but it is then embedded within a main report as a report object and it 

cannot contain another subreport within it. This allows you to access and display information from two 

unrelated reports in a single report, or to display multiple views of report data in a single report. 

 You can create either linked or unlinked subreports. Unlinked subreports simply have no relationship 

between the records displayed in the subreport and the records displayed in the main report. The data is 

unrelated to each other in much the same way “unlinked” data in tables is unrelated. In linked subreports 

the data in the subreport is matched up to data in the primary report. For example, If you create an “Orders” 

report, you can create a linked subreport that displays the “Order Details” for each record in the “Orders” 

table. This could be used as another way of displaying the “one-to-many” type join between data in related 

tables. 

 To create a subreport, you can select “Insert| Subreport…” from the Menu Bar or click the “Insert 

Subreport” button in the Insert toolbar. This will invoke the “Insert Subreport” dialog box. In this dialog box 

you can select how you want to create the subreport using the two options displayed: “Choose an existing 

report” or “Create a subreport with the Report Wizard.” If you select the first option, then click the 

“Browse…” button to invoke the “Open” dialog box where you can choose which report you want to embed 

as a subreport within the main report. If you wanted to create the subreport “on-the-fly” within the primary 

report, you can instead choose the latter option button and then click the “Report Wizard…” button to launch 

the Report Wizard dialog box which steps you through the creation of a standard report. 

 You can also check the “On-demand subreport (similar to a hyperlink)” checkbox to create a 

subreport which doesn‟t display its data until the user double-clicks on the subreport link to drill-down and 

display the subreport data on another “Preview” tab. They are displayed within their own object frame in the 

main report, which reduces the amount of display space required within the main report. In addition, data 

from an “On-demand subreport” isn‟t accessed from the database until the user double-clicks on the 

subreport to display the detail data. You can later access the subreport object and change its caption using 

the “Format Editor.” 

 Assuming you wanted to create an unlinked subreport, you could just click the “OK” button at this 

point and then click into the report at the place where you wanted to display the subreport data. However, if 

you wanted to create a linked subreport, you must then click the “Link” tab in the “Insert Subreport” dialog 

box. When you create a link between the primary report and the subreport, they are linked by a parameter 

field created by the linking process. The parameter field is then used as a reference for the subreport‟s 

record selection formula, which filters the records displayed. 

 On the “Link” tab, you use the “For subreport:” drop-down to choose which subreport to link to from 

the drop-down displayed. Then in the “Container Report field(s) to link to” list, select the report field or 

underlying database field which will serve as the basis for the link between the data in the two reports. Then 

click the “>” arrow button to move the selected field(s) into the “Field(s) to link to:” list at the right side of the 

dialog box. At the bottom of the dialog box, use the drop-down at the left side of the dialog box to select the 

parameter field to use from the primary report, and the associated field from the subreport to use for the link 

from the drop-down at the right side of the dialog box. Once the association between the fields has been 

created, just click “OK” at the bottom of the dialog box. Then you can click into the position within the report 

at which you want to place the linked subreport. 
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Advanced Reporting Tools 

13.8- Report Alerts: 

 

 You can set report alerts to notify the user of conditions or information in a report that are outside of 

the defined “norm.” Many times in business you will want to see these types of reports, which are often 

called “exception reports,” because they can alert you to potential problems. Crystal Reports uses report 

alerts to identify and notify the user when certain specified criteria are met. For example, you could create a 

report alert which informs the management staff with a custom message when sales for a specified period 

are under a certain specified value. 

 To create a report alert, choose “Report| Alerts| Create or Modify Alerts…” from the Menu Bar. This 

will launch the “Create Alerts” dialog box. You can click the “New” button in the dialog box to launch the 

“Create Alert” dialog box. Here you must type a name for the alert into the “Name” text box. You can then 

type the message that you want to display when the condition which you will set is met into the “Message” 

text box. If you wish to create a formula that displays a text value or makes reference to other report fields, 

you can instead click the “X+2” button to the right of the “Message” text box and then create the formula in 

the “Formula Editor” which you will display when the criteria is met. 

 Click the “Condition…” button to invoke the Formula Editor where you can create the formula, that 

when met, will trigger the display of the message which you created. Then click “Save and Close” in the 

Formula Editor window to return to the “Create Alert” dialog box. You can then click “OK” in this dialog box 

to return to the “Create Alerts” dialog box. Note the “Enabled” checkbox is checked, which indicates that the 

alert is “on.” You can always return to an alert that you wish to temporarily deactivate and uncheck this 

checkbox to turn an alert “off” without having to delete the alert. 

 If you wish to delete an alert which you created but no longer need, you can select the name of the 

alert from the “Create Alerts” dialog box and then click the “Delete” button to delete the selected alert. You 

can also click on the name of an alert in this dialog box and then click “Edit…” to edit the selected alert‟s 

condition or message if needed. You can also click the “New…” button to create as many additional alerts 

as you feel you need for the report. When you are finished, you can click the “Close” button to return to the 

report. When you preview the data or refresh the report data, any alerts will be triggered if they meet the 

criteria which you specified. They will appear in their own “Report Alerts” dialog box, where you can see the 

name of the alert and the message which was entered. In this dialog box, you can select the name of the 

alert which was triggered and then click the “View Records” button to view the data records which triggered 

the report alert. When you are finished reviewing the data, you can click the “Close” button in the “report 

Alerts” dialog box. 

13.9- Report Alert Functions: 

 

 Crystal Reports contains three functions which evaluate the status of the alerts within a report. 

These functions all return a “True” value or “False” value (boolean) used for evaluating the status of alerts. 

You can use these functions to determine whether or not an alert has been activated. You can use the 

“IsAlertEnabled” function to determine if the “enabled” checkbox is checked for an alert. You can use the 

“IsAlertTriggered” function to determine if the record being evaluated is triggering the alert. You can use 

the “AlertMessage” function to return the message (or the formula) that was typed into the “Message” text 

box in the “Create Alert” dialog box. 
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ACTIONS- 

Advanced Reporting Tools 
CREATING A RUNNING TOTAL FIELD: 

 

1. Click on the “Running Total Fields” entry in the “Field Explorer” pane. 

2. Click the “New” button in the toolbar at the top of the “Field Explorer” pane to launch the “Create Running 

Total Field” dialog box. 

3. In the “Running Total Name:” text box you can type a name for the running total field. 

4. In the “Summary” section, you select which field‟s values to calculate. Click on the field to summarize 

within the “Available Tables and Fields:” list at the left side of the dialog box, and then click the “>” arrow 

button to move the selected field into the “Field to summarize” text box at the right. 

5. Use the “Type of summary” drop-down to select what type of summary calculation to perform over the 

chosen field. 

6. In the “Evaluate” section you can set the parameters under which the calculation will be performed for the 

selected field‟s values. You can select the “For each record” option to calculate the chosen function for 

every record in the report. You can also choose the “On change of field” option to calculate a value 

based on the change to the value shown in another field. If you do choose that option, then click on the 

field to use for the changing values in the “Available Tables and Fields” list at the left of the dialog box 

and click the “>” arrow button to move it into the “On change of field” text box at the right side. 

7. You could also choose the “On change of group” option button in the “Evaluate” section to evaluate the 

selected field on the change of a grouped value. If you choose this option, then select which group‟s 

values you want to use from the drop-down to the right of the “On change of group” label. 

8. You can also select the “Use a formula” option button and then click the “X+2” button to invoke the 

“Formula Editor.” In the Formula Editor, you can create a formula that, when evaluated and found to be 

true, will then perform the selected calculation of the chosen field. 

9. In the “Reset” section, you can choose under which conditions the running total will be reset back to zero. 

If you select “Never,” the field‟s values will never be set back to zero in the report. 

10. If you select the “On change of field” option button in the “Reset” section to have the running total field 

get reset back to zero on the change of value to a specified field. If you select this option, then select by 

which field you want to reset the value from the list displayed in the “Available Tables and Fields:” list at 

the left side of the dialog box, and click the “>” arrow button to move the selected field into the text box 

displayed. 

11. If you select the “On change of group” option, and then select by which group‟s changing values you 

wish to reset the running total back to zero from the drop-down which appears. You can also click the 

“Use a formula” option button, and then click the “X+2” button to invoke the “Formula Editor.” In the 

“Formula Editor,” you can create a condition that, when met, will reset the value of the running total field 

back to zero. 

12. Once you have set the desired attributes of the running total field, just click “OK” in the “Create Running 

Total Field” dialog box. 

13. The field that you created will then be displayed in the “Field Explorer” pane. You can then insert it into 

your report just as you would any other type of field. 
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ACTIONS- 

Advanced Reporting Tools 
CREATING A PARAMETER FIELD- (2011, 2008 & 11): 

 

1. Select the “Parameter Fields” option in the “Field Explorer” pane, and then click the “New” button in the 

toolbar at the top of the pane. 

2. In the “Create New Parameter” dialog box, type the name of the parameter field that you want to create 

into the “Name:” text box. 

3. You can then use the “Type:” drop-down to select the data type of the parameter. 

4. In the “List of Values:” area, you can either select the “Static” option or the “Dynamic” option. Note that 

your choice changes what fields are available in the dialog box. 

5. If you select the “Static” option, then you can provide a list of values from a database field from which the 

user can choose by selecting the name of the desired database field from the “Value Field” drop-down. 

6. You can use the “Description Field:” drop-down to choose a database field which describes the contents 

of the “Value Field” choice, if needed. 

7. If you wish to manually type a list of values and, optionally, descriptions; then you can either click into the 

first row of the “Value” column to begin entering the parameter values, or you can click the “Insert” button 

to append a new entry to the list of values. 

8. In the value list, you can click into any entry made, and then click the “Delete” button, which looks like a 

black „x,‟ to delete the selected entry. 

9. You may also click the “Move Up” and “Move Down” arrow button to move the selected choice up or 

down through the list of values. 

10. You can use the “Actions” drop-down button to perform various commands on the value list shown. If 

you selected to use a database field value, then you must select the “Append all database values” 

command to load the values from the selected field(s) into the value list. 

11. You can select the “Clear” command to remove all list values shown. 

12. You can import a delimited list of values from a text file by clicking the “Import…” command choice. This 

launches a separate dialog box, which you can use to browse for and open the desired delimited text file. 

13. You can select the “Export…” command to export a manual list to a delimited text file using the “Save 

As” dialog box. 

14. If you choose “Dynamic” in the “List of Values:” section, then you have different choices to make in this 

section. 

15. If you have a cascading parameter choice, meaning it uses multiple fields, then type whatever you 

would like to have displayed as the prompting text for the cascading parameter into the “Prompt Group 

Text:” text box. You can use this with single-field prompts, as well, but the title shows up at the top of the 

parameter dialog box prompt and not over the individual fields. 

16. To create a new list of field values from which the user can select, ensure that the “New” choice is 

selected in the “Choose a Data Source:” section. You can then select from the list of fields in the current 

data source by using the “Insert” button or by clicking into the first empty row of the “Value” column. 

17. You can select any field entered into the list and click the “Delete” button to delete the field. 

18. You can also reorganize a selected value by clicking the “Move Up” and “Move Down” arrow buttons. 

19. If you would like to use a secondary field for the description of the field selected in the “Value” column, 

then you can choose a field for that purpose to the right in the “Description” column. 

20. In the “Parameter” column, you can click on a value to unbind it from the parameter. You can also click it 

to bind an unbound parameter value. 

21. You can set the desired options for each value in the “Options” area. The choices from which you can 

select change depending on whether or not you selected “Static” or “Dynamic” value fields. 
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ACTIONS- 

Advanced Reporting Tools 
CREATING A PARAMETER FIELD- (2011, 2008 & 11- CONT.): 

 

22. For all “Static” values that are not “Boolean” (logical) values, you can set the following parameter 

options by clicking into the “Setting” column and entering or changing the value. 

23. In the “Prompt Text:” option, you can enter the text that you want to appear as the parameter prompt. 

24. You can choose “True” or “False” for the “Prompt With Description Only” to only allow the description 

field choices to be viewed in the parameter prompt (True), or to show both the value and description 

fields (False). 

25. You can enter a default parameter value to use in the “Default Value” option. 

26. If you select “True” in the “Allow custom values” option, then the users can type in  their own values in 

addition to selecting from the value list. If set to “False,” then they must only choose from the values 

shown in the list. 

27. If the “Allow multiple values” option is set to “True,” then the parameter prompt will allow multiple values 

to be selected. This also enables you to set both the “Allow discrete values” and “Allow range values” 

options to “True,” as well. Normally, you can only select one of the two options. 

28. You can set the “Allow discrete values” option to “True” to allow for only singular parameter values to be 

selected. Although there can be multiple, singular values- this means that there are no ranged parameter 

values, such as all values from $100 to $1,000. 

29. You can set the “Allow range values” option to “True” to allow ranged parameter value choices. 

30. You can use the “Min length” option to enter the minimum number of characters that can appear as a 

value entry. 

31. You can also use the “Max length” to enter the maximum number of characters that could appear as a 

value entry. 

32. You can use the “Edit Mask” option to enter a field mask that restricts the possible range of characters 

that your users could input, if desired. 

33. When setting static, boolean parameter options, you can set the “Prompt Text,” “Prompt With 

Description Only,” and “Default Value” options, as normal. 

34. You can also enter the “Boolean group #” option to set the number of the group to which you wish to 

add the selected boolean value. When a user select a group of boolean values, they can set the same 

values or different values to each parameter in the group. 

35. If the “Exclusive Group” option is set to “True,” users can only select a single “True” boolean value from 

the boolean options presented in the group. If set to “False,” then the users can set multiple options in 

the group to “True.” 

36. If you selected a “Dynamic” set of values, then you can set the “Prompt Text,” “Prompt With Description 

Only,” “Allow multiple values,” “Allow discrete values,” and “Allow range values” options, as normal. 

37. In addition, you can use the “Sort Order” option to select how to sort the field‟s data values in the 

parameter prompt. The values can be sorted in either ascending (A-Z, 1-9) order or descending (Z-A, 9-

1) order by either the value field or the description field. 

38. Once you have set the desired parameter options, click “OK” in the “Create New Parameter” dialog box 

to create the new parameter field. 
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ACTIONS- 

Advanced Reporting Tools 
CREATING A PARAMETER FIELD- (10): 

 

1. Select the “Parameter Fields” option in the “Field Explorer” pane and then click the “New” button in the 

toolbar at the top of the pane to launch the “Create Parameter Field” dialog box. 

2. Type the name of the parameter field that you want to create into the “Name:” text box. 

3. In the “Prompting text:” text box, type the text that you want to have appear when the report prompts you 

to enter the parameter value. 

4. You can use the “Value type:” drop-down to select the data type of the parameter. 

5. If you click the “Default Values…” button in this dialog box, you will open the “Set Default Values” dialog 

box. You can use this dialog box to set a default value to be used in case the user doesn‟t specify a 

value. You can also use this dialog box to create a list of preset values from which the user can select 

the value to use for the parameter when refreshing the report data. 

6. In the “Set Default Values” dialog box, you can restrict the possible values from which the user could 

select to values from a database table by specifying the name of the table from the “Browse table:” drop-

down. 

7. Select which field in the table to use from the choices in the “Browse field:” drop-down. The values will 

then appear in the “Select or enter value:” list at the left side of the dialog box. 

8. If you had the values listed in a text file which you wanted to import, you could instead click the “Import…” 

button to launch the “Open” dialog box where you could select the text file with the values which you 

wanted to use, and then click “Open” to list the values in the “Select or enter value:” list. 

9. You can then use the arrow buttons to move the selected list items to and from the “Default Values” list at 

the right side of the dialog box. 

10. You can even click into the text box that is immediately below the “Select or enter value:” label and type 

in the value which you wish to add to the default values list. Then click the “>” arrow button to move it to 

the default values list. 

11. In the “Default Values” list you can click on a listed element to select it. You can then click the “Set 

Description…” button to change the description used for the selected value, if desired. 

12. Notice that if the elements added to the “Default Values” list aren‟t in the desired order, you can select 

an entry and then click the “Up” and “Down” arrows in the upper right corner of the list to reorganize the 

entries, if desired. 

13. In the “Options” section, you can check the “Length limit” checkbox to restrict the data entry of the 

parameter to a specified size range. You can then type a “Min Length” and a “Max Length” into the text 

boxes provided. 

14. If you instead prefer to specify an input mask to use for the parameter, you can type an input mask 

using accepted masking characters into the “Edit mask:” text box. 

15. You can also set the “Display:” drop-down to either “Value and Description” or “Description” to choose 

what will be shown in the pick list used by the report user. 

16. If you want to sort the entries shown in the default values list, you can choose a sorting method from the 

“Order:” drop-down. You can then use the “Order based on:” drop-down to choose to sort either by the 

“Values” or “Descriptions” used. 

17. When you have made any changes to the settings of the default values used by the parameter field that 

you want to apply, click “OK” to return to the “Create Parameter Field” dialog box. 

18. In this dialog box, if you want the user to be able to choose more than one value from your list of default 

values, check the “Allow multiple values” checkbox. Otherwise, the user will only be allowed to specify a 

single value from the list of defaults specified. 
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ACTIONS- 

Advanced Reporting Tools 

ENTERING PARAMETER VALUES- (10): 

 

1. If necessary, you can force a “refresh” of the data by selecting “Report| Refresh Report Data” from the 

Menu Bar. 

2. When you do this in a report that contains parameterized values, Crystal Reports invokes a dialog box 

asking if you wish to “Use current parameter values” or “Prompt for new parameter values.” Select the 

desired option and then click “OK” to continue. 

3. In the “Enter Parameter Values” dialog box, you will see the names of the report parameters listed in the 

“Parameter Fields:” list. 

4. You can click on a parameter listed to display its settings and the parameter‟s prompt below the list. The 

last selected value for the parameter is displayed at the bottom of the dialog box. You can click the 

“Reset” button to reset all the parameter values back to their default values, if needed. Otherwise, all 

parameters will retain their last setting, and you only need to select and change the value of the 

parameters that you need to in order to display the data you want to see in the “Preview.” 

5. Depending on the type of parameter that you created, you enter the value or range of values to use for 

each parameter into the text box(es) or drop-down(s) at the bottom of this dialog box. The value or 

values which you then specify are used to by the parameter to select records, display the chosen value, 

format fields, or whatever else you may use parameter values for in a report. 

6. Once you have entered the values for use, click “OK” to apply the new parameters. 

ENTERING PARAMETER VALUES- (2011, 2008 & 11): 

 

1. You can “refresh” report data by selecting “Report| Refresh Report Data” from the Menu Bar, if needed. 

2. When you refresh report data that contains parameterized values, Crystal Reports invokes a dialog box 

asking if you wish to “Use current parameter values” or “Prompt for new parameter values.” Select the 

desired option and then click “OK” to continue. 

3. When you are initially entering a parameter value, or if you select to re-enter parameter values when 

refreshing report data, you will do so through the “Enter Values” dialog box. In this dialog box, you will set 

or enter the desired values to use for each parameter shown. After initially selecting parameter values, all 

parameters will retain their last setting, and you only need to select and change the value of the 

parameters that you need to, in order to display the data you want to see in the “Preview.” 

4. Once you have entered the values to use, click “OK” to apply the new parameters. 

CREATING A PARAMETER FIELD- (10): CONT.: 

 

19. If you select the “Discrete value(s)” option, you can choose multiple, individual values to use for the 

parameter. 

20. If you select “Range value(s)” instead, you can select a range of values between which all of the other 

values would also be selected. 

21. You could also choose “Discrete and Range Values” option to allow for the selection of both ranged and 

discrete values for the parameter. 

22. You can also check the “Allow editing of default values when there is more than one value” checkbox, if 

you wish to enable that feature. 

23. Whenever you have the desired settings for the type of parameter field you want to create set in the 

“Create Parameter Field” dialog box, click “OK” to create the parameter field. 
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ACTIONS- 

Advanced Reporting Tools 
CREATING A SUBREPORT: 

 

1. Select “Insert| Subreport…” from the Menu Bar or click the “Insert Subreport” button in the Insert toolbar. 

2. In the “Insert Subreport” dialog box, select how you want to create the subreport using the two options 

displayed: “Choose an existing report” or “Create a subreport with the Report Wizard.” If you select the 

first option, then click the “Browse…” button to invoke the “Open” dialog box where you can choose 

which report you want to embed as a subreport within the main report. If you wanted to create the 

subreport “on-the-fly” within the primary report, you can instead choose the latter option button and then 

click the “Report Wizard…” button to launch the Report Wizard dialog box which steps you through the 

creation of a standard report. 

3. You can check the “On-demand subreport (similar to a hyperlink)” checkbox to create a subreport which 

doesn‟t display its data until the user double-clicks on the subreport link to drill-down and display the 

subreport data on another “Preview” tab. 

4. Assuming you wanted to create an unlinked subreport, you could just click the “OK” button at this point 

and then click into the report at the place where you wanted to display the subreport data. However, if 

you wanted to create a linked subreport, you must then click the “Link” tab in the “Insert Subreport” dialog 

box. 

5. On the “Link” tab, you use the “For subreport:” drop-down to choose which subreport to link to from the 

drop-down displayed. 

6. Then in the “Container Report field(s) to link to” list, select the report field or underlying database field 

which will serve as the basis for the link between the data in the two reports. 

7. Click the “>” arrow button to move the selected field(s) into the “Field(s) to link to:” list at the right side of 

the dialog box. 

8. At the bottom of the dialog box, use the drop-down at the left side of the dialog box to select the 

parameter field to use from the primary report, and the associated filed from the subreport to use for the 

link from the drop-down at the right side of the dialog box. 

9. Once the association between the fields has been created, just click “OK” at the bottom of the dialog box. 

10. Then click into the position within the report at which you want to place the linked subreport. 

CREATING REPORT ALERTS: 

 

1. Choose “Report| Alerts| Create or Modify Alerts…” from the Menu Bar to launch the “Create Alerts” dialog 

box. 

2. Click the “New” button in the dialog box to launch the “Create Alert” dialog box. 

3. Type a name for the alert into the “Name” text box. 

4. Type the message that you want to display when the condition which you will set is met into the 

“Message” text box. If you wish to create a formula that displays a text value or makes reference to other 

report fields, you can instead click the “X+2” button to the right of the “Message” text box and then create 

the formula in the “Formula Editor” which you will display when the criteria is met. 

5. Click the “Condition…” button to invoke the Formula Editor where you can create the formula, that when 

met, will trigger the display of the message which you created. Then click “Save and Close” in the 

Formula Editor window to return to the “Create Alert” dialog box. 

6. You can then click “OK” in this dialog box to return to the “Create Alerts” dialog box. 
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ACTIONS- 

Advanced Reporting Tools 
ENABLING AND DISABLING REPORT ALERTS: 

 

1. Choose “Report| Alerts| Create or Modify Alerts…” from the Menu Bar to launch the “Create Alerts” dialog 

box. 

2. Select the name of the alert to turn on or off from the list shown, and then click the “Edit…” button. 

3. If the “Enabled” checkbox is checked, the alert is “on.” You can always uncheck this checkbox to turn an 

alert “off” without having to delete the alert. 

4. Click “OK” when you are finished to return to the “Create Alerts” dialog box. 

DELETING REPORT ALERTS: 

 

1. Choose “Report| Alerts| Create or Modify Alerts…” from the Menu Bar to launch the “Create Alerts” dialog 

box. 

2. Select the name of the alert to delete from the list shown, and then click the “Delete” button to delete the 

selected alert. 

EDITING REPORT ALERTS: 

 

1. Choose “Report| Alerts| Create or Modify Alerts…” from the Menu Bar to launch the “Create Alerts” dialog 

box. 

2. Select the name of the alert to edit from the list shown, and then click the “Edit…” button to edit the 

selected alert in the “Edit Alert” dialog box. 

3. Click “OK” when you are finished making your changes to the report alert. 
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EXERCISES- 

Advanced Reporting Tools 
Purpose: 

 

1. To be able to apply advanced reporting tools to enhance reports in Crystal Reports 10. 

Exercises: 

 

1. Open Crystal Reports 10 and click “Cancel” in the “Welcome to Crystal Reports” dialog box. 

2. Select “File| Open…” from the Menu Bar to launch the “Open” dialog box. 

3. Navigate to the “My Documents” folder where you stored the “Customer Order Report” which we 

created in the “Chapter 11- Exercise.” 

4. Click on the “Customer Order Report” to select it, and then click the “Open” button to open it. 

5. Click on the “Parameter Fields” entry to select it, and then click the “New” button in the toolbar at the 

top of the “Field Explorer” pane. 

6. In the “Create Parameter Field” dialog box, type “Customer” into the “Name:” text box. 

7. In the “Prompting text:” text box you can type the following text: “Select the names of the customers 

for which you wish to view the sales totals from the drop-down below.” 

8. Select “String” from the “Value type:” drop-down. 

9. In the “Options” section, check the “Allow multiple values” checkbox. 

10. Ensure that the “Discrete value(s)” option is selected. 

11. Click the “Default Values…” button to launch the “Set Default Values” dialog box. 

12. Use the “Browse table:” drop-down to select “Customer.” 

13. Use the “Browse field:” drop-down to select “Customer Name.” 

14. Click the right-pointing, double-arrow button “>>” to move the selected values from the list at the left 

side of the dialog box to the list at the right side of the dialog box. 

15. In the lower right corner, select “Alphabetical ascending” from the “Order:” drop-down. 

16. Ensure that “Value” is selected from the “Order based on:” drop-down. 

17. Click “OK” at the bottom of the dialog box to return to the “Create Parameter Field” dialog box. 

18. Click “OK” at the bottom of the “Create Parameter Field” dialog box. 

19. Select “Report| Select Expert…” from the Menu Bar. 

20. In the “Choose Field” dialog box which appears, click on “Customer.Customer Name” to select it. 

21. Click “OK” to launch the “Select Expert” dialog box. 

22. On the “Customer.Customer Name” tab, use the drop-down to select “is equal to” at the left side of 

the dialog box. 

23. Use the drop-down which appears to the right to choose {?Customer} from the top of the drop-down 

list. 

24. Click “OK” to set the selection criteria. 

25. Select “File| Print Preview” from the Menu Bar to view the report on the “Preview” tab. If you already 

have a “Preview” tab, you can just switch to the “Preview” tab and then choose “Report| Refresh 

Report Data” from the Menu Bar to invoke the “Enter Parameter Values” dialog box. 

26. In the dialog box, use the “Discrete Value” drop-down to select “Aruba Sport.” 

27. Click the “Add” button to add them to the “Value” list box. 

28. Use the “Discrete Value” drop-down to choose “Bikefest.” 

29. Click the “Add” button to add them to the “Value” list box. 

30. Click “OK” to view the sales totals for the two selected customers. 

31. Select “File| Save” from the Menu Bar. 

32. Select “File| Close” to close the report. Sa
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EXERCISES- 

Advanced Reporting Tools 
Purpose: 

 

1. To be able to apply advanced reporting tools to enhance reports in Crystal Reports 2011, 2008 & 

11. 

Exercises: 

 

1. Open Crystal Reports 2011, 2008 or 11. 

2. Select “File| Open…” from the Menu Bar to launch the “Open” dialog box. 

3. Navigate to the “My Documents” folder where you stored the “Customer Order Report” which was 

created in the “Chapter 11- Exercise.” 

4. Click on the “Customer Order Report” to select it, and then click the “Open” button to open it. 

5. Click on the “Parameter Fields” entry to select it, and then click the “New” button in the toolbar at the 

top of the “Field Explorer” pane. 

6. In the “Create New Parameter” dialog box, type “Customer” into the “Name:” text box. 

7. Select “String” from the “Type:” drop-down. 

8. Select “Static” from the “List of Values:” choices. 

9. Select “Customer Name” from the “Value Field” drop-down. 

10. Select “Customer Name” from the “Description Field” drop-down. 

11. Click the “Actions” button and select “Append all database values.” 

12. In the “Options:” section, enter the following “Prompt Text:” string: “Select the names of the 

customers for which you wish to view the sales totals from the drop-down below.” 

13. Set the “Prompt With Description Only” option to “True.” 

14. Set the “Allow custom values” option to “False.” 

15. Set the “Allow multiple values” option to “True.” 

16. Ensure that the “Allow discrete values” option is set to “True.” 

17. Click “OK” at the bottom of the “Create New Parameter” dialog box. 

18. Click the “Select Expert” button within the Experts toolbar. 

19. In the “Choose Field” dialog box which appears, click on “Customer.Customer Name” to select it. 

20. Click “OK” to launch the “Select Expert” dialog box. 

21. On the “Customer.Customer Name” tab, use the drop-down to select “is equal to” at the left side of 

the dialog box. 

22. Use the drop-down which appears to the right to choose {?Customer} from the top of the drop-down 

list. 

23. Click “OK” to set the selection criteria. 

24. Select “File| Print Preview” from the Menu Bar to view the report on the “Preview” tab. If you already 

have a “Preview” tab, you can just switch to the “Preview” tab and then choose “Report| Refresh 

Report Data” from the Menu Bar to invoke the “Enter Values” dialog box, if needed. 

25. In the “Enter Values” dialog box, select “Aruba Sport” from the “Available Values:” list. 

26. Click the “>” button to add “Aruba Sport”  to the “Selected Values:” list. 

27. Select “Bikefest” from the “Available Values:” list. 

28. Click the “>” button to add “Bikefest”  to the “Selected Values:” list. 

29. Click “OK” to view the sales totals for the two selected customers. 

30. Select “File| Save” from the Menu Bar. 

31. Select “File| Close” to close the report. Sa
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CHAPTER 14- 

Advanced Formula Creation 

14.1- Evaluation Time Functions 

 

14.2- Declaring Variables 

 

14.3- Using and Displaying Variables 

 

14.4- Using Array Values 

 

14.5- Using “If... Then... Else...” Statements 

 

14.6- Using the “Select/Case” Statement 

 

14.7- Using “For” Loops 

 

14.8- Using “Do... While” Loops 

 

14.9- The IIF Function 
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Advanced Formula Creation 

14.1- Evaluation Time Functions: 

 

 For some more complex reports that you can create, it can be important to be familiar with the order 

in which data processing occurs when creating the reports. Crystal Reports employs a two-pass method of 

data selection and processing which allows you to employ sophisticated formulas and determine when they 

occur and in what order. A “pass” occurs when Crystal Reports passes over the data- reading and 

manipulating the data in the report. There are functions that can be specified to “run” during this process. 

This can impact the result of other formulas in the report. 

 Before the first “pass” of the data, Crystal will evaluate formulas which make no references to the 

underlying data fields. These would be fields such as the current print date and time, for example. This is 

also when text objects are read and parameters are identified. In general, this process is referred to as 

“Before Reading Records.” You can use the “BeforeReadingRecords” function to specify that a formula is 

to be evaluated before the first pass, during this time. If the formula refers to an unevaluated object, 

however, then it will return an error message. 

 Next, Crystal Reports begins the first “pass” of the data. During this phase, Crystal Reports begins to 

read the database records. It then selects the records, evaluates recurring formulas (versus “summary” 

formulas), applies record selection formulas, performs grouping, sorting, and totaling, generates cross-tabs, 

and then stores all saved records. This evaluation time is known as “While Reading Records.” You can 

force a formula to be processed while reading database records by using the “WhileReadingRecords” 

function. Most formulas have been calculated at this point, except for some grouping functions. 

 After the first pass, the “Group Sort Expert” runs an intermediate process before running the second 

full pass of the data. Basically, the groups in the report are inspected and sorted as needed, but no actual 

records are “read” in the tables. 

 The records are next read during the second pass, which is called the “While Printing Records” 

process. During this phase the records are saved with their subtotals, group selection occurs, running totals 

are executed, charts and maps are generated, subreports are run, and “Page on Demand” pages are 

generated. You can also run formulas using the “WhilePrintingRecords” function during this phase after 

grouping, summarizing, and sorting have been accomplished. 
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Advanced Formula Creation 

14.2- Declaring Variables: 

 

 You can declare and use variables, which are stored values that can be referenced and 

manipulated, within a report. However, to use a variable you must first create it by “declaring” its existence 

within a formula. Once you have created the variable, you can then assign or “pass” values to the variable 

which it can then store. The variable and its stored value (or values) can then be used by the formulas 

within the report. 

 The first part of the process is “declaring” the variable. This is the process where we create the 

variable and set its initial values. The first aspect of declaring the variable is defining the data type that the 

variable will contain. Most commonly, the variable is defined using one of seven “simple” data types: 

“NumberVar,” for number values you wish to calculate; “CurrencyVar,” for currency variables which you 

wish to calculate, “StringVar,” for any text characters; “BooleanVar,” for logical values; “DateVar,” for date 

values; “TimeVar,” for time values; and “DateTimeVar,” for both date/time values. In addition to the 

standard “simple” data types, there are also other ranged and array types available for a total of up 26 

different types of variables which you can use for your formulas in your reports. 

 Next you would need to set the name of the variable. The name can contain up to 254 characters, 

but should probably be very short, unique, and descriptive. They may contains numbers, but cannot have a 

number as the first character in the name. Spaces are never allowed in variable names. Also, the name of 

the variable cannot be identical to any operator or function used in Crystal Reports. Also be aware that 

when you declare variables with the same name and type in more than one formula, they then share the 

variable and the value. You can define the “scope” of a variable to determine where it can and cannot be 

used. 

 In Crystal Syntax, you declare a variable in the formula text window of the “Formula Editor,” by 

typing the variable type, a literal space character, followed by the variable name. 

 Once the variable has been declared, it must then have a values assigned to it. If you have no value 

assigned to the variable, it will have a “blank” or “zero” value, depending on the type of variable which you 

declared. To assign a value to a variable, you use the “assignment” operator of “:=” to accomplish this. For 

example, if you wanted to declare a “datetime” type variable named “WeekAfterOrder” to which you wanted 

to assign the value of the current record‟s “Order Date” field, plus seven days, it could be assigned as 

follows in the “Formula Workshop.” The value of the “WeekAfterOrder” variable is then set to “Order Date” 

plus seven, so you can then use the “WeekAfterOrder” variable in other calculations, where it will use the 

variable. 

 

DateTimeVar WeekAfterOrder; 

 

WeekAfterOrder := {Orders.Order Date} + 7 
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Advanced Formula Creation 

14.3- Using and Displaying Variables: 

 

 During the process of “declaring” a variable, the name and value of the variable is stored to the 

computer‟s memory for later use. The value of the variable can then be used by the formula or by other 

calculations later on in the report. When using multiple variables within a complex formula, it is important to 

note that the last variable assigned a value or used in the formula is the one which will be displayed in the 

formula result field when the field is placed into the report. 

 To display the value of a variable, you can just create a simple formula which contains the variable 

type and the variable name as a formula field within the report. Then you can place the formula field into the 

report at the place at which you want the variable‟s value to appear within then report. 

 Another consideration of displaying variables is defining the scope of the variable. The scope of the 

variable determines how the value of the declared variable is passed from formula to formula within the 

report. There are three levels of scope which can be defined for a variable: “Global,” which means that the 

value of the variable is available to formulas through out the entire report; “Shared,” which means that the 

value of the variable can be shared with a subreport as well as all formulas within the main report; or 

“Local,” which means that the variable can only specifically be used by the formula within which it is 

declared. 

 The scope of the variable is actually set when you originally declare the variable value by placing 

either the word “Global,” “Shared,” or “Local”, then a space, and then the variable declaration of the data 

type and the variable name, as normal. If omitted, the default scope for a variable is “global.” Although the 

value of global variables can be used by any formula in the report, you must re-declare the variable in any 

other formula in order to use its value. If you wish to re-declare a variable, type the variable type, a space, 

and then the name of the variable again. 

 It is also worth noting that in order for a variable to work, it must be placed into a formula field within 

the Design view of a report, so that Crystal can evaluate the variable calculation and store it to temporary 

memory for future display. If you don‟t need to see the calculations in the “Preview,” then you can suppress 

the display of the variable in the “Design” view. 

14.4- Using Array Values: 

 

 Note that when you create parameter fields, you had the ability to create parameters that stored 

multiple values, such as multiple names or even an upper and a lower date value. When you create a 

parameter that stores multiple values, Crystal Reports stores these values to a structure called an array. An 

array is much like a database table, in that it can store multiple values. It is simply an ordered list of values 

which all share the same data type. Values stored within an array are called the array elements. 

 You can also create arrays using the MakeArray() function in either the Crystal syntax or the Basic 

syntax. There are also several functions which make use of arrays of numbers for their calculations, such as 

the statistical functions of Variation() or StdDev(). You can also use arrays with your standard 

mathematical functions, like Average() or Sum(). Oftentimes, arrays are created in parameter fields by 

storing two date values which are then used for record selection purposes. You can use the Minimum() and 

Maximum() functions to extract the lower and upper date ranges from the parameter array to use in the 

report subtitle, which is helpful for showing the date range selected by the parameter prompt. 
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Advanced Formula Creation 

14.5- Using “If… Then… Else…” Statements: 

 

 You can use the “If… Then… Else…” statement to create formula expressions which evaluate a 

condition and then return an outcome based on whether or not the condition evaluated returns a “true” or 

“false” value. You can even nest multiple “If… Then… Else…” statements together in order to test for 

multiple possible conditions. Note that it is important to remember that the results specified by the “Then…” 

and “Else…” lines of the expression must be of the same data type. In the “If… Then… Else…” statement 

you specify the condition to evaluate after the word “If.” If the condition evaluates as being “true,” then 

whatever is specified by the “Then…” aspect is returned by the statement and the “Else…” is ignored. 

Conversely, if the test returns a “false” value, the “Then…” is ignored and the “Else…” is evaluated. This 

can be very important to remember when using multiple nested if statements to test for multiple conditions. 

The general syntax of the statement is as follows: 

 

IF logical_test 

THEN true_result 

ELSE false_result 

14.6- Using the “Select/Case” Statement: 

 

 The “Select” statement, which is also often called the “Case” statement, is another statement which 

evaluate multiple possible conditions and returns an output based on which condition evaluates to “true.” 

This is often a simpler way of expressing a statement that could also be expressed as a more complex 

nested “If… Then… Else…” statement. The general format of the select/case statement is as follows: 

 

SELECT evaluated_expression 

CASE Condition_1 : Expression_1 

CASE Condition_2 : Expression_2 

CASE Condition_3 : Expression_3 

DEFAULT : default_value 

 

 The evaluated expression is placed after the word “SELECT.” After the word “CASE” for each 

subsequent line, you add the condition to evaluate, followed by a colon symbol (:), followed by the 

expression to use if the condition is “true.” After the word “DEFAULT,” you place the expression that you 

want as the default if the evaluated condition doesn‟t match any of the listed cases. 

 You can have multiple specific conditions listed for the evaluated_expression by separating them 

with commas. If you want to use comparison operators in the Conditions, then specify the word “is,” 

followed by a space and then the desired comparison operator, followed by the condition to evaluate as 

usual. 

Sa
mple

- f
or

 ev
alu

ati
on

 pu
rp

os
es

 on
ly!



89 Advanced Crystal Reports ©TeachUcomp, Inc. 

Advanced Formula Creation 

14.7- Using “For” Loops: 

 

 Both the “If… Then… Else…” and “Select/Case” statements are only executed once and not every 

condition possible is necessarily tested during the execution. You can use the “For” clause to establish 

loops that allow you to evaluate a sequence of expressions multiple times. Oftentimes, this is useful for 

working with array values. 

 You need to declare a “counter” variable to establish a number to use as the number of times to loop 

through the collected statements (which must appear inside of parentheses). Also note that if you have an 

“If… Then… Else…” statement included within your “For” statement, you will often use the “Exit For” ending 

as one of the results returned from the logical test in order to exit the specified loop. The general syntax is 

shown below (without the “exit for” clause): 

 

FOR number_of_times DO (statements) 

14.8- Using “Do… While” Loops: 

 

 While the “For” loop allows the user to loop through a series of statements a set number of times, 

the “Do… While” loop allows the user to repeat looping through a series of statements until a specific 

condition is met. Once again, like the “For” loop, you can also use the “exit while” clause to exit a “Do… 

While” loop if it uses an “If… Then… Else…” clause and you wish to have a possible result of the test be to 

exit the “Do… While” loop. The general syntax of the “Do… While” loop (without the “exit while” clause) is 

shown below: 

 

DO (statements) WHILE condition_remains_true 

 

 There is another variation on this loop which can be used to evaluate a condition, first, and then 

execute a series of statements if the condition evaluates to a “true” value. This is the “While… Do” loop 

syntax. When using the “Do… While” syntax, the set of statements must be executed at least once, and 

then the condition is evaluated. When we switch the syntax to the “While… Do” syntax, the condition is 

evaluated first, and if found to be true, the series of statements is then executed until the condition returns a 

“false” value. The general syntax of the “While… Do” loop is shown below: 

 

WHILE condition_remains_true DO (statements) 

14.9- The IIF Function: 

 

 The IIF Function is another way of expressing the logic found within the “If… Then… Else…” 

statement using a more succinct syntax. There are three arguments used in this function, the logical_test to 

evaluate, the true_result, and the false_result. The general syntax used for this function is shown below: 

 

IIF(logical_test,true_result,false_result) 
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ACTIONS- 

Advanced Formula Creation 
EVALUATION TIME FUNCTIONS: 

 

1. BeforeReadingRecords- specifies that the formula is to be evaluated before the first pass. 

2. WhileReadingRecords- specifies that the formula is to be evaluated during the first pass of the data. 

3. WhilePrintingRecords- specifies that the formula is to be evaluated during the second pass of the data. 

DECLARING A VARIABLE: 

 

1. First decide what “scope” the variable should have: “Global,” “Shared,” or “Local.” If omitted, then the 

variable is determined to be “Global” in scope. 

2. Next, declare the data type of the variable. 

3. Type a literal space value. 

4. Type the name of the variable. It must be less than 255 characters in length, have no spaces, and cannot 

begin with a number. 

ASSIGNING A VARIABLE: 

 

1. Type the name of the variable which you have already declared. 

2. Type a space, a colon sign, followed by an equal sign, and then another space. 

3. Type the value to assign to the variable. 

CREATING AN ARRAY: 

 

1. When you create a parameter field which accepts multiple selections, the selections made are stored into 

an array. 

 

OR 

 

1. Use the MakeArray() function to create an array of values. 

THE GENERAL “IF… THEN… ELSE…” STATEMENT SYNTAX: 

 

IF logical_test 

THEN true_result 

ELSE false_result 

THE GENERAL “SELECT/CASE” STATEMENT SYNTAX: 

 

SELECT evaluated_expression 

CASE Condition_1 : Expression_1 

CASE Condition_2 : Expression_2 

CASE Condition_3 : Expression_3 

DEFAULT : default_value Sa
mple

- f
or

 ev
alu

ati
on

 pu
rp

os
es

 on
ly!



91 Advanced Crystal Reports ©TeachUcomp, Inc. 

ACTIONS- 

Advanced Formula Creation 
THE GENERAL “FOR” STATEMENT SYNTAX: 

 

FOR number_of_times DO (statements) 

THE GENERAL “DO… WHILE” STATEMENT SYNTAX: 

 

DO (statements) WHILE condition_remains_true 

 

OR 

 

WHILE condition_remains_true DO (statements) 

THE GENERAL “IIF” STATEMENT SYNTAX: 

 

IIF(logical_test,true_result,false_result) 
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EXERCISES- 

Advanced Formula Creation 
Purpose: 

 

1. To be able to incorporate more advanced formula usage into our reports. 

Exercises: 

 

1. Open Crystal Reports. 

2. Select “File| Open…” from the Menu Bar to launch the “Open” dialog box. 

3. Navigate to the “My Documents” folder where you stored the “Customer Order Report” which was 

created in the “Chapter 11- Exercise.” 

4. Click on the “Customer Order Report” to select it, and then click the “Open” button to open it. 

5. Click the “Design” tab. 

6. Click the “Customer Order Report” text object in the “Report Header” to select it. 

7. Choose “Edit| Delete” from the Menu Bar. 

8. Click on the “Formula Fields” entry in the “Field Explorer” pane. 

9. Click the “New” button in the toolbar at the top of the pane. 

10. In the “Formula Name” dialog box, type “CustomerTitle” into the “Name:” text box. If using Crystal 

Reports 10, click the “Use Editor” button. If using Crystal Reports 2011, 2008 or 11, click “OK.” 

11. Type the following into the “Formula Text” window in the “Formula Workshop- Formula Editor” 

window. 

 

 NUMBERVAR Repetitions; 

 STRINGVAR ShowCustomers := 'Total Sales for All Orders for the Following Customers: ' ; 

 FOR Repetitions := 1 to UBOUND({?Customer}) DO 

 (ShowCustomers := ShowCustomers + {?Customer}[Repetitions] + ', ' ); 

 LEFT(ShowCustomers,LENGTH(ShowCustomers)-2) 

 

12. Click the “Save and Close” button in the toolbar at the top of the window when you are finished. 

13. Click and drag the “CustomerTitle” field from the “Field Explorer” pane and drop it into the upper left 

corner of the “Report Header.” 

14. Right-click on the field and choose “Format Field…” from the Menu Bar. 

15. In the “Format Editor” dialog box, click the “Font” tab. 

16. Use the “Style:” drop-down to select “Bold.” 

17. Use the “Size:” drop-down to select “14.” 

18. Click “OK.” 

19. Resize the field so that it is taller vertically and can display the height of the text. 

20. Resize the field horizontally so that it stretches across the entire top of the page. 

21. Switch to the “Preview” tab to view your change. Switch back to the “Design” tab and resize it as 

needed to display the names of the selected customers. 

22. Select “File| Save” from the Menu Bar. 

23. Select “File| Close” from the Menu Bar. 
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CHAPTER 15- 

Advanced Reporting 

15.1- Creating a Report Template 

 

15.2- Exporting Report Results 

 

15.3- Exporting as HTML 

 

15.4- Setting Default Options 

 

15.5- Setting Report Options 
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Advanced Reporting 

15.1- Creating a Report Template: 

 

 You can create report templates that have no defined connection to data sources, but can be used 

to apply report formatting and layout. To do this, first create a new blank report that has no connection to an 

underlying data source. In Crystal Reports 10 you can do this by selecting “File| New…” from the Menu Bar 

to launch the “Crystal Reports Gallery” dialog box, where you can select the “As a Blank Report” option 

button and then click “OK.” In Crystal Reports 2011, 2008 and 11, you can click the “Blank Report” hyperlink 

in the “Start Page.” When the “Database Expert” dialog box appears, click the “Cancel” button. 

 You can add the report elements that you would like into the template. Text objects, logos and other 

images, and other non-data related objects (like “Special Fields”) can be placed into the report. In a 

template, you do not place actual fields of information, but rather place “template fields” which act as 

placeholders for the data- to determine the appearance and placement of the fields. When you are ready to 

set the placement of the template fields, select “Insert| Template Field Object” from the Menu Bar. Then 

click into the section of the report where you want to place the template field. This will then place a detail 

entry and column heading that you can move and format as desired. Also notice that the template field is 

actually a “Formula Field” and you can see it under that section of the “Field Explorer” pane. 

 In order to save the report and have it appear in the future as a template which can be selected 

through the “Template Expert” dialog box, we will need to make some more modifications beyond simply 

placing the desired report objects, special fields, and template fields into the report design view. When you 

select a template to apply in the “Template Expert” dialog box, you can see the name of the template and a 

preview of the template to be applied. This information, such as the “name” of the template and the 

“preview” picture, is entered into the document before saving it as a template so that it will appear in the 

future when you select this template through the “Template Expert” dialog box. 

 To create the document properties, which allows you to enter this type of information, select “File| 

Summary Info…” from the Menu Bar to launch the “Document Properties” dialog box. This dialog box 

consists of two tabs: “Summary” and “Statistics.” Click the “Summary” tab to enter the document information 

for the report template. In the “Author:” text box, you can enter the name of the creator of the template, if 

desired. Under “Keywords:,” you can enter any keywords that identify this template. This can be used for file 

searching in the future. You can type a description of the report, or any other information you want, into the 

“Comments:” text box. The first 256 characters of this box can be displayed through the use of the “Report 

Comments” special field within a report. Type a title for the report into the “Title:” text box. Whatever title is 

entered here can be displayed through the use of the “Report Title” special field in a report. This will also be 

the name of the template displayed within the “Template Expert.” You can click into the “Subject:” text box 

and type in the overall subject of your report. Then you can click into the “Template:” text box and type in an 

identifying name for the template, if desired. Then check the “Save Preview Picture” to save a preview of 

the first page of the content of the template. Ensure that you do not have sensitive data displayed in the first 

page if you check this checkbox. When you have finished entering the document properties, click “OK” to 

save and close the “Document Properties” dialog box. 

 You can save the report template by choosing “File| Save As…” from the Menu Bar. This will open 

the “Save As” dialog box. In order to save the report as a template, use the “Save in:” drop-down to save the 

file into the default template directory. Assuming that you installed to your “C:\” drive, for Crystal Reports 

2011, this is usually “C:\Program Files\SAP BusinessObjects\Crystal Reports 2011\Templates\en.” For 

2008, this is usually “C:\Program Files\Business Objects\Crystal Reports 12.0\Templates.” For 11, this is 

usually “C:\Program Files\Business Objects\Crystal Reports 11\Templates.” For 10, this is usually 

“C:\Program Files\Crystal Decisions\Crystal Reports 10\Templates.” Then type whatever file name you wish 

to save it with into the “File Name:” text box. Click “Save” to save the report template into the selected folder 

with the given name. Sa
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Advanced Reporting 

15.2- Exporting Report Results: 

 

 When it comes time to allow access to the report data generated by Crystal Reports, you have a few 

options for exporting the results. In this lesson we will examine the options that we have for exporting report 

results to the users that need to view that data. When it comes time to export the report results, you can first 

open the report which you wish to export, and then choose either “File| Export| Export Report” (“File| 

Export…” in Crystal Reports 10) from the Menu Bar or click the “Export” button in the Standard toolbar. 

 This will then launch the “Export” dialog box, which is used to export the selected report to a chosen 

destination in the format you prefer. Use the “Format:” drop-down to select the desired format to which you 

would like to export the selected report. Then use the “Destination:” drop-down to select one of the possible 

report destinations to which you could export the report. When you have made the desired selections from 

the drop-down, click “OK” to begin the exporting process. 

 Note that if you wish to export to one of the e-mail systems listed, you will log-in to the selected 

system and send the email to the designated recipients after clicking “OK.” If using the “Lotus Domino” 

system, ensure that you read the help file in Crystal Reports about exporting to this destination, as it 

requires additional setup. 

 If you select the “Application” option, Crystal will export the report to the application used to open the 

type of file format you selected. For example, if you selected “MS Word” from the “Format:” drop-down and 

then chose “Application” for the “Destination:,” Crystal Reports would open Microsoft Word and export the 

report as a new file in that application. 

 If you choose “Disk file” from the “Destination:” drop-down, then you can select the folder on your 

network to which you want to export the report. If you have Microsoft Exchange Server available and wish to 

save the report to a selected exchange folder, you can select that option to save it into a public or private 

folder which is then accessible through Microsoft Outlook. 

 The types of formats which are available for export will vary depending on the DLL files installed on 

your system. Depending on which format and destination you select, you may have to make additional 

choices in the ensuing dialog boxes which appear. 
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Advanced Reporting 

15.3- Exporting as HTML: 

 

 HTML (Hypertext Markup Language) is a terrific export option for Crystal Reports, as HTML 

documents can be displayed easily on both the Internet and also on corporate intranets, as needed. As long 

as the user has access to the directory to which you will be exporting the results and a web browser, you 

can export the results as HTML to allow user access. 

 To export a displayed report as HTML, choose either “File| Export| Export Report” (“File| Export…” in 

Crystal Reports 10) from the Menu Bar, or click the “Export” button in the Standard toolbar. In the “Export” 

dialog box, select “HTML 4.0” as the “Format:” and then choose “Application” from the “Destination:” drop-

down. Selecting “Application” will then immediately open the report using your computer‟s default web 

browser after you have exported the results as HTML. Click “OK” when you are ready to export the results 

to launch the “Select Export File” dialog box. 

 In the “Select Export File” dialog box, you create the directory (folder) into which you will export the 

report results. The HTML report file will be placed into the folder created (along with several secondary, 

associated files) with the name that you used when you saved it, but with the “.html” file extension, versus 

the “.rpt” file extension. 

 To decide where to create the specified report directory, use the “Drives:” drop-down to choose a 

computer drive into which you want to save the results. Double-click into the folder shown in the list above 

the “Drives:” into which you want to save the report. You can continue double-clicking on the folders within 

that folder to continue choosing sub-directories, as needed. When you have double-clicked on the folder 

into which you want to create the new report folder, type the name which you want to give to the new folder 

into the “Directory Name:” text box. 

 Next, you can change the name of the default web page (HTML file) created by typing the desired 

file name into the “Base File Name:” text box. Typically this is not necessary as the report will simply use 

the same name you used. You can then check the “Page navigator” checkbox to create a navigation tool in 

the web page which the users can use to browse through the pages in the report. You can check the 

“Separate HTML Pages” checkbox to create each page as a separate web page, versus creating one long 

scrolling web page from the report data. 

 If you wish to filter the page range, you can select the “Pages” option in the “Page Range” section. 

Then input the starting page number into the “From:” box and the ending page number into the “To:” text 

box. When you have set all of the options for HTML publishing as needed, click “OK” to export the selected 

report as an HTML page and then view it immediately in your computer‟s default web browser. 
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Advanced Reporting 

15.4- Setting Default Options for Crystal Reports: 

 

 You can control many of the default behaviors and options of Crystal Reports using the “Options” 

dialog box. Changes that are made here will affect all users of the installed instance of the application, so 

you should only make changes here if you are fully aware of how the changes will impact Crystal Reports 

and the other users on your machine. This is not like the “Report Options” dialog box, where changes made 

affect only the selected report. Changes made in the “Options” dialog box are global in nature. To view the 

“Options” dialog box, select “File| Options…” from the Menu Bar. 

 In the “Options” dialog box, you can select the tab name which contains the attributes which you 

would like to set. Then change any settings as needed, and click “OK” to apply the selected settings. Note 

that you can click on the name of any tab displayed in the “Options” dialog box and then click the “Help” 

button in the lower right corner to display a help file that lists the specific options which you can choose to 

set. The help file opens in a separate window, which you can close when you are finished using it. 

15.5- Setting Report Options: 

 

 You can also set options for a single report in the “Report Options” dialog box. To access this dialog 

box, first open the report whose options you would like to set. Then select “File| Report Options…” from the 

Menu Bar to open the “Report Options” dialog box. You can then set the desired options which you wish to 

apply to only the selected report in the dialog box, and then click “OK” to apply the selected report options. 

Note that if there are any report options that you do not understand, you can click the “Help” button in the 

“Report Options” dialog box to launch an associated help file that lists all of the available report options in a 

separate window. You can then read through the options or print the help file if you need a hard copy, and 

close the window when you are finished using it to return to Crystal Reports. 
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ACTIONS- 

Advanced Reporting 
CREATING A REPORT TEMPLATE: 

 

1. In Crystal Reports 2011, 2008 or 11, you can simply click the “Blank Report” hyperlink in the “Start Page.” 

If using Crystal Reports 10, select “File| New…” from the Menu Bar to launch the “Crystal Reports 

Gallery” dialog box, where you can select the “As a Blank Report” option button and then click “OK.”  

2. When the “Database Expert” dialog box appears, simply click the “Cancel” button to view the blank report 

in design view. 

3. Add the various report elements which you would like to appear as part of the template. Text objects, 

logos and other images, and other non-data related objects (like “Special Fields”) can be placed into the 

report at this time. 

4. When you are ready to set the placement of the template fields, select “Insert| Template Field Object” 

from the Menu Bar. Then click into the section of the report at which you would like to place the template 

field. Note that this will then place a detail entry and column heading that you can move and format as 

desired. Also notice that the template field is actually a “Formula Field” and you can see it under that 

section of the “Field Explorer” pane. 

5. Select “File| Summary Info…” from the Menu Bar to launch the “Document Properties” dialog box. 

6. Click the “Summary” tab to enter the document information for the report template. 

7. In the “Author:” text box, you can enter the name of the creator of the template, if desired. 

8. Under “Keywords:,” you can enter any keywords that identify this template. 

9. You can type a description of the report, or any other information you want, into the “Comments:” text 

box. 

10. Type a title for the report into the “Title:” text box. 

11. You can click into the “Subject:” text box and type in the overall subject of your report. 

12. In the “Template:” text box, type an identifying name that will be used for the template. 

13. Then check the “Save Preview Picture” to save a preview of the first page of the content of the template. 

14. When you have finished entering the document properties, click “OK” to save and close the “Document 

Properties” dialog box. 

15. Save the report by choosing “File| Save As…” from the Menu Bar to open the “Save As” dialog box. 

16. In order to save the report as a template, use the “Save in:” drop-down to save the file into the default 

template directory. For Crystal Reports 2008, this is usually “C:\Program Files\Business Objects\Crystal 

Reports 12.0\Templates,” assuming you installed the program to your “C:” drive. For Crystal Reports 11, 

this is usually “C:\Program Files\Business Objects\Crystal Reports 11\Templates,” assuming you 

installed the program to your “C:” drive. For Crystal Reports 10, this is usually “C:\Program Files\Crystal 

Decisions\Crystal Reports 10\Templates,” assuming you installed the program to your “C:” drive. 

17. Type whatever file name you wish to save it with into the “File Name:” text box. 

18. Click “Save” to save the report template into the selected folder with the given name. 

EXPORTING REPORT RESULTS: 

 

1. Open the report which you wish to export, and then choose either “File| Export| Export Report” (“File| 

Export…” in Crystal Reports 10) from the Menu Bar, or click the “Export” button in the Standard toolbar. 

2. In the “Export” dialog box, use the “Format:” drop-down to select the desired format to which you would 

like to export the selected report. 

3. Use the “Destination:” drop-down to select one of the possible report destinations to which you could 

export the report. 

4. Click “OK” to begin the exporting process and make any secondary selection in the dialog boxes which 

appear. Sa
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ACTIONS- 

Advanced Reporting 
EXPORTING REPORT RESULTS AS HTML: 

 

1. Open the report which you wish to export, and then choose either “File| Export| Export Report” (“File| 

Export…” in Crystal Reports 10) from the Menu Bar, or click the “Export” button in the Standard toolbar. 

2. In the “Export” dialog box, select “HTML 4.0” as the “Format:.” 

3. Choose “Application” from the “Destination:” drop-down. Selecting “Application” will immediately open the 

report using your computer‟s default web browser after you have exported the results. 

4. Click “OK” when you are ready to export the results to launch the “Select Export File” dialog box. 

5. To decide where to create the specified report directory, use the “Drives:” drop-down to choose a 

computer drive into which you want to save the results. 

6. Double-click into the folder shown in the list above the “Drives:” into which you want to save the report. 

You can continue double-clicking the folders within that folder to select sub-directories, as needed. 

7. When you have double-clicked on the folder into which you want to create the new report folder, type the 

name which you want to give to the new folder into the “Directory Name:” text box. 

8. You can change the name of the default web page (HTML file) created by typing the desired file name 

into the “Base File Name:” text box. Typically this is not necessary as the report will simply use the same 

name you used. 

9. You can then check the “Page navigator” checkbox to create a navigation tool in the web page which the 

users can use to browse through the pages in the report. 

10. You can check the “Separate HTML Pages” checkbox to create each page as a separate web page, 

versus creating one long scrolling web page from the report data. 

11. If you wish to filter the page range, you can select the “Pages” option in the “Page Range” section. Then 

input the starting page number into the “From:” box and the ending page number into the “To:” text box. 

12. When you have set all of the options for HTML publishing as needed, click “OK” to export the selected 

report as an HTML page and then view it immediately in your computer‟s default web browser. 

SETTING DEFAULT OPTIONS FOR CRYSTAL REPORTS: 

 

1. Select “File| Options…” from the Menu Bar. 

2. In the “Options” dialog box, select the tab name which contains the attributes which you would like to set. 

3. Note that you can click on the name of any tab displayed in the “Options” dialog box and then click the 

“Help” button in the lower right corner to display a help file that lists the specific options which you can 

choose to set. 

4. The help file opens in a separate window, which you can close when you are finished using it. 

5. Change any settings as needed, and click “OK” to apply the selected settings. 

SETTING REPORT OPTIONS: 

 

1. Open the report whose options you would like to set. 

2. Select “File| Report Options…” from the Menu Bar to open the “Report Options” dialog box. 

3. You can click the “Help” button in the “Report Options” dialog box to launch an associated help file that 

lists all of the available report options in a separate window, if needed. You can then read through the 

options and close the window when you are finished using it to return to Crystal Reports. 

4. You can then set the desired options which you wish to apply to only the selected report in the dialog 

box, and then click “OK” to apply the selected report options.  Sa
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EXERCISES- 

Advanced Reporting 
Purpose: 

 

1. To be able to create a report template in Crystal Reports 10. 

Exercises: 

 

1. Open Crystal Reports 10 and choose “File| New…” from the Menu Bar. 

2. In the “Crystal Reports Gallery” dialog box, select the “As a Blank Report” option and click “OK.” 

3. Click the “Cancel” button at the bottom of the “Database Expert” dialog box. 

4. Click the plus sign (+) next to the “Special Fields” list in the “Field Explorer” pane. 

5. Click and drag the “Report Title” special field from the list and drop it into the upper right corner of 

the “Report Header.” 

6. Right-click on the field and choose “Format Field…” from the Menu Bar to launch the “Format Editor” 

dialog box. 

7. Click on the “Font” tab. 

8. Use the “Style:” drop-down to select “Bold.” 

9. Use the “Size:” drop-down to select “14.” 

10. Click “OK.” 

11. Resize the “Report Title” field so that it is tall enough vertically to display the selected text. Then 

resize it horizontally to a width of 5” across. 

12. Click and drag the “Page N of M” field from the “Special Fields” in the “Field Explorer” pane and drop 

it at the far left edge of the “Page Footer.” 

13. Select the page number field that you just inserted and click the “Italic” button in the Formatting 

toolbar to italicize the selected field. 

14. Choose “Insert| Template Field Object” from the Menu Bar. 

15. Click once into the far left edge of the “Details” section to place the first template field. 

16. Resize the field horizontally so that it is 2” in width. 

17. Choose “Insert| Template Field Object” from the Menu Bar. 

18. Click once into the “Details” section at 2.5” to place the second template field. 

19. Resize the field out to the 4” mark on the horizontal ruler. 

20. Select “File| Summary Info…” from the Menu Bar. 

21. Click into the “Title:” field and type: “Two-column Report Template.” 

22. Check the “Save Preview Picture” checkbox. 

23. Click “OK” to set the document properties. 

24. Select “File| Save As…” from the Menu Bar. 

25. Use the “Save in:” drop-down to navigate to the following directory (assuming Crystal Reports is 

installed on your C:\ drive): “C:\Program Files\ Crystal Decisions\ Crystal Reports 10\Templates.” 

26. Type “Two-column template” into the “File name:” text box. 

27. Click “Save.” 

28. Select “File| Close” from the Menu Bar. 

Sa
mple

- f
or

 ev
alu

ati
on

 pu
rp

os
es

 on
ly!



101 Advanced Crystal Reports ©TeachUcomp, Inc. 

EXERCISES- 

Advanced Reporting 
Purpose: 

 

1. To be able to create a report template in Crystal Reports 2011, 2008 & 11. 

Exercises: 

 

1. Open Crystal Reports 2011, 2008 or 11. 

2. Click the “Blank Report” hyperlink in the “Start Page.” 

3. Click the “Cancel” button at the bottom of the “Database Expert” dialog box. 

4. Click the plus sign (+) next to the “Special Fields” list in the “Field Explorer” pane. 

5. Click and drag the “Report Title” special field from the list and drop it into the upper left corner of the 

“Report Header.” 

6. Right-click on the field and choose “Format Field…” from the Menu Bar to launch the “Format Editor” 

dialog box. 

7. Click on the “Font” tab. 

8. Use the “Style:” drop-down to select “Bold.” 

9. Use the “Size:” drop-down to select “14.” 

10. Click “OK.” 

11. Resize the “Report Title” field so that it is tall enough vertically to display the selected text. Then 

resize it horizontally to a width of 5” across. 

12. Click and drag the “Page N of M” field from the “Special Fields” in the “Field Explorer” pane and drop 

it at the far left edge of the “Page Footer.” 

13. Select the page number field that you just inserted and click the “Italic” button in the Formatting 

toolbar to italicize the selected field. 

14. Choose “Insert| Template Field Object” from the Menu Bar. 

15. Click once into the far left edge of the “Details” section to place the first template field. 

16. Resize the field horizontally so that it is 2” in width. 

17. Choose “Insert| Template Field Object” from the Menu Bar. 

18. Click once into the “Details” section at 2.5” to place the second template field. 

19. Resize the field out to the 4” mark on the horizontal ruler. 

20. Select “File| Summary Info…” from the Menu Bar. 

21. Click into the “Title:” field and type: “Two-column Report Template.” 

22. Check the “Save Preview Picture” checkbox. 

23. Click “OK” to set the document properties. 

24. Select “File| Save As…” from the Menu Bar. 

25. If using Crystal Reports 2008, use the “Save in:” drop-down to navigate to the following directory 

(assuming Crystal Reports is installed on your C:\ drive): “C:\Program Files\ Business Objects\ 

Crystal Reports 12.0\Templates.” If using Crystal Reports 11, use the “Save in:” drop-down to 

navigate to the following directory (assuming Crystal Reports is installed on your C:\ drive): 

“C:\Program Files\ Business Objects\ Crystal Reports 11\Templates.” 

26. Type “Two-column template” into the “File name:” text box. 

27. Click “Save.” 

28. Select “File| Close” from the Menu Bar. 
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CHAPTER 16- 

Using Report Wizards 

16.1- Using the Report Wizards 

 

16.2- Report Wizard Types 

 

16.3- Creating a Cross-Tab Report 
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Using Report Wizards 

16.1- Using the Report Wizards: 

 

 There are several report wizards which you can run to quickly and easily create many various types 

of reports in Crystal Reports. This can often be a way of more quickly creating a report which you would 

otherwise have to create by hand. You can also edit and modify the reports after you have created them, if 

needed. This is simply another way of beginning the report creation process. However, these are not tools 

for the novice user who has no concept of data selection, sorting, filtering and grouping to use. These 

wizards simply expedite the basic report creation process. 

 In Crystal Reports 2011, 2008 or 11, you can start one of the four reports wizards by simply clicking 

on the hyperlinked name of the desired report wizard that appears in the “New Reports” section of the “Start 

Page.” You can also start a report wizard by selecting “File| New” from the Menu Bar and then choosing the 

name of the desired report wizard from the side menu of choices that appears. You can select either the 

“Standard Report…,” “Cross-Tab Report…,” “Mailing Label Report…,” or “OLAP Cube Report…” choice to 

create a report using a wizard of the selected type. 

 In Crystal Reports 10, you can create a new report from a wizard by simply choosing “File| New…” 

from the Menu Bar or by clicking the “New” button in the Standard toolbar to launch the “Crystal Reports 

Gallery” dialog box. In the “Create a New Crystal Report Document” section, select the “Using the Report 

Wizard” option. That then allows you to select the type of report which you will create by choosing the 

desired type of wizard to use from the “Choose a Wizard” list. You can select either the “Standard,” “Cross-

Tab,” “Mail Label,” or “OLAP” wizard to create a report of the selected type. Once you have selected the 

type of report to create, click “OK” to continue. 

 Each wizard will lead you through a screen-by-screen process in which you answer questions and 

select report options. The screens which follow next will vary depending upon which wizard you selected. 

We will examine the most common options which you can set by selecting the “Standard” choice. 

 The first screen you will view after selecting the “Standard” choice is the “Data” screen in the 

“Standard Report Creation Wizard” dialog box. This is the same as the “Database Expert” dialog box. Any 

database connections you have created and stored to the “Favorites” folder in the “Database Expert” screen 

are available in this window. Select or set the desired data connection from the “Available Data Sources:” 

window and then move the desired data tables into the “Selected Tables:” pane at the right side of the 

dialog box. When you are ready to continue, click the “Next >” button to continue. 

 If you added multiple tables in the last screen, you will next view the “Link” screen. Here you review 

the tables which you have added to the report and you can edit the links, if needed. This is the same as the 

“Links” tab in the “Database Expert” dialog box. Make any changes you need here, and click the “Next >” 

button to continue. 

 In the “Fields” screen, you select the fields that you want to add to the report from the fields shown in 

the “Available Fields:” list at the left side of the dialog box. Click on the name of the field you want to add to 

the report and then click the right-pointing arrow “>” button to add the selected field to the “Fields to 

Display:” list at the right side of the dialog box. If needed, you can click on the name of a selected field in the 

“Fields to Display:” list and click the “up” and “down” arrows to change the placement of the field within the 

field list. The order of the fields, from top to bottom, is the order that they will be displayed from left to right in 

the report. When you have added the desired fields, click the “Next >” button to continue. 

 Next is the “Grouping” screen, where you can select a field by which to create data groupings within 

the report from the “Available Fields:” list at the left side of the dialog box. You can then click the right-

pointing arrow button “>” to move the selected field to the “Group By:” list at the right side of the screen. You 

can then choose how to sort the chosen field groupings by selecting the desired sorting option from the 

drop-down at the bottom of the “Group By:” list. Sa
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Using Report Wizards 

16.1- Using the Report Wizards (cont.): 

 

 If you want to create additional groupings within the primary grouping, you can continue to add 

additional fields from the “Available Fields:” list to the “Group By:” list, where you can then sort them by their 

values within the main grouping. If needed, you can select one of the groups and then click the “up” and 

“down” arrows to reorganize the order of the groups shown. When you have added the necessary fields by 

which to create the data groupings within your report, click the “Next >” button to continue. 

 If you elected to create data groupings in the report, then after clicking the “Next >” button to 

continue you will be presented with the “Summaries” screen. Once again, select the name of the field that 

you want to calculate and summarize for each unique value within the grouping. Then click the right-

pointing arrow button “>” to move the selected field to the “Summarized Fields:” list at the right side of the 

screen. You can choose which summary calculation to perform on the selected field from the drop-down list 

at the bottom of the “Summarized Fields:” list. If needed, you can choose a summary field value and click 

the “up” and “down” arrows in the “Summarized Fields:” list to move the field up or down in the list. The 

order of fields displayed here, from top to bottom, indicates the order that the fields will appear from left to 

right in the report. When you are ready, click the “Next >” button to continue. 

 If you added “Summaries” for the “Groups” in your report, then the next screen will be the “Group 

Sorting” screen, where you can sort the records by the summarized field values for each grouping. You can 

elect “None” to skip group ordering, or you can select “Top 5 Groups,” or “Bottom 5 Groups,” based on the 

values displayed in the selected summary value field. When you have set any options that you want to 

apply, click the “Next >” button to continue. 

 The next screen is the “Chart” screen. You can select a type of chart which you would like to see in 

the report by choosing a selected chart type from the option buttons available at the top of the screen. If you 

don‟t want a chart, then select the “No Chart” option button. If you do select a chart type, then type the title 

into the “Chart title:” text box. You can use the “On change of:” drop-down to select the field whose 

changing value establishes the series in your chart. Use the “Show Summary:” drop-down to choose the 

field whose values you wish to chart for each changing value in the field you selected in the “On change of:” 

drop-down. When you are ready to continue, click the “Next >” button. 

 In the “Record Selection” screen, you select a field or fields by which you want to filter the records in 

the selected tables. Choose the field by which you would like to filter the data from the “Available Fields:” 

list, and click the right-pointing arrow button “>” to move it into the “Filter Fields:” list. You can then select 

the field by which you wish to filter from the list at the right side of the dialog box and use the drop-down at 

the bottom of the “Filter Fields:” list to select the desired comparison operator. Then use the drop-down 

which appears below that one to select the desired comparison value from the drop-down list. You can also 

type a value directly into the drop-down box instead. When you are ready, click “Next >” to continue. 

 In the “Template” screen, you can select a report template to use as the basis for the current report 

from the listing in the “Available Templates” section. If you have a report which you would like to apply as a 

template you can click the “Browse…” button to select the report using the “Open” dialog box. If you don‟t 

want to apply a template, you can select the “No Template” option from the top of the “Available Templates” 

list. When you have made your choice, click “Finish” to create the report with the options which you have 

selected. 

 Note that if you wanted to change any settings that you made in the previous screens of the 

“Standard Report Creation Wizard,” you can click the “< Back” button to return to the desired screen and 

make changes. Then click the “Next >” button until you have reached the end of the wizard, at which point 

you can click the “Finish” button. If you simply wish to cancel the creation of the report, you can click the 

“Cancel” button at any time during the “Standard Report Creation Wizard” to cancel the report generation. Sa
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Using Report Wizards 

16.2- Report Wizard Types: 

 

 Besides the “Standard” report wizard, which is certainly the most common of the report wizards 

available for use, you can also use the wizards to create cross-tab reports, mailing labels, and reports 

based on OLAP data sources. 

 You can choose the “Cross-Tab” report wizard to let the wizard lead you through the process of 

creating a cross-tab report, which will generate a report which resembles the data displayed within a 

spreadsheet. The screens displayed in the “Cross-Tab Report Creation Wizard” are as follows: “Data,” 

“Link,” “Cross-Tab,” “Chart,” “Record Selection,” and “Grid Style.” 

 You can choose the “Mailing Label” report wizard to create a multi-column report which you can use 

to create mailing labels of various sizes and styles. The screens displayed in the “Mailing Labels Report 

Creation Wizard” are as follows: “Data,” “Link,” “Fields,” “Label,” and “Record Selection.” 

 If you select the “OLAP” report wizard, you will be led through the screens in the “OLAP Report 

Creation Wizard,” which allows you to display your OLAP data in a manner similar to a cross-tab report. The 

“OLAP Report Creation Wizard” contains the following screens: “OLAP Data,” “Rows/Columns,” 

“Slice/Page,” “Style,” and “Chart.” 

 Each wizard behaves in essentially the same manner that the “Standard Report Creation Wizard” 

does. You make your choices on each screen displayed and click the “Next >” button to continue to the next 

screen. When you are done answering the questions displayed in each screen, you can click the “Finish” 

button to generate the selected report. 
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Using Report Wizards 

16.3- Creating a Cross-Tab Report: 

 

 The cross-tab report format allows you to view information in one column by information in another 

column, and then display the summary value of yet a third column in the intersecting report cells. In 

essence, a cross-tab looks much like a giant spreadsheet would, and perhaps you have a familiarity with 

using cross-tab data in spreadsheet applications. For example, if you had a data table which had a column 

for each sale, the customer, the sale date, and the sales total; you could create a cross-tab report that lists 

the sales, grouped by quarter, across the top of the cross-tab report with the customers listed down the left 

side of the report, and the sum of all the sales totals for each customer by quarter shown in the intersecting 

cells. 

 Cross-tab reports are complete and separate reports that can stand well on their own. Often they will 

interfere with summary data displayed in a primary report when inserted as a report object. Ensure that you 

try to only use cross-tab reports as subreports within primary reports that share the same record set or 

underlying tables. If you still have difficulty, you can instead create the cross-tab report as a separate report 

and then link it to the primary report as an “on-demand” subreport. 

 You can create a cross-tab report by selecting “File| New| Cross-Tab Report…” from the Menu Bar. 

That will open the “Cross-Tab Report Creation Wizard.” On the first screen, you simply select the data on 

which you wish to base the report. Select the tables to use from the listing shown in the “Available Data 

Sources” list, and then click the “>” arrow button to move the selected table or tables into the “Selected 

Tables” list at the right side of the dialog box. Then click the “Next >” button to continue. 

 If you added multiple tables, the next screen you will see is the “Link” screen, where you can inspect 

the joins between the tables which you have added to the cross-tab report. When you are finished setting 

table joins, just click the “Next >” button to continue. 

 In the next screen, titled “Cross-Tab,” you can add fields from the “Available Fields” list into the 

“Rows,” “Columns,” and “Summary Fields” sections by selecting the desired field and then clicking the “>” 

arrow button that appears next to the desired section. Fields added to the “Columns” and “Rows” list will 

effectively be treated like “Grouped” fields, in that they will only display their unique values in the columns or 

rows. Fields added to the “Summary Fields” section will display the result of a calculation for the intersecting 

cells of the “Columns” and “Rows” values. You can select a field in the “Summary Fields” section, and then 

use the drop-down that appears below that section to change which calculation is performed on that field‟s 

data values. Also, for some types of fields, such as date/time fields that are added to the “Columns” or the 

“Rows” you can select which level of grouping to apply to the selected field from the drop-down that 

appears below those sections, as well. When you are finished, click the “Next >” button to continue. 

 The next screen is the “Chart” screen. You can select a type of chart which you would like to see in 

the report by choosing a selected chart type from the option buttons available at the top of the screen. This 

is the same as the “Chart” screen in the “Standard Report Creation Wizard.” When you are ready to 

continue, click the “Next >” button. 

 In the “Record Selection” screen, you select a field or fields by which you want to filter the records in 

the selected tables. This is the same as the “Record Selection” screen in the “Standard Report Creation 

Wizard.” When you are ready to continue, click the “Next >” button. 

 In the “Grid Style” section, you can select a default design template to apply to your cross-tab data 

from the styles shown in the “Available Styles” list. Select a style from the list and then click the “Finish” 

button to finish creating your cross-tab report. 
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ACTIONS- 

Using Report Wizards 
CREATING A STANDARD REPORT USING THE REPORT WIZARD: 

 

1. In Crystal Reports 2011, 2008 or 11, you can start one of the four reports wizards by simply clicking on 

the hyperlinked name of the desired report wizard that appears in the “New Reports” section of the “Start 

Page,” or by selecting “File| New” from the Menu Bar and then choosing the name of the desired report 

wizard from the side menu of choices that appears. You can select either the “Standard Report…,” 

“Cross-Tab Report…,” “Mailing Label Report…,” or “OLAP Cube Report…” choice. 

 

OR 

 

2. In Crystal Reports 10, you can create a new report from a wizard by simply choosing “File| New…” from 

the Menu Bar or by clicking the “New” button in the Standard toolbar to launch the “Crystal Reports 

Gallery” dialog box. In the “Create a New Crystal Report Document” section, select the “Using the Report 

Wizard” option. That then allows you to select the type of report which you will create by choosing the 

desired type of wizard to use from the “Choose a Wizard” list. You can select either the “Standard,” 

“Cross-Tab,” “Mail Label,” or “OLAP” wizard to create a report of the selected type. Once you have 

selected the type of report to create, click “OK” to continue. 

3. The first screen you will view after selecting the “Standard” choice is the “Data” screen in the “Standard 

Report Creation Wizard” dialog box. Select or set the desired data connection from the “Available Data 

Sources:” window and then move the desired data tables into the “Selected Tables:” pane at the right 

side of the dialog box. When you are ready, click the “Next >” button to continue. 

4. If you added multiple tables in the last screen, you will next view the “Link” screen. Review the tables that 

you have added and you can edit the links, if needed. Click the “Next >” button to continue, when ready. 

5. In the “Fields” screen, you select the fields that you want to add to the report from the fields shown in the 

“Available Fields:” list at the left side of the dialog box. Click on the name of the field you want to add to 

the report and then click the right-pointing arrow “>” button to add the selected field to the “Fields to 

Display:” list at the right side of the dialog box. If needed, you can click on the name of a selected field in 

the “Fields to Display:” list and click the “up” and “down” arrows to change the placement of the field 

within the field list. The order of the fields, from top to bottom, is the order that they will be displayed from 

left to right in the report. When you have added the desired fields, click the “Next >” button to continue. 

6. In the “Grouping” screen, select a field by which to create data groupings within the report from the 

“Available Fields:” list at the left side of the dialog box. You can then click the right-pointing arrow button 

“>” to move the selected field to the “Group By:” list at the right side of the screen. You can then choose 

how to sort the chosen field groupings by selecting the desired sorting option from the drop-down at the 

bottom of the “Group By:” list. If you want to create additional groupings within the primary grouping, you 

can continue to add additional fields from the “Available Fields:” list to the “Group By:” list, where you can 

then sort them by their values within the main grouping. If needed, you can select one of the groups and 

then click the “up” and “down” arrows to reorganize the order of the groups shown. When you have 

added the necessary fields by which to create the data groupings within your report, click the “Next >” 

button to continue. 

7. If you elected to create data groupings in the report, then after clicking the “Next >” button to continue you 

will be presented with the “Summaries” screen. Once again, select the name of the field that you want to 

calculate and summarize for each unique value within the grouping. Then click the right-pointing arrow 

button “>” to move the selected field to the “Summarized Fields:” list at the right side of the screen. You 

can choose which summary calculation to perform on the selected field from the drop-down list at the 

bottom of the “Summarized Fields:” list. 

(cont…) Sa
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ACTIONS- 

Using Report Wizards 
CREATING A STANDARD REPORT USING THE REPORT WIZARD (CONT.): 

 

8. If needed, you can choose a summary field value and click the “up” and “down” arrows in the 

“Summarized Fields:” list to move the field up or down in the list. The order of fields displayed here, from 

top to bottom, indicates the order that the fields will appear from left to right in the report. When you are 

ready, click the “Next >” button to continue. 

9. If you added “Summaries” for the “Groups” in your report, then the next screen will be the “Group Sorting” 

screen, where you can sort the records by the summarized field values for each grouping. You can elect 

“None” to skip group ordering, or you can select “Top 5 Groups,” or “Bottom 5 Groups,” based on the 

values displayed in the selected summary value field. When you have set any options that you want to 

apply, click the “Next >” button to continue. 

10. The next screen is the “Chart” screen. You can select a type of chart which you would like to see in the 

report by choosing a selected chart type from the option buttons available at the top of the screen. If you 

don‟t want a chart, then select the “No Chart” option button. If you do select a chart type, then type the 

title into the “Chart title:” text box. You can use the “On change of:” drop-down to select the field whose 

changing value establishes the series in your chart. Use the “Show Summary:” drop-down to choose the 

field whose values you wish to chart for each changing value in the field you selected in the “On change 

of:” drop-down. When you are ready to continue, click the “Next >” button. 

11. In the “Record Selection” screen, you select a field or fields by which you want to filter the records in the 

selected tables. Choose the field by which you would like to filter the data from the “Available Fields:” list, 

and click the right-pointing arrow button “>” to move it into the “Filter Fields:” list. You can then select the 

field by which you wish to filter from the list at the right side of the dialog box and use the drop-down at 

the bottom of the “Filter Fields:” list to select the desired comparison operator. Then use the drop-down 

which appears below that one to select the desired comparison value from the drop-down list. You can 

also type a value directly into the drop-down box instead. When you are ready, click “Next >” to continue. 

12. In the “Template” screen, you can select a report template to use as the basis for the current report from 

the listing in the “Available Templates” section. If you have a report which you would like to apply as a 

template you can click the “Browse…” button to select the report using the “Open” dialog box. If you don‟t 

want to apply a template, you can select the “No Template” option from the top of the “Available 

Templates” list. 

13. When you have made your choice, click “Finish” to create the report with the options which you have 

selected. 

14. If you want to change any settings that you made in the previous screens of the “Standard Report 

Creation Wizard,” you can click the “< Back” button to return to the desired screen and make changes. 

Then click the “Next >” button until you have reached the end of the wizard, at which point you can click 

the “Finish” button. 

15. If you simply wish to cancel the creation of the report, you can click the “Cancel” button at any time 

during the “Standard Report Creation Wizard” to cancel the report generation. 
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ACTIONS- 

Using Report Wizards 
CREATING A REPORT USING ONE OF THE REPORT WIZARDS (CRYSTAL REPORTS 10): 

 

1. Select “File| New…” from the Menu Bar or click the “New” button in the Standard toolbar to launch the 

“Crystal Reports Gallery” dialog box. 

2. Select the “Using the Report Wizard” option button. 

3. Select the desired report wizard in the “Choose a Wizard” list which you would like to run: “Standard,” 

“Cross-Tab,” “Mail Label,” or “OLAP.” 

4. Click “OK.” 

5. Answer any questions and make the necessary selections posed to you in each screen of the report 

wizard, and click the “Next >” button to continue through the screens. 

6. When you are done answering the questions posed to you by the wizard, click “Finish” to create the 

report with the options that you specified. 

CREATING A REPORT USING ONE OF THE REPORT WIZARDS (CRYSTAL REPORTS 2011, 2008 

AND 11): 

 

1. Click the hyperlinked name of the report wizard that you want to use in the “Start Page:” “Standard 

Report Wizard;” “Cross-Tab Report Wizard;” “Mailing Label Report Wizard;” or “OLAP Cube Report 

Wizard.” 

 

OR 

 

1. Select “File| New” from the Menu Bar and then choose the desired report wizard from the side menu 

which appears: “Standard Report…;” “Cross-Tab Report…;” “Mailing Label Report…;” or “OLAP Cube 

Report….” 

2. Answer any questions and make the necessary selections posed to you in each screen of the selected 

report wizard, and click the “Next >” button to continue through the screens. 

3. When you are done answering the questions posed to you by the wizard, click the “Finish” button to 

create the report with the options that you specified. 
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ACTIONS- 

Using Report Wizards 
CREATING A CROSS-TAB REPORT : 

 

1. You can create a cross-tab report by selecting “File| New| Cross-Tab Report…” from the Menu Bar. That 

will open the “Cross-Tab Report Creation Wizard.” 

2. On the first screen, you simply select the data on which you wish to base the report. Select the tables to 

use from the listing shown in the “Available Data Sources” list, and then click the “>” arrow button to 

move the selected table or tables into the “Selected Tables” list at the right side of the dialog box. Then 

click the “Next >” button to continue. 

3. If you added multiple tables, the next screen you will see is the “Link” screen, where you can inspect the 

joins between the tables which you have added to the cross-tab report. When you are finished setting 

table joins, just click the “Next >” button to continue. 

4. In the next screen, titled “Cross-Tab,” you can add fields from the “Available Fields” list into the “Rows,” 

“Columns,” and “Summary Fields” sections by selecting the desired field and then clicking the “>” arrow 

button that appears next to the desired section. Fields added to the “Columns” and “Rows” list will 

effectively be treated like “Grouped” fields, in that they will only display their unique values in the 

columns or rows. Fields added to the “Summary Fields” section will display the result of a calculation for 

the intersecting cells of the “Columns” and “Rows” values. You can select a field in the “Summary 

Fields” section, and then use the drop-down that appears below that section to change which 

calculation is performed on that field‟s data values. Also, for some types of fields, such as date/time 

fields that are added to the “Columns” or the “Rows” you can select which level of grouping to apply to 

the selected field from the drop-down that appears below those sections, as well. When you are 

finished, click the “Next >” button to continue. 

5. The next screen is the “Chart” screen. You can select a type of chart which you would like to see in the 

report by choosing a selected chart type from the option buttons available at the top of the screen. This 

is the same as the “Chart” screen in the “Standard Report Creation Wizard.” When you are ready to 

continue, click the “Next >” button. 

6. In the “Record Selection” screen, you select a field or fields by which you want to filter the records in the 

selected tables. This is the same as the “Record Selection” screen in the “Standard Report Creation 

Wizard.” When you are ready to continue, click the “Next >” button. 

7. In the “Grid Style” section, you can select a default design template to apply to your cross-tab data from 

the styles shown in the “Available Styles” list. Select a style form the list and then click the “Finish” 

button to finish creating your cross-tab report. 
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EXERCISES- 

Using Report Wizards 
Purpose: 

 

1. To be able to create a standard report using the report wizard in Crystal Reports. 

Exercises: 

 

1. In Crystal Reports 2011 or 2008, click the “Report Wizard” hyperlink in the “Start Page.” In Crystal 

Reports 11, click the “Standard Report Creation Wizard” hyperlink in the “Start Page.” In Crystal 

Reports 10, choose “File| New…” from the Menu Bar. Then, in the “Crystal Reports Gallery” dialog 

box, select the “Using the Report Wizard” option button. Select the “Standard” option in the “Choose 

a Wizard” list. Click “OK.” 

2. In the “Database Expert” dialog box, expand the data source connection to reveal the sample 

database connection, which was created in the “Chapter 3- Exercise” from the “Introductory Crystal 

Reports” manual. 

3. Click the plus sign next to the “Tables” in the sample database 

4. Select the “Employee” table. 

5. Click the right-pointing arrow button “>” to move the table into the “Selected Tables:” list. 

6. Click “Next >” to continue. 

7. In the “Fields” screen, select the “First Name” field. 

8. Click the right-pointing arrow button “>” to move the field into the “Fields to Display:” list. 

9. Select the “Last Name” field. 

10. Click the right-pointing arrow button “>” to move the field into the “Fields to Display:” list. 

11. Select the “Position” field. 

12. Click the right-pointing arrow button “>” to move the field into the “Fields to Display:” list. 

13. Click “Next >” to continue. 

14. On the “Grouping” screen, select the “Employee.Position” field. 

15. Click the right-pointing arrow button “>” to move the field into the “Group By:” list. 

16. Click “Next >” to continue. 

17. In the “Summaries” screen, select the “Employee.Position” field from the “Available Fields:” list at the 

left side of the dialog box. 

18. Click the right-pointing arrow button “>” to move the field into the “Summarized Fields:” list. 

19. Use the drop-down at the bottom of the “Summarized Fields:” list to select “Count.” 

20. Click “Next >” to continue. 

21. In the “Group Sorting” screen, select “None.” 

22. Click “Next >” to continue. 

23. In the “Chart” screen, select the “Pie Chart” option button. 

24. Type “Employees by Job Type” into the “Chart Title” text box. 

25. Click “Next >” to continue. 

26. Skip the “Record Selection” screen and click “Next >” to continue. 

27. Select the “No Template” option from the “Available Templates” list at the left side of the dialog box. 

28. Click the “Finish” button to finish the report. 

29. Select “File| Save As…” from the Menu Bar. 

30. Use the “Save in:” drop-down to select the “My Documents” folder. 

31. Type “Employees by Job Type” into the “File name:” text box. 

32. Click “Save” to save the report. 

33. Select “File| Close” from the Menu Bar to close the report. Sa
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CHAPTER 17- 

Advanced Database Concepts 

17.1- Viewing the SQL Code 

 

17.2- Using Table Aliases 

 

17.3- Verifying the Database 

 

17.4- Setting the Datasource Location 

 

17.5- Mapping Fields 
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Advanced Database Concepts 

17.1- Viewing the SQL Code: 

 

 SQL (ess-cue-el), is an acronym that stands for “Structured Query Language.” It is the language 

used in relational database applications for record selection, modification, and creation. You may also often 

hear it referred to as SQL (sequel), which is not technically correct but often used. 

 In Crystal Reports we focus on the ways in which we can use the SQL statements to select the data 

which we then use as the basis for our reports. Almost all of the reports which we create have an SQL 

statement as their basis. There is really only one statement used for record selection in the SQL language, 

and it is called the SELECT statement. Every report has the SELECT statement as the basis of the report, 

but with variations on the specific clauses used in the statement. The general syntax of the SELECT 

statement in SQL is as follows: 

 

SELECT fields 

FROM tables 

WHERE criteria 

ORDER BY field 

 

 There are also several variations within this general framework. Many different database vendors 

use slightly different SQL code, and there are also additional clauses, such as INNER JOIN, OUTER JOIN, 

GROUP BY and others which may also be used in more complex expressions of SQL. 

 If you would like to study the SQL code for a report based on tables, you can do so by choosing 

“Database| Show SQL Query…” from the Menu Bar. This will then display the “Show SQL Query” dialog 

box, where you can view the specific SQL code used to generate the report‟s data set. This statement is not 

editable, so when you have finished examining the SQL statement, click “OK” or “Close” to close the box. 
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Advanced Database Concepts 

17.2- Using Table Aliases: 

 

 You can add a table to a report more than one time in order to create a “self-join” between two 

related fields within a single table. However, you cannot add the same table twice without giving it a 

different name the second time. This is called specifying a table “alias.” When you attempt to add the same 

table to a report twice, Crystal warns you that you already have a table with that name added to the report, 

and prompts you to add an alias for this table. If you click “Yes” to this prompt, Crystal will then add the 

name of the table, followed by the underscore character, and then a sequential number (1, 2, 3, etc…) 

increasing the number for each alias. You can then change the name of the alias by selecting the name of 

the alias in the “Database Expert” dialog box and then pressing the “F2” key on your keyboard to rename 

the table alias. 

17.3- Verifying the Database: 

 

 At times you will find that the computer or network environment in which you have created your 

Crystal Reports has changed and caused your Crystal Reports to no longer function. Database files can be 

moved about on the network, re-designed, or otherwise changed in some way that can create an improperly 

working report. Crystal Reports provides three tools to assist you in fixing reporting issues caused by 

changes to the database to which the report is connected. Using these tools can prevent you from having to 

scrap your report and start over creating an entirely new report. The first tool we will discuss is the “Verify 

Database” command. This is a useful tool for detecting new field additions to the database from which the 

report results are drawn. 

 When you verify the database, Crystal will either automatically make the corrections to the report or 

it will prompt you to make the corrections manually through the “Map Fields” dialog box. Crystal Reports will 

automatically find new fields added to the database, note changes to field data types, change the order of 

the fields if needed, and remove fields which have not been used in the report from the “Field Explorer” 

pane. Other types of changes, will invoke the “Map Fields” tool which requires user assistance in order to 

resolve report and database inconsistencies. 

 To verify a database, simply open the report which attaches to the database that you want to verify. 

Then select “Database| Verify Database” from the Menu Bar. If the database to which the report is attached 

is current, then you will see a message box appear and tell you that the database is up to date. You can 

then click “OK” to close the message box. 

 If there are errors in the underlying table, you will see a message box appear and tell you that the 

file has changed and that Crystal will now proceed to fix up the report. When you click “OK,” Crystal will 

then attempt to fix any database errors. Some of the alterations made may require that you manually make 

the change to the report field using the “Map Fields” dialog box. After it is done, you will then see any 

database changes in the “Field Explorer” pane. Sa
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Advanced Database Concepts 

17.4- Setting the Datasource Location: 

 

 If you need to change the database connection used by the report, you can use the “Set Datasource 

Location” dialog box to reset the data source association used for the selected report. In order to 

accomplish this, open the report which contains the data source connection which you wish to change and 

then choose “Database| Set Datasource Location…” from the Menu Bar. 

 This will then open the “Set Datasource Location” dialog box where you can view the current data 

source choice shown in the “Current Data Source:” section at the top of the dialog box. Here you can select 

the table to replace from the list displayed. 

 At the bottom of the dialog box, in the “Replace with:” section, you can select the name of the table 

with which you want to replace the table you previously selected. Once you have the tables which you wish 

to change selected, click the “Update” button at the right side of the dialog box. Unless the tables which you 

switched have identical field names, you will then need to use the “Map Fields” dialog box to re-map the 

data fields within the report. If they do happen to have the exact same names, then simply clicking the 

“Update” button is enough. 

17.5- Mapping Fields: 

 

 When you switch the data source used for a report from one database to another, or even make 

simple structure modifications to the existing database which involve renaming the fields within the tables 

used in the report, Crystal Reports will then need to re-map the fields in the report to the new (or changed) 

fields within the associated database tables. You use the “Map Fields” dialog box to accomplish this. This 

dialog box is often invoked as a secondary process involved with database verification and changing the 

report‟s data source. It is used to manually make corrections between the report and the underlying data 

source. 

 In the “Map Fields” dialog box you will see four separate lists of fields. The upper left list shows 

“unmapped” fields within the report which have not been associated with a field in the underlying data 

source. The potential fields with which the “unmapped” fields could be associated are listed in the upper 

right corner. In the lower left corner are report fields which have successfully been mapped by Crystal 

Reports based on the field names. In the lower right corner you can see the database fields with which the 

“mapped” report fields have been associated. 

 You can manually create associations between the unmapped report fields and the potential 

database fields by selecting the field to map from the “Unmapped Field” list, and then clicking on a 

“matching” field in the list of database fields to the right. Then click the “Map” button at the right to create an 

association between the two fields. In order to make this process easier, ensure that the “Match Type” 

checkbox is selected. This will ensure that when you select an unmapped field, only potential fields of the 

same data type will be displayed in the list to the right. 

 If you have mapped field that shouldn‟t be mapped, you can select a report field from the list in the 

lower left corner of the “Map Fields” dialog box. You can then click the “Unmap” button to the right to 

dissociate the selected report field from its database partner in the list at the right. They will then both move 

into the lists of unmapped report and database fields above. Once you have associated the desired report 

fields with the database fields, click “OK.” Note that you will often have to change additional information in 

the report, such as data labels used for the original report fields, after mapping the data fields. 
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ACTIONS- 

Advanced Database Concepts 
VIEWING THE SQL CODE IN A REPORT: 

 

1. Open the report based on database tables. 

2. Choose “Database| Show SQL Query…” from the Menu Bar. 

3. In the “Show SQL Query” dialog box, you can view the SQL code used to generate the report‟s data set. 

4. This statement is not editable, so when you have finished examining the SQL statement click “OK” or 

“Close” to close the box. 

CREATING SQL EXPRESSION FIELDS: 

 

1. Open a report which is based on tables (versus an SQL Command) and select the “SQL Expression 

Fields” option in the “Field Explorer.” 

2. Click the “New” button in the toolbar at the top of the “Field Explorer” pane. 

3. This will launch the “SQL Expression Name” dialog box, where you will type the name of the SQL 

Expression field which you are about to create. 

4. When you are ready to create the SQL Expression, click “OK” to continue to the “Formula Workshop – 

SQL Expression Editor” window. 

5. Create the SQL statement in the “Formula Text” window and make sure that you double-check the 

syntax. You will, however, be notified of any error in your expression when you try to click “Save and 

Close” when you are finished creating the SQL statement. 

6. The SQL field will then appear in the “Field Explorer” pane, where you can insert it into your report and 

use it much as you would use a “Formula Field.” 

USING TABLE ALIASES: 

 

1. Open the “Database Expert” dialog box. 

2. Select the name of the table which you would like to add to the report from the listing of “Available 

Tables:” and click the right-pointing arrow button “>” to move it into the list of “Selected Tables.” 

3. Select the same table again and click the right-pointing arrow button again. 

4. Crystal warns you that you already have a table with that name added to the report, and prompts you to 

add an alias for this table. 

5. Click “Yes” to this prompt and Crystal will add the name of the table, followed by the underscore 

character, and then a sequential number (1, 2, 3, etc…) increasing the number for each alias added. 

6. You can then change the name of the alias by selecting the name of the alias in the “Database Expert” 

dialog box and then pressing the “F2” key on your keyboard to rename the table alias. 

VERIFYING THE DATABASE: 

 

1. Select “Database| Verify Database” from the Menu Bar. 

2. If the database to which the report is attached is current, then you will see a message box appear and tell 

you that the database is up to date. You can then click “OK” to close the message box. 

3. If there are errors in the underlying table, you will see a message box appear and tell you that the file has 

changed and that Crystal will now proceed to fix up the report. 

4. When you click “OK” Crystal will then attempt to fix any database errors. Some of the alterations made 

may require that you manually make the change to the report field using the “Map Fields” dialog box. 

After it is done, you will then see any database changes in the “Field Explorer” pane. Sa
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ACTIONS- 

Advanced Database Concepts 
SETTING THE DATASOURCE LOCATION: 

 

1. Open the report which contains the data source connection which you wish to change and then choose 

“Database| Set Datasource Location…” from the Menu Bar. 

2. This will then open the “Set Datasource Location” dialog box where you can view the current data source 

choice shown in the “Current Data Source:” section at the top of the dialog box. Here you can select the 

table to replace from the list displayed. 

3. At the bottom of the dialog box, in the “Replace with:” section, you can select the name of the table with 

which you want to replace the table you just selected. 

4. Once you have the tables which you wish to change selected, click the “Update” button at the right side of 

the dialog box. 

5. Unless the tables which you switched have identical field names, you will then need to use the “Map 

Fields” dialog box to re-map the data fields within the report. If they do happen to have the exact same 

names, then simply clicking the “Update” button is enough. 

MAPPING REPORT FIELDS: 

 

1. You use the “Map Fields” dialog box to manually make corrections between the report and the underlying 

data source. 

2. In the “Map Fields” dialog box you will see four separate lists of fields. 

3. The upper left list shows “unmapped” fields within the report which have not been associated with a field 

in the underlying data source. 

4. The potential fields with which the “unmapped” fields could be associated are listed in the upper right 

corner. 

5. In the lower left corner are report fields which have successfully been mapped by Crystal Reports based 

on the field names. 

6. In the lower right corner you can see the database fields with which the “mapped” report fields have been 

associated. 

7. You can manually create associations between the unmapped report fields and the potential database 

fields by selecting the field to map from the “Unmapped Field” list, and then clicking on a “matching” field 

in the list of database fields to the right. 

8. Click the “Map” button at the right to create an association between the two fields. 

9. In order to make this process easier, ensure that the “Match Type” checkbox is selected. This will ensure 

that when you select an unmapped field, only potential fields of the same data type will be displayed in 

the list to the right. 

10. If you have mapped field that shouldn‟t be mapped, you can select a report field from the list in the lower 

left corner of the “Map Fields” dialog box. 

11. You can then click the “Unmap” button to the right to dissociate the selected report field from its 

database partner in the list at the right. 

12. Once you have associated the desired report fields with the database fields, click “OK.” 
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EXERCISES- 

Advanced Database Concepts 
Purpose: 

 

1. There are no exercises for this chapter. 

Exercises: 

 

1. None 
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Crystal Reports Keyboard Shortcuts 

Formula Editor Shortcut Keys (cont.) Key 

Opens a dialog to create a new formula Ctrl + N 

Save and close Formula Editor Ctrl + S 

Focus to the syntax name list box Ctrl + T 

Switch to previous control box Ctrl + Shift + Tab 

Switch to next control box Ctrl + Tab 

Paste Ctrl + V 

Cuts Ctrl + X 

Undo Ctrl + Z 

Repeat Ctrl + Shift + Z 

Keyword Auto Complete Ctrl + Space 

Move to end of line End 

Copies object from list to formula box Enter 

Go to next bookmark F2 

Find next item F3 

Go to previous bookmark Shift + F2 

Menu Bar Shortcut Keys Key 

New Report Ctrl + N 

Open Report Ctrl + O 

Save Report Ctrl + S 

Print Report Ctrl + P 

Cut Ctrl + X 

Copy Ctrl + C 

Paste Ctrl + V 

Delete Del 

Select All Ctrl + A 

Find Ctrl + F 

Go To Page Ctrl + G 

Design View Ctrl + D 

Refresh Report Data F5 

Formula Editor Shortcut Keys Key 

Browse selected field Alt + B 

Check for Errors Alt + C 

Toggle the “Shows Field” tree Alt + F 

Comments the current line Alt + M 

Sort tree content Alt + O 

Toggles the “Shows Operator” tree Alt + P 

Save formula Alt + S 

Toggles the “Shows Function” tree Alt + U 

Select all Ctrl + A 

Copy Ctrl + C 

Move to end of last formula line Ctrl + End 

Find Ctrl + F 

Set a bookmark Ctrl + F2 

Clear all bookmarks Ctrl + Shift + F2 

Move to beginning of file Ctrl + Home 

Move to start of word at left Ctrl + ← 

Select through start of word at left Ctrl + Shift + ← Sa
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